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1. PREPARING FOR DEPLOYMENT
The Savant Telephony Solution Deployment Guide documents the options and processes involved in deploying the 
Savant PBX system. To ensure a successful deployment Savant Systems has developed a checklist, as well as a 
section on what is needed before you get started. These are both contained in Appendix 2. As you can see from this 
appendix the installer needs to have an IP plan which requires knowledge of the following:

• Specific IP addresses assigned to Savant PBX equipment 
• MAC addresses of the Savant PBX equipment
• IPEI (IP Electronic Identifier) for wireless phones
• UID (unique identifier) for all the iOS devices

The checklist is a step-by-step instruction (as well as links to documentation describing those steps) on doing a full 
installation. There are also checklists for just adding a wired phone, wireless phone, iOS device, or adding a new 
base station to an existing system. Savant Systems encourages you to look at this appendix at this time to get 
acquainted with the type of information that it contains.This will help you in completing the various procedures in this 
deployment guide.

Savant PBX and Supported Components
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IP Address Assignment

Savant Systems recommends you reserve the following IP addresses before installing any hardware. You must 
reserve IP addresses on your DHCP server for the following: 

1. One for the Savant PBX (SPX-1000)

2. One for the Savant Gateway (TEL-­‐GW04)

3. One per each access point used (SIP DECT base stations)

After the IP addresses are assigned you are ready to start installing and configuring the system.

Note that the network configuration can be changed. See Changing the PBX Network Configuration. 

Savant PBX Hardware and Installation

To add the SPX-1000 to the PBX solution simply plug in one end of an Ethernet cable to the unit’s single 10/100 
Base-T Ethernet port, plug in the other end of the Ethernet cable to a managed Ethernet switch, and then plug in the 
unit’s AC power cord.

Savant Gateway
(TEL-GW04)

Savant PBX
(SPX-1000)

1U Rack Shelf
(RCK-3000)
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Savant Phones

The phones supported by the Savant PBX Telephony solution are Savant products: TEL-HST01, TEL-HST02, and 
TEL-HSTW01. The usage of these phones is described in more detail in the Savant Telephony Solution: Call 
Features Usage and Telephony-Enabled iOS Devices Deployment Guide.

To install the TEL-HSTW01 battery, push the battery cover 
downwards until it disengages from the locking mechanism and lift 
off. Insert the battery with contacts downwards. Replace the 
battery cover and push upwards until it snaps into place.

To change the power adapter, push the OPEN button on the unit 
to pop off the existing plug. Insert the desired plug and press 
downwards until it snaps in place.

Plug in the power supply cord to the charger cradle and plug the 
other end into the wall. For more details on installing this phone, 
see Installing the Savant Wireless Phone: TEL-HSTW01. 
 

Front View of TEL-HSTW01

To setup your TEL-HST02 phone 
turn the phone over and locate 
the handset port, and then plug 
in the handset cord until it clicks 
in place. Attach the handset to 
the other end of the handset 
cord. Next, on the phone locate 
the port marked LAN (not PC) 
and plug in an Ethernet cable. 
Plug in the other end of the 
Ethernet cable to the managed 
ethernet switch. For more details 
on installing this phone, see 
Installing the Savant Phone: 
TEL-HST02.

Top View of TEL-HST02 (above)
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To setup your TEL-HST01 phone 
turn the phone over and locate the 
handset jack, and then plug in the 
handset cord until it clicks in place. 
Attach the handset to the other end 
of the handset cord. Next, on the 
phone locate the port marked LAN 
and plug in an Ethernet cable. Plug 
in the other end of the Ethernet 
cable to the managed ethernet 
switch. Insert the key card and 
label it to correspond to the keys 
function. For more details, see 
Installing the Savant Phone: TEL-
HST01.

Top View of TEL-HST01 (above)

TEL-HST01 Key Card
To insert the key card that 
provides the labels for the 
eight keys shown in the 
diagram to the right, do the 
following.
1. Remove the logo plate as 

shown.

2. Slide the card into the 
slot.

3. Slide the logo plate back 
in place.

NOTE: You can make customized key cards using the templates provided in Appendix 1. Alternatively, you can 
purchase professionally-made key cards from a third-party supplier. 
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Savant PBX Software

The Savant PBX Server (SPX-1000) is developed on top of Asterisk®, a leading open source Internet Protocol (IP) 
telephony engine, which in tandem with Savantʼs IP solutions offers a completely integrated voice communications 
package. The SPX-1000 is communicating with the Savant Control System to allow for a truly integrated home, 
where the phone system and the control system are unified. The SPX-1000 also comes with an intuitive user 
interface to simplify the installation and reduce the overall setup time.

Refer to the PBX 5.2.1 ER2- Release ReadMe notes to verify the correct software version.

One-Click Software Update in Savant Configurator
For post-Release 5.0 releases, users must update the Savant PBX system software using an option available in 
Savant Configurator. This option is located in the System sidebar on the Overview page—Software Update.

Passwords
The next table specifies the default user names and passwords for logging in to the various applications/devices used 
to configure the Savant PBX solution. The entries are case-sensitive.

User Interface User Name Password

Savant Gateway* Admin Admin

Savant Configurator admin savant

Savant phones admin 22222

Savant PAS-1000 admin 0000 
(zeros)

Savant PBX (SPX-1000) RPM RPM

OpenMobility Manager
(for base stations)

omm
(must be changed after initial login)

omm
(must be changed after initial login)

*To access the settings of the Savant Gateway you must use a web browser other than Safari. 
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Supported Hardware List

The Savant PBX solution supports the hardware described in the next table.

Model Number Telephony Hardware

SPX-1000 Savant PBX (includes 1 RCK-3000—1U Rack Shelf)

TEL-GW04 4-port VoIP Gateway

TEL-IAD2 Integrated Access Device (IAD)

TEL-HST01 Entry Level IP Handset

TEL-HST02 High-End IP Handset 

TEL-HSTW01 Wireless DECT Handset

TEL-HSTPWR Universal Power Supply for Desktop Handsets

TEL-BST11 Indoor DECT Base Station

TEL-BST01I Indoor International DECT Base Station

TEL-BST12 Outdoor DECT Base Station

TEL-BST02I Outdoor International DECT Base Station

TEL-BSTMMT Mast Mount for Outdoor Base Station

TEL-BSTWMT Wall Mount for Outdoor Base Station

TEL-BSTPWR Universal Power Supply for Indoor Base Station

PAS-1000 Public Announcement System

TEL-PASPWR Universal Power Supply for PAS-1000

Note the following:
• Savant Wired Handset with Color Touch Screen LCD, Model TEL-HST02, AC Wall Adapter not included—

number of handsets dependent on specific configuration; check packing list.
• Savant Wired IP Handset with LCD Display, Model TEL-HST01 AC, Wall Adapter included—number of 

handsets dependent on specific configuration; check packing list.
• Savant Wireless DECT Handsets, Model TEL-HSTW01 includes charging cradle—number of handsets 

dependent on specific configuration; check packing list.
• Savant DECT over IP Base Station, Model TEL-BST11 (indoor access point)—number of base stations 

dependent on specific configuration; check packing list.
• Savant DECT over IP Base Station, Model TEL-BST12 (outdoor access point)—number of base stations 

dependent on specific configuration; check packing list.
• Public Announcement System, Model PAS-1000—number of Public Announcement Systems dependent on 

specific configuration; check packing list.
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PBX Support of Call Features
Important!  You should avoid using iOS devices and full duplex (two-way) PBX functions with in-wall docks. 

Otherwise, the iOS devices will experience acoustic issues.  Instead, half duplex (one-way) Push-To-
Talk intercom functions must be used with in-wall docks.

The next table shows call features supported or not, by the Savant PBX components and iOS devices.

Feature TEL-HST01 TEL-HST02 TEL-HSTW01 iOS 
Devices Notes

Conference Yes Yes No No

Transfer Yes Yes Yes No

SLA Yes Yes Yes Yes
DECT handsets cannot display the 
status of the SLA lines they belong 
to.

SLA Status Yes Yes No Yes
DECT handsets cannot display the 
status of the SLA lines they belong 
to.

SLA Join Yes Yes Yes Yes

Hold Yes Yes Yes Yes

Resume Yes Yes Yes Yes

Call Forward Yes Yes Yes No

Paging Yes Yes Yes Yes

Receiving Paging Yes Yes No Yes DECT handsets will always ring

Distinctive Ringing Yes1 Yes1 Yes2 Yes

1 Only rings supported by the 
phone. No custom mp3 support.

2 Only rings supported by the 
phone. No custom mp3 support. 
slightly different to the ones for 
wired phones.

MWI Yes Yes Yes Yes

Caller ID Yes Yes Yes Yes Provided the phone line does 
support Caller ID.

Mute Yes Yes Yes Yes

Call Waiting 
(Network Side) Yes Yes Yes Yes Only iOS devices will present the 

Caller ID of the new call.
Call Waiting 
(Multi Call) Yes Yes Yes Yes

SpeakerPhone Yes Yes Yes Yes

Redial Yes Yes No Yes

Global Contacts/
Directory No No No No Contacts are local to the 

endpoints.

Global Missed calls 
Indication No No No No The indication is kept independent 

in each device.

Speed Dial

DND Yes Yes Yes Yes No global—is individual to the 
device.
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Headphone

BLF No Yes No Yes

Auto Answer No1 No1 Yes Yes
1 Does not support auto-answer for 

non-intercom calls.

2. SAVANT GATEWAY

The Savant Gateway manages the interworking between the traditional Plain Old Telephone Service (POTS) lines—
or Central Office lines—and the Savant Systems network.
Savant Systems supports a maximum of four wired lines coming into the gateway.
This section describes the Savant Gateway—TEL-GW04 (AudioCodes™ MP-114) which supports the Savant PBX 
system.

Gateway Hardware
The front and rear views of the Savant Gateway are shown in the next images.

Front View of Savant Gateway (TEL-GW04)

Rear View of TEL-GW04

Disabling Local Ringback on PBX Endpoints
Local ringback from the endpoints can be disabled using the Savant Gateway web user interface. The Savant PBX 
will relay 183 from the gateway to endpoints so that no local ringback is played from endpoints. 
To disable local ringback on PBX endpoints, do the following.
4. Open your web browser and enter the IP address of the gateway—for example, http://10.5.200.45—to open the 

gateway’s web interface. Note that it may be necessary to use a web browser other than Safari. 

5. Click Full instead of Basic.

6. Go to Configuration (tab) > VoIP > SIP Definitions > General Parameters > Enable Early Media to Enable.

7. Click Submit.

8. Go to Configuration (tab) > VoIP > SIP Definitions > Advanced Parameters >Progress Indicator to IP.  
Select the value: PI=1.
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9. Click Submit.

10. Click Burn to store the new configuration, in case of a gateway reset.

Application Diagram

Mounting the Savant Gateway

The Savant Gateway (shown above on right) is mounted in the 1U Shelf (RCK-3000), beside the Savant PBX Server 
(SPX-1000).

Hardware Installation
To add the TEL-GW04 to the PBX solution simply plug in one end of an Ethernet cable to the unit’s single 10/100 
Base-T ethernet port, plug in the other end of the ethernet cable to a managed Ethernet switch, and then plug in the 
unit’s AC power cord. 

In addition, plug in a phone cable with an RJ-11 connector to at least one of the four FXO analog ports, and then plug 
in the other end of the phone cable to the telephone service provider’s equipment.
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You are now ready to configure your Savant PBX system using RacePoint Blueprint™. Please refer to the section, 
RacePoint Blueprint™Procedures.

3. SAVANT RACEPOINT BLUEPRINT™

Use the next section to setup your Savant PBX using the Savant RacePoint Blueprint™ tool.
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RacePoint Blueprint™ Procedures

To access the link to the topics in this document, click the topic or topic page number in the following table of 
contents.
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Configuring a Savant PBX in RacePoint Blueprint™
To configure your Savant telephony solution, you must first add the Savant Private Branch Exchange (PBX) 
component and supporting devices to an existing configuration in RacePoint Blueprint™ configuration window which 
includes these components: Savant PBX, Savant Gateway, and door entry system (optional). When the RacePoint 
Blueprint™ configuration is complete, you must do the following: 

• Load the gateway configuration generated by RacePoint Blueprint™ to the gateway.
• Using the Savant Configurator load the telephony endpoints.plist generated by RacePoint Blueprint™.
• Configure phones, Savant Public Announcement (PA) system, using configuration files generated by Savant 

Configurator.

Before You Begin
If the current RacePoint Blueprint™ configuration contains a Call Server and Intercom Service, do the following:

1. In RacePoint Blueprint™select the Call Server component and delete it.

Important! A plist will not be generated unless the call server has been deleted.

2. Click Generate Services, and then synchronize the services. 

NOTE: Ensure the Intercom Service has been removed from the realized services.

To ensure that the IP addresses of the Savant PBX and Savant Gateway are reserved permanently in the DHCP 
server, you must configure a DHCP reservation in your DHCP server. The Savant PBX is shipped with DHCP 
enabled. 

The following procedures must be performed in the sequence shown below:

1. Adding a Savant PBX Component

2. Adding a Savant Gateway Component

3. Exporting Savant Gateway *.ini File

4. Exporting Telephony plist File

5. Adding a Savant Public Announcement (PA)
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Adding a PBX Component
Before adding a Savant PBX component to your RacePoint Blueprint™ configuration, read this first: Configuring a 
Savant PBX in RacePoint Blueprint™.

To add a Private Branch Exchange (PBX) component to your RacePoint Blueprint™ configuration, do the following.

1. In RacePoint Blueprint™ click Show Library.

2. From the Components window, select the PBX (Savant SPX-1000) component and drag it to the configuration 
window.

3. Click Show Inspector.

4. From the Inspecting <name> window, enter the PBX Savant ID.

NOTE: The PBX Savant ID will not display in Apple Remote Desktop but will appear in System Monitor.
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5. Select telephony properties and enter the PBX IP address. 

NOTE: Savant recommends that this IP address be reserved in the DHCP server so that the PBX will 
always get the same DHCP address when a power cycle is performed. The Savant PBX is shipped 
with DHCP enabled.
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Adding a Gateway Component

To add a gateway component to your RacePoint Blueprint™ configuration, do the following.

1. From the Library window, using the search text “GW” find the Savant gateway component (TEL-GW04), select 
it, and drag it into the configuration window.

2. Drag the gateway component to the configuration window.

3. Enter a unique name for the component and click Create. 

NOTE: The name of the gateway must not exceed 20 characters—a minus sign or dash is not a valid character.

4. Click Show Inspector. 

5. From the Inspecting window enter the gateway IP address.

6. From the Show drop-down list, select Telephony.

7. Select General option.
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8. Enter the Savant PBX IP Address.

9. For Release 5.1 and later, you must set the Gateway Index to 1.

10. Click Show Library and highlight the Generic SignalSource component.

11. Drag Generic SignalSource to the configuration window and enter a unique name for the component.

12. In the TelephonyGateway configuration window, select the gateway component.

13. Under the TelephonyGateway right click Line 1 and select the corresponding Signal Source Line 1.
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14. Repeat the previous step for each external phone line (POTS) required. A maximum of four lines is supported in 
the current release.

15. Next, click Generate Services and then Save the configuration. Saving the configuration also generates two 
important files that are needed to configure the Savant Gateway and the Savant PBX.

16. Synch with services, if required.

17. Upload the configuration to your Savant system.

NOTE: Ensure the telephony service is enabled in all the zones of interest.

If more gateways must be added, see Configuring Multiple Gateways.
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Exporting Savant Gateway *.ini File
To load the Savant Gateway configuration generated by RacePoint Blueprint™ to the gateway, you must export the 
gateway initialization (*.ini) file. To export the *.ini file, do the following.

1. From the Tools menu go to Telephony and select Export Gateway ini File.

2. The Export Gateway ini File window opens. See the next screenshot.

3. Select the destination folder and the name of file and click Save.
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Uploading the *.ini file to the Savant Gateway
This procedure assumes you are using the gateway interface version: 6.20A.037.001 (factory default.)

To upload the *.ini file to the Savant Gateway, do the following.

1. Open your web browser and enter the IP address of the gateway—for example, http://10.5.200.45—to open the 
gateway’s web interface. Note that it may be necessary to use a web browser other than Safari.

NOTE: This step assumes the gateway already has been set up to use DHCP and its IP address has been properly 
reserved on the DHCP server.
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2. Select Maintenance button and then expand Software Update.

3. Select Configuration File.
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4. Browse and select the *.ini file

5. Click Send INI File.
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6. Click OK. Wait until the device restarts. This could take as long as 60 seconds.

7. Click Burn.

8. Click OK. Then, you should see a message saying the new configuration was saved.

9. Click OK.
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Exporting Telephony plist File
If you do not have a gateway as part of your Savant PBX system, exporting of the telephony plist is not required—
please skip this procedure.

To load the telephony property list files (Endpoints.plist) generated by RacePoint Blueprint™ to the Savant 
Configurator, do the following.

1. From the Tools menu select Telephony and then select Export Telephony plist.

The Export telephony plist file window opens.

2. Select the destination folder and the name of file, and then click Save. This file will later be used in the Savant 
Configurator.
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Adding Endpoints to the PBX System

iOS Devices
iOS devices can be added to the Savant PBX system with or without a shareable UID. Savant Systems recommends 
the use of shareable UID. For more details see the Technical Application Note, How To Guide: Setting Up Guest 
Access. To view this document, go to http://www.savantsystems.com and navigate as follows: 
> Dealer Login > Knowledge Base > Products 

1. From the Library window select the iOS device.

2. Click Show Inspector.

3. In the Inspector window, enter the Device Name.

4. If required, insert a check mark for the field Sharable UID (in the Inspector window).

5. Add a user.

IP Phones
IP phones are configured for a Savant PBX system using the Savant Configurator. See the section, Savant 
Configurator.

Adding the Savant PA System
The Savant Public Announcement (PAS-1000) system—also used as a paging system—can activate an Audio 
Interrupt Service, similar to the door bell service, providing two workflows: PageCallStart and PageCallStop. These 
workflows allow all zones to pause the current audio source, send the output of the PA system, and then resume the 
audio source.

To add the Savant PAS-1000 component to the RacePoint Blueprint configuration, do the following.

1. Open your RacePoint Blueprint™ configuration.

2. Click Show Library.

3. From the Components library window, type Savant PA in the search field to display Savant PA (PAS-1000).

4. Select and drag the PAS-1000 component to the configuration window.

5. Select the zone and the name, then assign the component to a global zone.
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NOTE: To configure the Savant Public Announcement (PA) system, a Savant audio/video matrix switcher is 
required.

6. Connect the RCA audio output to the Savant Audio-Video Switch Processor stereo input. Ensure that an audio 
connection is assigned to an input on the matrix switcher.
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7. Click Show Inspector and inspect the Savant PA System component.

8. View the telephony properties and select Registration Enabled by inserting a check mark. See the next 
screenshot.

9. Double-click Registrar Ip Address on the Properties for: Registration pane and enter the correct IP address 
for the Savant PBX (SPX-1000)—for example, 10.5.200.71.

10. Double-click Username and enter a user name—for example: 2020. Write down this user name for use in the 
Savant Configurator. This value matches the one used to add the Savant Public Announcement System 
(PAS-1000) while configuring the Savant PBX in Savant Configurator.
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11. Leave the Password blank.

12. Click Generate Services.

13. Confirm that an Audio Interrupt Service is configured for all zones. See the next screenshot.
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Configuring Triggers for Savant PA System

The triggers, PageCallStart and PageCallStop, must be configured for the Savant PA (paging) system (PAS-1000).

When global.PageCall is TRUE, this triggers the PageCallStart workflow.
When global.PageCall is FALSE, this triggers the PageCallStop workflow.

To configure the triggers so the paging system workflows can be executed, do the following.

1. In RacePoint Blueprint™ navigate to Tools-> Review-> State Triggers.

2. Create a new trigger, PageCallStart by clicking the + button in the Trigger group.

3. Create the Transition Conditions by clicking the + button.

4. In the Triggers for… window, select Other (tab).

5. Under Type select global.

6. Under State Name select PageCall.

7. Assign the state: Boolean Equal True. See the circled area of the next screenshot.

8. Click Add.

True
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9. In the Request to run group (bottom) click the + button.

10. Select the Service—a doorbell audio interrupt service, and then select the Request—PageCallStart.

11. Click Choose.

12. To create the second trigger, PageCallStop, under State Name select PageCall.

13. Assign the state: Boolean Equal False.

14. Click Add.
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15. Click Save.

16. Upload the configuration.
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Configuring the Whole-House Paging Feature

The Whole House Page Feature uses the Savant PA system in a Calling Group set as a Paging Group. Ensure that 
you have a Calling Group set as Paging Group with extension 8000. The Paging Group must be configured using the 
Savant Configurator.

If you dial a Paging Group extension, all the devices in that group will auto-answer and be placed in a conference 
bridge. The audio will then flow in one direction only from the caller device to the devices in the group, see the figure 
below:
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By default, the iPad® Page button uses extension 8000 for paging. See the next screenshot.

From a phone, simply dial the extension 8000 or use the Page button configured for this purpose.
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Triggering Distributed Audio Zones

The system by default creates an empty calling group called PageAll for the purpose of paging. 

For the PageAll calling group to be able to trigger the distributed audio zones, do the following in Savant Configurator.

1. Click the Call Groups tab.

2. Select the PageAll group.

3. Click the Edit Group button to open the Edit Call Group page.

4. Insert a check mark in the Distributed Audio Zones checkbox.

5. Click Save Group.

Now you need to add the Savant Public Announcement system corresponding device to this group. 
For more details, see Adding a Savant PA System.
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Using Telephony Advanced Configuration
To provide seamless integration between the Savant PBX system and Savant control systems, actions or workflows 
based on telephony events can be triggered with the use of the Telephony Advanced Configuration.

This advanced configuration is required because the endpoint information that is entered in Savant Configurator, 
does not get synchronized with RacePoint Blueprint™ which does not know in advance the names of these events 
and thus is not able to use them as triggers. To solve this, Savant provides a component in RacePoint Blueprint™ 
called the Telephony Advanced Configuration. The advanced configuration allows telephony related information to be 
entered in the Blueprint telephony configuration.

The Savant Telephony Advanced Configuration allows you to do the following:
• Enter the names of telephony devices (endpoints) in the system
• Use endpoint telephony events as triggers.
• Associate control commands to extension numbers—that is, telephony endpoints such as wired and 

wireless phones called by dialing extension
• Execute control commands, providing another level of integration between the telephony system and the 

control system.
To perform the Telephony Advanced Configuration in Blueprint, do the following. 
1. In RacePoint Blueprint click Generate services, to see the Realized Services window.
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2. To open the Telephony Advanced Configuration, from the main menu select Tools > Settings > Telephony. See 
the next screenshot.

If you are using a pre-Release PBX 5.1.1 software version, double click telephony (as circled in the next 
screenshot) to open the services window for devices.

From the telephony services window you can set up events for devices (or endpoints) and commands for those 
endpoints.

3. Under Devices click +.

4. Enter the name of the device (endpoint). You must ensure that the name entered matches a user Friendly Name 
used when you add the device in Savant Configurator. For every name entered the following (events) states are 
generated to use as triggers. See the next table.
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Telephony Events
Event Description Possible Values

CallState State the Call Incoming Call
Ringing
Connected
Call Ended
Call In Progress

CallingIdNumber Extension or number of the 
initiator of the call

Only applicable when the device is  
receiving the a call

CurrentDialNumber Dialed number or extension Only applicable when the device is  
initiating a call

ReleaseReason Protocol level (SIP) reason why 
the call ended.

For details on possible values see 
RFC3261.

CallingIdName Caller ID Name For external incoming calls is 
depending of the line having this 
service. For internal calls this 
value is the user Friendly Name 
entered in Savant Configurator.

SharedLine1.State State of the CO Line 1 Could be: Busy or Idle.
This only applies to the gateway 
device

SharedLine1.Users Number of endpoints currently in 
the call

Possible values are 1-72

SharedLine2.State State of the CO Line 2 Could be: Busy or Idle.
This only applies to the gateway 
device

SharedLine2.Users Number of endpoints currently in 
the call

Possible values are 1-72

SharedLine3.State State of the CO Line 3 Could be: Busy or Idle.
This only applies to the gateway 
device

SharedLine3.Users Number of endpoints currently in 
the call

Possible values are 1-72

SharedLine3.State State of the CO Line 3 Could be: Busy or Idle.
This only applies to the gateway 
device

SharedLine4.Users Number of endpoints currently in 
the call

Possible values are 1-72

5. After you have finished entering the name of the endpoints. Click Done.

Confidential and Proprietary                                                    41  of  272Savant Telephony Solution Deployment Guide
Release PBX 6.0
009-0406-14



6. Next, go to Tools->Review->State Triggers.

7. Select State Triggers to open the triggers window.

8. Under the Trigger group add a new trigger by clicking the + button (circled in the previous screenshot).
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9. Enter the trigger name.

10. Under Transition Conditions click the + button.

11. Select the Other (tab), and then select telephony. For each telephony device you have entered previously, the 
available state will display under State Name on the right side of the window.

12. Select the state under State Name that you want to use as a trigger.
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13. Complete the fields related to the state’s values (circled in the previous screenshot) Use the values that match 
the state as described in the previous table, see Telephony Events. 

14. Under Request select the request you want to execute.

15. Click Choose. See the next screenshot.

16. Repeat the previous steps for each state trigger you want to add. When done click Save.

You are now ready to associate commands with extension numbers.
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Commands
Telephony endpoints such as wired and wireless phones called by dialing the extension, can execute control 
commands, providing another level of integration between the telephony system and the control system exists.

NOTE: The extensions you enter here must be unique and therefore must not conflict with extensions you have 
already assigned to your telephony system.

It is recommended that you define a high range for example, 9500-9599.

To associate control commands to extension numbers, do the following.

1. From the Commands window select the Extension Number. 

2. Add the extension by clicking the plus (+) button.

3. Select an option under Zones.

4. Select an option under Services.

5. Select an option under Commands.
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6. Click Apply.

7. Repeat this process for each extension you want to bind to commands.

8. Click Done.

The telephony devices and command will now become part of your system after the configuration is downloaded to 
the Savant host controller (master).
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TEL-HST02 Configuration
A TEL-HST02 phone must be made aware of the extension. For this, softkeys can be programmed to allow the phone 
to send commands to the system.

The softkeys must not be programmed before the procedure, Uploading the Configuration to the Wired 
Phone, is performed. The command that is used to program the softkeys is described in step 9 of the next procedure.

1. From the Savant Configurator click the Phones tab.

2. Click the IP address of the phone to which you want to add this functionality (which is only valid for TEL-HST02).

3. Enter the user name and password:

Name: admin
Password: 22222

4. Click Log In. The phone web interface (Aastra) opens.
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5. Under Operation, click Softkeys and XML to open the Softkeys Configuration page.

6. Under Type, choose the available Key that you want to program. An available type is shown as None. The next 
screen shot shows 2 as the key being programed, for example.

7. From the drop-down list under None select XML.
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8. For Label, type in something meaningful to indicate what the command does. The next screenshot shows HVAC 
Off, for example.

9. For Value you need to paste the command described in this step. Savant Systems recommends the command 
be copied and pasted to a text file first, and then edited to reflect the customer master_ip and extension. Note 
that the command must not include any spaces or line breaks—that is, the command must be one continuous 
line before being pasted. It could also be helpful to increase the font size for editing. The command is as follows:

http://master_ip:8080/assets/state/disReq.pl?command={%22disApp%22:%22Telephony%22,%22command
%22:%22telephonyPhoneCommand%22,%22extension%22:%22XXXX%22}
Where:
master_ip is the IP of your Savant master
XXXX is the extension for which the associated command is to be executed, for example, 9999.

10. Repeat the above step for each softkey you want to program on this phone.

11. Scroll down and click Save Settings.
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Your phone should now have a new button and when pressed will execute the command associated with the 
extension (for example, HVAC Off). See the next screenshot.
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Configuring Multiple Gateways 
The Savant PBX supports up to six gateways, totaling port capacity of 24. The next procedure assumes one gateway 
has already been added. See Adding a Gateway Component.

To add more gateways to the PBX system using RacePoint Blueprint™, do the following.

1. From the Library window drag a Savant Gateway (TEL-GW04) to the layout view. 

2. Highlight the gateway component and click Show Inspector.

2.1. Enter the IP Address of the gateway.

2.2. From Show select the Telephony properties.

2.3. Enter the PBX IP Address.

2.4. Select the Gateway Index. This value is important and allows the system to identify the gateway 
from which a call is coming. Savant recommends selecting the next available index.

3. Repeat steps 1and 2 for all the gateways.

4. After all the gateways have been added, Generate Services.

5. Sync with services.
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6. Save the configuration.

7. Next, export the gateways configuration file to a folder.

8. From Tools >Telephony, select Export Gateway ini file. 

9. Enter the name of the file. When multiple gateways are configured the name entered will be used as a prefix for 
the gateway file names. For convenience the files names will be generated with the following format:

prefix-GatewayIndex-GatewayIPAddress.ini

where:
prefix is the name entered by the user
GatewayIndex is the index associated to this gateway (entered in RacePoint Blueprint)
GatewayIPAddress is the IP address of the gateway

10. Upload the configuration files to the corresponding gateway, repeat the procedure described in this Savant 
Telephony Solution Deployment Guide (009-0406-XX) for each gateway.

11. Next configure the gateways using Savant Configurator. See Configuring Additional Gateways.
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What to Do Next

To continue the configuration of your Savant PBX, you must next use the Savant Configurator. See the next section: 
Savant Configurator Procedures.
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4. SAVANT CONFIGURATOR

Use the next section to setup your Savant PBX system using the Savant Configurator tool.
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Savant Configurator Procedures
The procedures included in this document should be performed using Savant Configurator in the order in 
which they are presented, unless the configuration object is not required. You may skip a procedure that 
is not applicable to your configuration.
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Savant Configurator Overview
The Savant Configurator is a web-based graphical user interface for setting up and maintaining Savant Systems’ 
telephony solution—an integrated IP-based Private Branch Exchange (PBX). Savant Configurator simplifies 
administration of objects such as users, extensions, and devices, which would include the following:

• Savant PBX server
• gateways
• telephone handsets
• telephony-enabled iOS devices such as the iPhone®, iPod touch® and iPad®.

The objects described in the next table can be configured using the Savant Configurator:
  

Objects Description

Users Individuals identified to the PBX for assignment of permissions and access to various 
functions

Devices Configures iOS devices, IP phones, gateway, Integrated Access Device (also referred 
to as an ATA device), and door entry (paging) system

Phones Supports Savant wired IP handsets: TEL-HST01 and TEL-HST02
Supports Savant wireless SIP-DECT handset: TEL-HSTW01 

Extensions Creates and edits time-based routing rules for Direct Inward Dials— (DID)s

Call Groups Configures call group to be hunt, ring all, or paging

SLA 

Shared Line Appearance (SLA) allows a station to be mapped to a SIP telephony 
gateway (device). The SLA feature allows extensions to share an external Central 
Office (CO) line—or sometimes referred to as POTS (plain old telephone service). 
Calls coming from the CO line will ring all member extensions assigned to the line. 
Answering from one member extension will stop ringing on all other extensions. The 
call can be easily transferred from one member extension to another by putting it on 
hold and picked up from the other. It also allows one to join the active call from a 
member extension, so that a two party conversation becomes a multi-party 
conference.

Voicemail Modify voice mail settings

CDRs Call Detail Records and Logs

IVRs Interactive voice response (IVR) files

Sounds  Not applicable in the current release

Logs View PBX log files live using the Log Viewer

Backups Create configuration backups automatically or manually

Ring Profiles Create custom rings for an iOS device or phone
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Starting Savant Configurator
To start the Savant Configurator you must use a web browser and then log in. 

To log in to the Savant Configurator for the first time do the following.

1. Open Savant Configurator using either System Monitor or Bonjour (described below).

In System Monitor select the row with the Device Type: PhoneSystem.

This will launch Savant Configurator.

Alternatively, to have your Apple® Safari® web browser launch Savant Configurator, select the Bonjour pull-
down menu.

NOTE:  If Bonjour is not showing on your Bookmarks Bar, go to:
Safari > Preferences > Bookmarks. Insert check marks for Include Bonjour.

2. Click the savant-ipbx option to open the login window for Savant Configurator. See the next screenshot.

3. Enter the user name and password as follows: 

Username: admin
Password: savant 

4. Click Submit.
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Main Page in Savant Configurator
After you log in to the Savant Configurator the interface opens with the focus on the Overview tab. The first time you 
log in, the System Overview will only display data in the System Information table. Data will be displayed in other 
tables as other entities are configured.

  Confidential and Proprietary                                                                         58 of  272Savant Telephony Solution Deployment Guide
Release PBX 6.0
009-0406-14



Savant Configurator Terminology
Before using the Savant Configurator tool, review the terms shown in the next table.

Term Description

CDRs Call Detail Records are server details of each call stored in a 
data format.

Call Groups

Groups of devices on a specific ring plan. Groups can be Ring 
All, Hunt, or Find Me/Follow Me type groups. A Ring All group 
rings all members’ devices simultaneously. A Hunt Group dials 
devices serially, attempting to get an answer until the call 
terminates to a voicemail (if not answered). A Find Me/Follow 
Me group is a personal call group where different devices 
belonging to the same user can ring in a hunt-type fashion.

Devices 
Physical handsets (telephones), iOS device, gateway, ATA 
device (Integrated Access Device—TEL-IAD2), or Public 
Announcement (PA) system (door entry system).

Direct Inward Dials

Direct Inward Dials (DID)s are numbers that may be dialed from 
outside the business to access the PBX. (DID)s are associated 
with an extension. For example, even though there may be four 
connections to the PBX from the service provider, the service 
provider may supply a block of numbers (such as, 555-1001 
through 555-1020) that will be routed to the four connections on 
the PBX. This example would allow 20 telephone sets to have 
their own unique number outside the business.

Extensions
Numbers that identify where a call should go. Extensions may 
point to a device or some entity of the PBX (such as, a call 
group).

SIP
Session Initiation Protocol (SIP) is a standard protocol for 
initiating, modifying, and terminating an interactive user 
session.

Users Individuals identified to the PBX for assignment of permissions 
and access to various functions.
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Uploading the plist
To complete this procedure you must have already created a plist using RacePoint Blueprint™ (see RacePoint 
Blueprint™ Procedures.)

If you do not have a gateway as part of your Savant PBX system, uploading of the telephony plist is not required—
please skip this procedure.

To load the initial configuration generated from RacePoint Blueprint™, do the following.

1. Click the Overview tab.

2. Under the System sidebar, click plist Upload.

3. Click Browse to find and select the plist file you created in the procedure, Exporting Telephony plist File, for 
example, pbxTelephony.plist.

4. Click Upload. The Savant Configurator will display the configured telephony properties.
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Adding a User to the Savant PBX
If an individual voice mail box will be used in the Savant PBX system, a user must be created for each voice mail box.
If a global voice mail box will be used or voice mail will not be enabled in the system, there is no need to create a 
user—you can skip this procedure.

To add a user for an individual Savant PBX voice mail box, do the following.
1. Click Users (tab) to open the Users page.

2. Click Add User to open the Add User page. 

4. Click Add User.

5. If more voice mail users must be added, repeat this procedure.
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Important!  Before installing any hardware or software, a thorough and detailed network analysis should be 
completed to create an ideal network design and implementation.  Because of the technical 
complexity of setting up networks, Savant recommends that the installer of a Savant system have a 
general understanding of networks.
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3. Use the next table to enter or select values for the fields on the Add User page.

Field Description

First	
  Name User’s	
  first	
  name.	
  

Last	
  Name User’s	
  last	
  name.	
  

Email
Email	
  address	
  to	
  no;fy	
  when	
  there	
  is	
  a	
  new	
  voice	
  mail	
  message	
  in	
  the	
  system.	
  Leave	
  
it	
  blank	
  if	
  email	
  no;fica;on	
  is	
  not	
  wanted.	
  

Pin PIN	
  used	
  to	
  access	
  the	
  voicemail	
  box	
  and	
  to	
  do	
  sound	
  recording.	
  

Pin-­‐less	
  Voicemail	
  access	
  
from	
  assigned	
  devices

If	
  PIN	
  access	
  is	
  not	
  required	
  from	
  assigned	
  device,	
  insert	
  a	
  check	
  mark	
  in	
  the	
  box.

Delete	
  Voicemail	
  aMer	
  
Email

To	
  delete	
  voicemail	
  aMer	
  sending	
  email	
  no;fica;on,	
  insert	
  a	
  check	
  mark	
  in	
  the	
  box.	
  
There	
  will	
  be	
  no	
  message	
  wai;ng	
  indicator	
  on	
  the	
  assigned	
  device	
  is	
  this	
  box	
  is	
  
checked.

Forwarding	
  Number
A	
  number	
  that	
  the	
  call	
  can	
  be	
  forwarded	
  to	
  before	
  failover	
  to	
  voicemail.	
  Leave	
  it	
  
blank	
  if	
  forwarding	
  is	
  not	
  wanted.	
  

Forwarding	
  Timeout Time	
  to	
  try	
  the	
  forwarding	
  number	
  before	
  failover	
  to	
  voicemail.	
  

4. Click Add User.

5. If more voice mail users must be added, repeat this procedure.
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Adding an iOS Device to the Savant PBX
To add an iOS device (iPhone®, iPad® or iPod® touch), do the following.

1. Click Devices (tab) to open the Devices page.

2. Click Add Device to open the Add Device page.
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3. Use the next table to enter or select values for the fields on the Add Device page. 

Field Description

Server
Available servers are shown in the drop-down list. Choose the server to which the new 
device should register. 
There should only be one (leave as is). 

Type Provides a drop-down list of the available types of devices that can be added to the 
server. Select this option: iOS Device.

Device Number Enter a four-digit number (in the range 2000-2500) for the iOS device. 

Assign to

Provides a drop-down list of all users that the device can be assigned to. If individual 
voicemail box is going to be used in the system and this device should have voicemail 
access, assign it to a user. In all other cases, Savant Systems recommends this field be 
unassigned. Leave as is.

Friendly Name Name that displays when a call is made from this device. This is only applicable if a static 
UID is entered.

Friendly Name 2 Leave blank.

MWI enabled This is enabled by default— allows device to receive Message Waiting Indicator.

UID Enter the Savant UID for the iOS device. Use the default value (dynamic) only when you 
want to  allow guest access into your telephony system.

Context A collection of extensions on the Savant PBX server. 
Default is Phone (all_calls). Use the default value.

Usable as Trunk Do not insert a check mark.  

Use TCP Insert a check mark in the check box since the device is an iOS device. 

Secret Leave it blank.

Call Limit Enter 2.

Host Use the default: dynamic.

Port Use the default value: 5060.

NAT
Network Address Translation (NAT) helps determine whether this device is on the internal 
network or outside the firewall. Since you are adding an iOS device, you must insert a 
check mark in the check box.

Register? Determines whether the device registers to the carrier to tell them where it is. This is only 
for carriers. Since you are adding an iOS device, the check box should be blank.

Qualify Determines whether the system periodically checks to see if the device is still available. 
Use the default value: YES.

Advanced See the section Performing Advanced Configuration.

4. Click Add & Exit, or Add & Clone if adding another device.

5. Launch the Savant phone service from the device.

6. Click the Devices (tab) to check the status of the iOS device just added. If it shows OK, the device is ready to 
make and receive internal calls. For external calls, see Adding an iOS Device or Phone to an SLA. 
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Adding a Phone to the Savant PBX
To add a wired phone, or wireless phone to the Savant PBX as devices, do the following.

1. Click the Devices tab.

2. Click Add Device to open the Add Device page.

3. Use the next table to enter or select values for the fields on the Add Device page. 

  Confidential and Proprietary                                                                         65 of  272Savant Telephony Solution Deployment Guide
Release PBX 6.0
009-0406-14



Field Description

Server Available servers will be in a drop-down list. Choose the server in which 
the new device should register. There should only be one (leave as is). 

Type Provides a drop-down list of the available types of devices that can be 
added to the server. Select this option: IP Phone.

Device Number Enter the four-digit number of this IP phone (in the range 2000-2500).

Assign to

Provides a drop-down list of all users that the device can be assigned to. 
If individual voicemail box is going to be used in the system and this 
device should have voicemail access, assign it to a user. In all other 
cases, Savant Systems recommends this field be unassigned. Leave as 
is.

Friendly Name
Name that displays when a call is made from this phone. This is the Caller 
ID name. This field allows a maximum of 20 alphanumeric characters 
(including spaces).

Friendly Name 2 Leave blank.

UID This is auto-assigned. No action is needed.

Context A collection of extensions on the Savant PBX server.
Default is Phone (all_calls).  Use the default value. Leave as is.

Usable as Trunk Since a SIP phone is being configured do not insert a check mark.

Use TCP Place a check mark in the check box if the device is an iOS device. When 
adding a SIP phone or an analog media gateway leave check box blank.

Secret Leave it blank.

Call Limit Enter 2.

Host Use the default: dynamic.

Port Use the default value: 5060.

NAT

Network Address Translation (NAT) helps determine if this device is on 
the internal network or outside the firewall. Turn NAT to register devices 
outside the internal network. Since you are adding a phone, you must 
insert a check mark in the check box.

Register?
Determines whether the device registers to the carrier to tell them where it 
is. This is only for carriers. Since you are adding a phone, the check box 
should be blank.

Qualify Determines whether the system periodically checks to see if the device is 
still available. Use the default check mark.

7. Click Add & Exit, or if adding another phone you can click Add & Clone, and then proceed with the next 
procedure. Or, you can repeat this procedure for each phone to be added. After adding all phones, continue with 
the next procedure.
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Adding a Savant Wired IP Phone as a Phone
It is important to confirm that your Savant IP phones have the most recent firmware. When this procedure is 
completed check the version of the firmware on the phone. If the firmware needs to be updated, see Updating Savant 
IP Phone Firmware. 

To add a Savant wired IP phone as a phone, do the following.

1. Click the Phones tab to open the Configured Phones page.

2. Click Add Phone to open the Add Phone page.
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4. Use the next table to enter or select values for the fields on the Add Phone page.

Field Description

Interface Use the default value.

Model Select a model:TEL-HST01, TEL-HST02, or TEL-HSTW01

MAC Address Enter the MAC address from the phone (located on a sticker on a phone).

Ring Profile Select a ring profile from the list. If no ring profile created, leave it as 
Default.

Identity Assignments Select one from the device list that matches the one added in the previous 
procedure.

Contacts For TEL-HST01 and TEL-HST02 models only. Insert a check mark if you 
want all the devices in the system are shown in this phone’s directory.

Intercom Directory
For TEL-HST02 models only. Insert a check mark if you want soft Busy 
Lamp Field (BLF)  buttons are created for every device in the system on 
this phone.

Disable Missed Call 
Indicator

For TEL-HST01 and TEL-HST02 models only. Insert a check mark if you 
don’t want the phone to show there is missed call at all.

4. Click Add.

5. To open the phone’s server settings in the phone’s user interface, on the Configured Phones page click the 
IP address of the phone. 

To upload the Savant Configurator configuration to the wired phone, see the next procedure Uploading 
the Configuration to the Wired Phone.
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To upload the Savant Configurator configuration to the wired phone, see the next procedure Uploading the 
Configuration to the Wired Phone.
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Uploading the Configuration to the Wired Phone
This procedure must be performed using the Safari web browser.

To upload the Savant Configurator configuration to the wired phone, do the following.

1. Open the Savant phone user interface (Aastra) using one of these methods:

Enter the IP address of the phone in the web browser, or 
From the list of Configured Phones under the Phones tab in Savant Configurator, click the IP address of 
the phone to which the configuration will be uploaded.

2. Log in to the Savant phone user interface, if you have not already done so. The default user login  is:

Name: admin
Password: 22222

3. To ensure that the phone is in the factory default mode—which is necessary to load the configuration properly—
from the main window under Operation in the left pane click Reset. See the next screenshot of the Reset page 
from the Aastra web-based user interface.

4. Click Restore.

5. Log in again to the phone user interface.

6. In the left pane under Advanced Settings, click Configuration Server.
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7. For the Download Protocol, select TFTP.

8. In the TFTP Server field, enter the Savant PBX IP address.

9. Click Save Settings.

10. In the left pane under Operation, click Reset.

11. Click Restart to restart the phone.
12. After the phone restarts from reboot, in Savant Configurator click the Devices (tab) to check the status of 

the phone just added. If it shows OK, the phone is ready to make and receive internal calls. To configure the 
phone to handle external calls, go to the procedure Adding an iOS Device or Phone to an SLA.
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Adding a Savant Wireless Phone
This procedure assumes you have added the Savant wireless phones as devices—see Adding a Phone to the 
Savant PBX. 

After you have added Savant wireless phones as phones (described in this procedure), you must configure the base 
station to activate the handsets. See the section, Savant DECT Base Stations.

To add a Savant wireless handset (TEL-­‐HSTW01) do the following.

1. Click the Phones tab open the Configured Phones page.

2.
Click Add Phone to open the Add Phone page.

3. Use the next table to enter or select values for the fields on the Add Phone page.

Field Description

Assign to user Select Unassigned.

Interface Use the default value.

Model Select TEL-HSTW01. 

IPEI Enter the 13 IPEI characters that can be displayed from the handset: 
system-> show IPEI.

Identity Assignments Select one from the device list that matches the one added in the procedure: 
Adding a Phone to the PBX System.
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4. Click Add. See the next screenshot.

NOTE:  It is normal that Savant Configurator shows Unable to find IP for these handsets.

5. Repeat this procedure for each Savant wireless handset that is added.

6. Click Download SIP DECT Config from the Phones sidebar to download sip_dect.cfg. You will need this file 
when you configure the base station and add handsets to the base station.
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Adding a Savant PA System
The Savant public announcement (PA) system—also a paging system—is added to the Savant PBX configuration 
similar to the method used to add a phone. 

To add the Savant PA system to the Savant PBX system, do the following.

1. Select the Devices tab to open the Devices page.

2. Click the Add Device button to open the Add Device page.
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3. The fields must be completed as shown in the next table:

Field Description

Server Available servers will be in a drop-down list. Choose the server to which the new 
device should register. There should only be one (leave as is). 

Type Select PA System from the drop-down list of the available types of devices.

Device Number Enter the extension associated with this device.  The range is 2000-2500. The 
next screenshot shows 2041 as an example.

Assign to Provides a drop-down list of all users that the device can be assigned to. It can 
also be unassigned. Savant Systems recommends this field be unassigned. 

Friendly Name Name that displays on the phones when the device registers to the server. This 
name will be displayed on the iOS devices when engaged in a call.

UID The Savant user identifier is automatically populated by the Device Number. 

Context
A collection of extensions on the Savant PBX server. 
Default is Phone (all_calls).  Use Phone (all-calls) when adding a phone, PA 
system, or iOS device including, iPhone, iPad or iPod touch.

Usable as Trunk This field is disabled—no input is required.

Use TCP Leave check box blank.

Secret Leave it blank.

Call Limit Enter 2.

Host Use the default value: dynamic.

Port Use the default value of 5060.

NAT

Network Address Translation (NAT) helps determine if this device is on the 
internal network or outside the firewall. Turn NAT to register devices outside the 
internal network. When adding a phone, iOS or analog media gateway device 
you must insert a check mark in the check box.

Register?
Determines whether the device registers to the carrier to tell the carrier where 
the device is. This is only for carriers. When adding a phone, iOS device or 
analog media gateway device, the check box should be blank.

Qualify Determines whether the system periodically checks to see if the device is still 
available. Insert a check mark in the box.

Advanced Leave blank.

4. Click Add & Exit and then you should see the new example device named 2041 on the Devices page.
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5. Click the Extensions tab and confirm that the extension has been added.

6. Click Phones tab to open the Phones page.

7. Click Add Phone. See the next screenshot.

8. Use the next table to enter or select values for the fields on the Add Phone page.

Field Description
3==6:,.-8.T=/< )/L/O-.T,*==6:,/4
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I84/L )/L/O-.)*+*,-.A3)$B'''

I37.344</== ",-/<.-?/.I37.*44</==.8M.-?/.A3.=1=-/5.CL8O*-/4.8,.*.=NOU/<.8,.-?/.A3)$B'''E\

W4/,N-1.3==6:,5/,-= )/L/O-.-?/.4/+6O/.O</*-/4.M8<.-?/.A3.=1=-/5.M8<.-?/.9/L4b.<&$%F@()G

9. Click Add. The Savant PAS-1000 is added and there is an IP address and a TFTP URL.
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6. Click Phones tab to open the Phones page.

7. Click Add Phone. See the next screenshot.

6. Click Phones tab to open the Phones page.

7. Click Add Phone. See the next screenshot.

8. Use the next table to enter or select values for the fields on the Add Phone page.

Field Description
3==6:,.-8.T=/< )/L/O-.T,*==6:,/4

W,-/<M*O/ T=/.-?/.4/M*;L-.+*L;/

I84/L )/L/O-.)*+*,-.A3)$B'''

I37.344</== ",-/<.-?/.I37.*44</==.8M.-?/.A3.=1=-/5.CL8O*-/4.8,.*.=NOU/<.8,.-?/.A3)$B'''E\

W4/,N-1.3==6:,5/,-= )/L/O-.-?/.4/+6O/.O</*-/4.M8<.-?/.A3.=1=-/5.M8<.-?/.9/L4b.<&$%F@()G

9. Click Add. The Savant PAS-1000 is added and there is an IP address and a TFTP URL.
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8. Use the next table to enter or select values for the fields on the Add Phone page.

Field Description

Assign to User Select Unassigned

Interface Use the default value

Model Select Savant PAS-1000

MAC Address Enter the MAC address of the PA system (located on a sticker on the 
PAS-1000).

Identity Assignments Select the device created for the PA system for the field, Identity 1

9. Click Add. The Savant PAS-1000 is added and there is an IP address and a TFTP URL displayed on the 
Configured Phones page.

10. Write down the IP address of the Savant PAS-1000. This will be used to upload the configuration file to the 
Savant PAS-1000.

11. Copy the entire TFTP URL which will later be used in the Advanced Settings configuration (in the next 
procedure: Uploading Configuration File to the Savant PA System).

12. Confirm the Savant PAS-1000 exists in the System Overview by selecting the Overview tab. The Savant 
PAS-1000 is shown as a phone extension in the list of Phones as Unregistered.

After the next procedure (Uploading Configuration File to the Savant PA System) is completed the Savant PAS-1000 
registration status should change to OK.
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10. Write down the IP address of the Savant PAS-1000 for future reference. This will be used to upload the 
configuration file to the Savant PAS-1000.

11. Copy the entire TFTP URL which will later be used in the Advanced Settings configuration (in the next 
procedure: Uploading Configuration File to the Savant PA System).

12. Confirm the Savant PAS-1000 exists in the System Overview by selecting the Overview tab. The Savant 
PAS-1000 is shown as a phone extension in the list of Phones as Unregistered.
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After the next procedure (Uploading Configuration File to the Savant PA System) is completed the Savant PAS-1000 
registration status should change to OK.
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Uploading Configuration File to the Savant PA System
For the Savant Public Announcement System (PAS-1000) the default user name and password are as follows:

User: admin
Password: 0000

Note that the password uses zeros.

To upload a configuration file to the Savant PAS-1000, do the following.

1. Open a web browser and type in the IP address you wrote down from the previous procedure. This will open the 
main page of the Savant PAS-1000 web-based user interface. See the next screenshot.

  Confidential and Proprietary                                                                         77 of  272Savant Telephony Solution Deployment Guide
Release PBX 6.0
009-0406-14



2. Select Advanced under Setup in the side bar, then click Update.

3. Paste the TFTP URL copied above into the Setting URL field.
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4. Click Save.

5. Click Reboot.

6.  After the Savant PAS-1000 boots up it should be registered with the Savant PBX. You can check the registration 
status by viewing the Savant Configurator system Overview page (accessed from the Overview tab). See the 
next screenshot.

5. Click Reboot.

6.  After the Savant PAS-1000 boots up it should be registered with the Savant PBX. You can check the registration 
status by viewing the Savant Configurator system Overview page (accessed from the Overview tab). See the 
next screenshot.
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Configuring the Door Entry Systems
The Savant PBX can be integrated with the following door entry systems:

• Holovision 404
• Siedle

Both of these are analog systems, hence they need an Integrated Access Device (TEL-IAD2)—also referred to as a 
Linksys PAP2T or ATA device—to be able to connect to the Savant PBX system.
For more details on configuring door entry systems, see the section on Third-Party Door Entry Systems Integration, 
which also includes VoIP door entry systems.

This procedure describes the configuration of the Holovision 404 but the steps are also applicable to the Siedle.
The only configuration required for the entry unit is the TEL-IAD2.

NOTE: The door entry system requires no configuration in RacePoint Blueprint™.

After the TEL-IAD2 is configured, this device must be added to the Savant PBX configuration. 

To add the TEL-IAD2 to the Savant PBX configuration, do the following.

1. Open your web browser and enter the IP address of the Savant PBX. This opens the Savant Configurator.

2. Select the Device tab to open the Devices page.
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3. Select Add Device to open the Add Device page. See the next screenshot.

4. Use the next table to enter or select values for the fields on the Add Device page. 

Field Description

Server Available servers will be in a drop-down list. Choose the server in which the new 
device should register. There should only be one (leave as is). 

Type Provides a drop-down list of the available types of devices that can be added to 
the server. Select this option: ATA Device.

Device Number Enter the value you used when the TEL-IAD2 was initially configured.

Assign to Provides a drop-down list of all users that the device can be assigned to. It can 
also be unassigned. Savant Systems recommends this field be unassigned. 

Friendly Name Name that displays when a call is made from this phone.

UID This is auto-assigned. No action is needed.

Context A collection of extensions on the Savant PBX server. 
Default is Phone (all_calls). Use the default value.

Usable as Trunk Leave the check box blank.  

Use TCP Leave the check box blank.

Secret Leave it blank.

Call Limit Enter 2.

Host Dynamic

Port 5060

NAT
Network Address Translation (NAT) helps determine if this device is on the 
internal network or outside the firewall. Turn NAT to register devices outside the 
internal network. Insert a check mark in the check box.

Register? Leave the check box blank.

Qualify Insert a check mark in the check box.

Advanced Leave blank.

4. Click Add & Exit.
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Adding an iOS Device or Phone to an SLA
Shared Line Appearance (SLA) allows a station to be mapped to a SIP telephony gateway (device). The SLA feature 
allows extensions to share an external Central Office (CO) line—sometimes referred to as POTS (plain old telephone 
service). Calls coming from the CO line will ring all member extensions assigned to the line. Answering from one 
member extension will stop ringing on all other extensions. The call can be easily transferred from one member 
extension to another by putting it on hold and picked up from the other. It also allows one to join the active call from a 
member extension, so that a two-party conversation becomes a multi-party conference.

Your system is pre-configured with up to four SLA lines. These lines are named "Line1", "Line2", "Line3" and "Line 4".  
Please do not modify the names of these SLA lines.

To add a previously configured phone or iOS device (iPhone/iPad/iPod touch) to an existing Shared Line Appearance 
(SLA) line, do the following.

1. Click the SLA tab to open the Shared Lines page.

2. Select the radio button for the SLA line to which you want to add a phone or iOS device.

3. Click Edit Shared Line to open the Edit Shared Line page.

Adding an iOS Device or Phone to an SLA

Shared Line Appearance (SLA) allows a station to be mapped to a SIP telephony gateway (device). The SLA feature 
allows extensions to share an external Central Office (CO) line—sometimes referred to as POTS (plain old telephone 
service). Calls coming from the CO line will ring all member extensions assigned to the line. Answering from one 
member extension will stop ringing on all other extensions. The call can be easily transferred from one member 
extension to another by putting it on hold and picked up from the other. It also allows one to join the active call from a 
member extension, so that a two-party conversation becomes a multi-party conference.

Your system is pre-configured with up to four SLA lines. These lines are named "Line1", "Line2", "Line3" and "Line 4".  
Please do not modify the names of these SLA lines.

To add a previously configured phone or iOS device (iPhone/iPad/iPod touch) to an existing Shared Line Appearance 
(SLA) line, do the following.

1. Click the SLA tab to open the Shared Lines page.

2.  Select the radio button for the SLA line to which you want to add a phone or iOS device.

3.  Click Edit Shared Line to open the Edit Shared Line page.

4. Click Members (no changes are required).

5. From the Available Stations list box, drag a selected station number (phone or iOS device) or click the arrow 
(<<) for a selected station number to be added to the Shared Line Members list box.
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4. Click Members (no changes are required).

5. From the Available Stations list box, drag a selected station number (phone or iOS device) or click the arrow 
(<<) for a selected station number to be added to the Shared Line Members list box.
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6. Click Save.

7. Click Save Shared Line.

8. For iOS devices, reload the instance on the device so that the SLA data is updated.

9. For wired Savant phones follow the next procedure, Regenerating a Configuration File for a Savant Phone.
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6. Click Save.

7. Click Save Shared Line.

8. For iOS devices, reload the instance on the device so that the SLA data is updated.

9. For wired Savant phones follow the next procedure, Regenerating a Configuration File for a Savant Phone.
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Regenerating a Configuration File for a Savant Phone
To regenerate a configuration file for a Savant phone after the phone has been added to a shared line 
(SLA), do the following.

1. Click the Phone tab to open the Configured Phones page. 
2. Select the radio button for the phone you want to add to the shared line.

3. Click Edit Phone. 

4. Click Save, since there is no need to change anything. 

5. To reload the configuration to the phone, you must open the Savant phone web-based user interface (Aastra). 
On the Configured Phones page click the IP address of the phone.

  Confidential and Proprietary                                                                         84 of  272Savant Telephony Solution Deployment Guide
Release PBX 6.0
009-0406-14



6. Under Operation in the left pane, click Reset. See the next screenshot.

7. Click Restart to reboot the phone.

8. After the phone restarts from reboot, in Savant Configurator click Devices to check the status of the phone for 
which a configuration file has been regenerated. If the Devices page shows OK, the phone is ready to make and 
receive calls.
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Adding Voice Mail to a Savant PBX
Voice mail in a Savant PBX system can work in two different ways:

• Use one global voice mail box. 

There is only one voice mail box in the system, and all devices in the system can share the voice mail box. When a 
voice mail is left, all devices sharing the voice mail box would receive notification, unless Message Waiting Indicator 
(MWI) is disabled for the device (see Adding Endpoints to the Savant PBX). The message can be retrieved from 
any device without entering a PIN when the PIN-less access is enabled, and once it is retrieved the MWI on all 
devices would reflect the change.

• Use individual voice mail boxes. 

There is one voicemail box per user, and one device needs to be assigned to each user. When voice mail is invoked, 
the caller can select to which person he/she wants to leave a message through an Interactive Voice Response 
(IVR) so that the message will be left to that person’s voicemail box. Only the device assigned to the person who is 
left a message receives notification. PIN-less access to voicemail, if enabled for a user, can only be done through 
the device assigned to the user.

NOTE: You can either enable global voicemail box or individual voicemail box, but not both in the same system.

Global Voice Mail Boxes
To add global voice mail functionality to the Savant PBX for individual mailboxes, do the following.
1. Click the Voicemail tab to open the Voicemail Settings page.
2. Insert a check mark in the Voicemail Enabled check box.
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3. Use the next table to enter or select values for the fields on the Voicemail Settings page.

Field Description

Voicemail Extension Extension number to access voice mail system. Use the default value.

Maximum # of Messages Maximum number of messages stored in the system. 
Enter a value from 1-100. Default is 100.

Maximum Message Length Maximum number of seconds an incoming message can be recorded. Enter 
a value from 120–300. The default value is 180 seconds.

Minimum Message Length Minimum number of seconds an incoming message must before notification 
is generated by the voice mail system.

Maximum Greeting Length Maximum number of seconds that an outgoing greeting message can be 
recorded.  Enter a value from 30–120. The default is 60 seconds.

Time before failover Number of seconds to ring before failover to voice mail system. 
Enter a value from 10–60. The default is 30.

Global Voicemail Box Default is 2998.

PIN
PIN used to access the global voicemail box.
PIN-less voice mail access is available from assigned devices. If PIN access 
is not required, insert a check mark in the box.

Email

Email address to notify when there is a new voice mail message in the 
system.
NOTE: If	
  you	
  are	
  not	
  receiving	
  email,	
  likely	
  your	
  Internet	
  Service	
  Provider	
  (ISP)	
  has	
  

implemented	
  messaging	
  restricDons.	
  Please	
  contact	
  the	
  Technical	
  Assistance	
  Center.

4. Click Save.

Individual Voice Mail Boxes
To add individual voice mail functionality to the Savant PBX, do the following.
1. Create a user for each person who wants to have a voice mail box. If you have not done so, please refer to the 

procedure: Adding a User to the Savant PBX. 

2. Assign a device to each user. Ensure that it is one user per one device. If you have not done so, please refer to 
these procedures: Adding an iOS Device to the Savant PBX or Adding a Phone to the Savant PBX.

3. Insert a check mark in the Voicemail Enabled check box.
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4. Use the next table to enter or select values for the fields on the Voicemail Settings page.

Field Description

Voicemail	
  Extension Extension	
  number	
  to	
  access	
  voice	
  mail	
  system.	
  Use	
  the	
  default	
  value.

Maximum	
  #	
  of	
  Messages Maximum	
  number	
  of	
  messages	
  stored	
  in	
  the	
  system.	
  
Enter	
  a	
  value	
  from	
  1-­‐100.	
  Default	
  is	
  100.

Maximum	
  Message	
  Length Maximum	
  number	
  of	
  seconds	
  an	
  incoming	
  message	
  can	
  be	
  recorded.	
  
Enter	
  a	
  value	
  from	
  120–300.	
  The	
  default	
  value	
  is	
  180	
  seconds.

Maximum	
  Gree;ng	
  Length Maximum	
  number	
  of	
  seconds	
  that	
  an	
  outgoing	
  gree;ng	
  message	
  can	
  
be	
  recorded.	
  	
  Enter	
  a	
  value	
  from	
  30–120.	
  The	
  default	
  is	
  60	
  seconds.

Time	
  before	
  failover Number	
  of	
  seconds	
  to	
  ring	
  before	
  failover	
  to	
  voice	
  mail	
  system.	
  
Enter	
  a	
  value	
  from	
  10–60.	
  The	
  default	
  is	
  30.

Global	
  Voicemail Uncheck	
  the	
  box.

Voicemail	
  IVR	
  Extension Default	
  is	
  2996.

Default	
  Voicemail	
  Box Select	
  a	
  default	
  voicemail	
  box	
  from	
  the	
  drop	
  down	
  list.	
  This	
  will	
  be	
  
used	
  when	
  there	
  is	
  no	
  selec;on	
  made	
  on	
  the	
  IVR.

Enable	
  Individual	
  Voicemail A	
  table	
  with	
  all	
  the	
  users	
  and	
  their	
  assigned	
  devices.	
  Insert	
  a	
  check	
  
mark	
  in	
  the	
  box	
  to	
  enable	
  voicemail	
  for	
  a	
  user.	
  By	
  default,	
  it’s	
  
enabled	
  .	
  	
  

5. Click Save.
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Adding Voice Mail IVR to a Savant PBX
If individual voice mail boxes are used in the Savant PBX system, voice mail Interactive voice response (IVR) must 
be set up. If a global voice mail box is used or voice mail is not enabled in the system, you can skip this section.

To set up the IVR, a sound file for greeting and a sound file for each user’s name need to be in the system. For 
example, if individual voice mail is used for the “Smith family” that has three members, John, Joanne, and Tom, there 
are four sound files needed. One greeting “Thank you for calling the Smith home”, and three for names John, Joanne, 
and Tom.  The IVR will be “Thank you for calling the Smith home. For John press 1, for Joanne press 2, for Tom press 
3”.

The sound files can be recorded through PBX or uploaded to the PBX.

Recording Sound Files
To record a sound file through Savant PBX, do the following:

1. Choose a user. 
2. Dial 2995.  

3. When prompted to enter agent number, enter the number of the device that is assigned to the user—for 
example, 2010.

4. When prompted to enter password, enter the PIN number assigned to the user.(PINs must be assigned and you 
can customize PINs.)

5. Follow the prompt to record and save sound file.

6. Click Sounds tab. The sound just recorded will be shown under the Contents, with the <first name>-<last 
name>-<year-month-day-hour-minute-second> as the file name.

7. The file name can be changed by click Rename button, enter new name then click Submit.
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8. The content of a file can be listened by click the name, then click the Listen button.

Uploading Sound Files
To upload IVR sound files to Savant PBX, do the following:

1. Have sound files ready on SDE, they can be in .mp3, .wav or .aiff format.  
2. Click Sounds tab, then click Choose File 

3. Select the file then click Choose.
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4. Click Add Another File to add more files. When done click Upload.
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5. Uploaded sound file appears under Contents.

Assigning Sound Files to IVR
To assign sound files to voicemail IVR, do the following.

1. Click the Voicemail tab, then click Voicemail IVR from the left. Greeting and all the voicemail box number and 
it’s user will be displayed. 

2. Select the correct sound file from the drop down list for Greeting and all users, then click Save.  
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Adding Voice Mail to a Shared Line
NOTE: Voice mail must be added to at least one phone or iOS device to complete this procedure.

To add voice mail to a shared line, do the following.

1. Click the SLA tab to open the Shared Lines page.

2. Select the radio button for the shared line (SLA) being associated with the voice mail.

3. Click Edit Shared Line to open the Edit Shared line page.

Adding Voice Mail to a Shared Line

To add voice mail to a shared line, do the following.
NOTE: Voice mail must be added to at least one phone or iOS device to complete this procedure.

1. Click the SLA tab to open the Shared Lines page.

2. Select the radio button for the shared line (SLA) being associated with the voice mail.

3. Click Edit Shared Line to open the Edit Shared line page.

4. Use the next table to enter or select values for the fields on the Add Extension page.

Field Description
Z*5/ ",-/<.*.,*5/.M8<.-?6=.=?*</4.L6,/\

X/+6O/ #/*+/.*=.6=\

H6,:.!65/8;- T=/.-?/.+*L;/.C!"#$%#&'(#$&)*+',#(E.-?*-.0*=./,-/</4.8,.-?/.J4#1$,+#').$K%?7.
>*:/.6,.-?/.><8O/4;</_.-..*/0$1'*2#$3)*+$4'$)$5),)/4$6789.

F*<:/ #/*+/.-?/.O?/OU.5*<U\

Y8L4 T=/.-?/.4/M*;L-.+*L;/_.4=$%

]*6L.!8 )/L/O-.J4#1$,+#'\

]*6L."[-/,=68, .)/L/O-.-?/.:L8K*L.+86O/5*6L.K8[.,;5K/<./,-/</4.8,.-?/.J4#1$,+#').$K%?7.>*:/.
6,.-?/.><8O/4;</_.-..*/0$1'*2#$3)*+$4'$)$5),)/4$678\

5. Click Save Shared Line.
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4. Use the next table to enter or select values for the fields on the Add Extension page.

Field Description

Name Enter a name for this shared line.

Device Leave as is.

Ring Timeout Use the value (time before failover) that was entered on the Voicemail Settings 
page in the procedure: Adding Voice Mail to a Savant PBX. 

Barge Leave the check mark.

Hold Use the default value: open

Fail To Select Voicemail.

Fail Extension Select the global voicemail box number entered on the Voicemail Settings page 
in the procedure: Adding Voice Mail to a Savant PBX.

5. Click Save Shared Line.
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Adding the Paging Functionality

To add paging functionality to the Savant PBX system, do the following.

1. Click the Call Groups tab to open the Call Groups page. A call group should have been created 
automatically when you loaded the initial configuration in the procedure, Uploading the plist. If you want 
to use that group, continue this procedure at step 5.

2. Click Add Group to open the Add Call Group page.

3. Use the next table to enter or select values for the fields on the Add Call Group page. Note that 
when you select Paging as the Type, the Fail Extension field is not available.

Field Description
Name Enter	
  the	
  group	
  name.

Full	
  Duplex	
  
Insert	
  a	
  check	
  mark	
  in	
  the	
  Full	
  Duplex	
  check	
  box	
  if	
  two-­‐way	
  communica;on	
  is	
  
required.	
  (This	
  field	
  is	
  enabled	
  aMer	
  you	
  select	
  the	
  Type:	
  Paging.

Distributed	
  Audio	
  
Zones

Insert	
  a	
  check	
  mark	
  if	
  you	
  want	
  to	
  use	
  paging	
  with	
  	
  the	
  PAS	
  -­‐1000	
  system.

Type Select	
  the	
  Paging	
  from	
  the	
  drop-­‐down	
  list.	
  

4. Click Save Group.
5. Select the radio button for the call group you want to modify, and then click Edit Members.

6. From the Available Devices list box—which shows all of the devices added previously— drag a 
selected device or click the arrow (<<) for a selected device to the Group Members list box.
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7. Click Save. 

8. NOTE: The call group that was created automatically when you loaded the initial configuration in the 
procedure, Uploading the plist, includes the paging extension number 8000. If you want to add 
another group with a different extension number, continue with the next steps. 

9. Click the Extensions tab to open the Extensions page. 

10. Click Add Extension to open the Add Extension page.

11. Use the next table to enter or select values for the fields on the Add Extension page.

Field Description

Number Enter an extension number from this range: 8001-8499.

Extension Type Select Call Group 

Destination Select the call group you created previously in this procedure. 

12. Click Add New Ext.
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Adding a Phone or iOS Device to a Paging Group
To add a phone or an iOS device to a paging group, do the following.

1. Click the Call Groups tab to open the Call Group page.

2. Select the group to which the newly added phone or iOS device is to be added.

3. Click Edit Group.

4. From the Available Devices list box, drag a selected device (phone or iOS device) or click the 
arrow (<<) for a selected device to the Group Members list box.

5. Click Save. 

  Confidential and Proprietary                                                                         97 of  272Savant Telephony Solution Deployment Guide
Release PBX 6.0
009-0406-14



Editing a Dial Plan

A dial plan describes the number and pattern of digits that a user dials to reach a particular telephone number. 
Access codes, area codes, specialized codes, and combinations of the number of digits dialed are all part of a dial 
plan. For example, the North American Public Switched Telephone Network (PSTN) uses a 10-digit dial plan that 
includes a three-digit area code and a seven-digit telephone number. 

For Savant wired phones—TEL-HST01 and TEL-HST02—if the user picks up a handset or presses the speaker key 
to get dial tone and then starts to enter a destination number, the phone will initiate the call when an exact match is 
found in the dial plan. In this case, there is no need to press the Dial key or wait for a timeout. Note that if a user 
enters the destination number directly when the phone is on-hook the dial plan will not take effect—in which case, the 
user has to press the Dial key or pick up the handset to initiate the call.

An administrator can use the custom dial plan field on the Phone page in Savant Configurator to create a dial plan 
that fits the needs of users.
The custom dial plan field accepts up to 512 characters. If a user enters a dial plan longer than 512 characters, or a 
parsing error occurs, the phone uses the default dial plan of “xx+#|xx+*”.

The symbols available to create a dial plan are as follows:

Symbol Description

1, 2, 3, 4, 5, 6, 7, 8, 9, 0 digit symbol

X match any digit symbol

*, #, . other keypad symbol

| Expression inclusive OR

+ 0 or more of the preceding digit symbols or [] expression

[] Symbol inclusive OR

- Used only with [], represent a range of acceptable symbols. 
For example: [2-8]

Dial Plan Example
An example of a custom dial plan is as follows:

[23]XXX|[4-8]XXXX|1XXXXXXXXXX|*XX

The dial plan in the above example can accept the following:
• Any four-digit dial strings that begins with a 2 or 3
• Any five-digit dial strings that begin with a 4 up to 8
• Any 11-digit dial strings that begin with 1
• Any two-digit code that begins with an asterisk (*).

NOTE:  A conflict in the dial plan will cause a call to the wrong destination or even failure. For example, if 
2XXX and 202XXXXXXX co-exist in the dial plan, the call can never be made to 202XXXXXXX 
destinations.
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Customization
To access the Custom Dialplan field, in Savant Configurator select the Phones tab and then click Phone Dialplans 
from the Phones side bar on the left. See the next example screenshot.

For Custom Dialplan enter the characters applicable to the dial plan and then click Save.

You can verify the dial plan from phone’s web user interface under Basic Settings->Preferences. (for login details 
see Adding a Savant Wired IP Phone as a Phone.
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Setting Up Time-of-Day Routing 
Time of the day routing allows a user to direct incoming calls from Central Office (CO) lines to different destinations 
based on the time of the day. 

To set up the time-of-day routing in Savant Configurator, do the following.

1. Click the Extensions tab.

2. Click DID Routing Rules from the Routing side bar on the left. 

3. Click Add Rule button to open the Add Routing Rule page. 

4. From the DID Extension drop-down list (circled in the next screenshot), select a value.

5. Use the next table to enter or select values for the fields on the Add Routing Rule page.

Field Description

DID Extension Select from the list the incoming CO line to which the rule should apply.
Choose 6296 for line 1, 6297 for line 2, 6298 for line 3, or 6299 for line 4.

Start Time Select the desired start time.

End Time Select the desired start time.

Destination Ext. Select a desired destination extension. 

6. Check the box for the day or specific date the rule should take effect. 

7. Click Add New Rule.
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8. Confirm the rule has been added by clicking DID Routing Rules from the Routing side bar on the left. The new 
rule should be displayed on the Time-based DID Routing Rules page.

9. Repeat steps 3-7 to add more rules, if required.

10. For the example shown in the next screenshot, on every Thursday from 2:30 PM to 3:00 PM, the call coming 
from CO line 1 will terminate on extension 2018 only. On every Thursday from 3:00 PM to 3:30 PM the call 
incoming from CO line 1 will terminate on extension 2002 only. The rest of the time the call will be routed 
normally as indicated from Extensions page.

  Confidential and Proprietary                                                                         101 of  272Savant Telephony Solution Deployment Guide
Release PBX 6.0
009-0406-14



Performing a Backup for the Savant PBX
The backup function allows you to save your Savant PBX configuration. If the system needs to be reset to the factory 
default settings or the hardware itself needs to be replaced, a backup file allows you to restore the system as it was at 
the time the backup file was generated.

This procedure assumes you have been using Safari as your web browser to open Savant Configurator.

To create a backup of your Savant PBX configuration, do the following.

1. In Safari go to the menu: Safari > Preferences. 

2. On the General window, ensure the checkbox for Open “safe” files after downloading is unchecked (blank). 
See the next screenshot.
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3. Click the Backups tab from Savant Configurator. 

The left side of the page shows backups automatically generated by the system. By default, a backup file is 
generated everyday at 3:00 AM, and the system keeps the backups for the last 14 days. If you want to download 
a automatically generated backup file, go to step 8.

4. If you want to manually generate a backup file, click Create button under Manual Backups.

5. On the pop up window, enter a name that you want to use as a prefix on the backup file, which will be named 
<name>_backup_<date>.zip. 

For example, if you create a backup on November 9, 2011 and enter mypbx as the prefix then the backup file 
name will be mypbx_backup_20111109.zip. 

6. Click Create. The new backup file will display on the backups page in Savant Configurator in a few minutes.
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7. Confirm that the backup file is shown under Manual Backups.

8. Select the backup file you want to download by clicking the radio button beside the file.

9. If an automatic backup is selected, click Download under Automatic Backups. If a manually generated backup 
is selected click Download under Manual Backups.

10. The file should be downloaded to the Downloads folder of the computer running Savant Configurator.
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Restoring the Savant PBX Configuration
The restore function allows you to restore the Savant PBX with a previously saved configuration using the backup 
function described in Performing a Backup for the Savant PBX. The Savant PBX can be set up with minimal 
configuration effort if the system has to be reset to the factory default settings or the hardware itself has to be 
replaced. Note that the restore is intended to work on the same installation from which the backup file is generated.

When performing a restore of a Savant Configurator configuration, ensure that you are applying the restore to a clean 
system.

To restore your Savant PBX configuration, do the following.

1. Select System Reset from the side bar on the Overview page.

If the physical PBX is changed, ensure that the new PBX has the same IP address as the one it replaces.

2. Click the Backups tab.

3. Click the Add Files button.

4. Select the file you want to use to restore then click Open button. See the next screenshot.
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There should be a progress bar showing the upload process and the file should show up under Manual 
Backups after the upload completes.

5. Under Manual Backups click the radio button for the backup file you want to use to restore the system, then 
click Restore. See the next screenshot.
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6. Click OK on the pop up window.

7. Wait until a restore_point_<date> file shows up under Manual Backups. 

8. Check Devices, Extensions, SLA, Voicemail and Call Groups page, ensure the configurations are what you 
expect.
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9. Click Phones.

Note that the Device field is empty. After performing a restore, a device must be assigned to each phone listed 
on this page.

10. Click the radio button beside a phone, then click Edit Phone.

11. Select one device from Identity 1 selection list, click Save.

12. Restart the phone. For details on restarting the phone, see the procedure, Uploading the Configuration to the 
Wired Phone.
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Configuring Music-On-Hold
The only sound format that the Savant PBX supports for the music-on-hold feature is MP3. 
To change or customize the music played while a call is on hold, do the following using Savant Configurator.

1. Click the Sounds tab.

2. From the Sounds sidebar on the left click Music On Hold.

Configuring Music-On-Hold
The only sound format that the Savant PBX supports for the music-on-hold feature is MP3. 
To change or customize the music played while a call is on hold, do the following using Savant Configurator.

1. Click the Sounds tab.

2. Click Music On Hold from the Sounds sidebar on the left.

3. Click default under Contents > Sounds.

4. On the left side is MusicOnHold Manager, click Choose File. 
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3. Click default (circled in the next screenshot).

Configuring Music-On-Hold
The only sound format that the Savant PBX supports for the music-on-hold feature is MP3. 
To change or customize the music played while a call is on hold, do the following using Savant Configurator.

1. Click the Sounds tab.

2. Click Music On Hold from the Sounds sidebar on the left.

3. Click default under Contents > Sounds.

4. On the left side is MusicOnHold Manager, click Choose File. 
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4. Under MusicOnHold Manager, click Choose File. 

5. Choose the music file you want to use for music-on-hold. Note that the file must be an *.mp3 file. Click Choose.

6. If more music files are required, click Add Another File, repeat steps 4 and 5.

7. Click Upload.
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5. Highlight the music file you want to use for music-on-hold. Note that the file must be an *.mp3 file. 

6. Click Choose.

5. Choose the music file you want to use for music-on-hold. Note that the file must be an *.mp3 file. Click Choose.

6. If more music files are required, click Add Another File, repeat steps 4 and 5.

7. Click Upload.
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7. If more music files are required, click Add Another File, repeat steps 4 and 5.

8. Click Upload.

9. All music files, including just added ones, should show up under MusicOnHold Options. Highlight one then click 
the up, down, or delete button to change the order or delete it from the system.

8. All music files, including just added ones, should show up under MusicOnHold Options. Highlight one then click 
up, down or delete button to change order or delete it from the system.

9. Click Save Changes. 

10. Wait for a couple of minutes and then verify that the music file has been changed.
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10. Click Save Changes. 

11. Wait for a couple of minutes and then verify that the music file has been changed.
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Changing PBX Network Configuration
The Savant PBX network configuration can be changed using Savant Configurator. A Dynamic Host Configuration 
Protocol (DHCP) IP address or static IP address can be assigned to the PBX. 

To change the PBX network configuration, do the following.

1. On the Overview page, click the Network Config from System sidebar on the left.

2. Click eth0. Note that the current network configuration is displayed on the left side.

3. For the Configuration Method select an option from the drop-down list. In the next example screenshot the IP 
address can be changed from Dynamic Host Configuration Protocol (DHCP) to a static assigned IP address.

Changing PBX Network Configuration
The Savant PBX network configuration can be changed using Savant Configurator. A Dynamic Host Configuration 
Protocol (DHCP) IP address or static IP address can be assigned to the PBX. 
To change the PBX network configuration, do the following.

1. On the Overview page, click the Network Config from System sidebar on the left.

2. Click eth0. The current network configuration is displayed on the left side.

3. For the Configuration Method select an option from the drop-down list. In the next example screenshot the IP 
address can be changed from Dynamic Host Configuration Protocol (DHCP) to a static assigned IP address.

4. Select static for Configuration Method. 

5. Use the next table to enter or select values for the fields on the Editing Interface page.

Fields Value

inet addr IP address to be assigned to Savant PBX

netmask Netmask in your network. Check with your network administrator. 
(Typically this will be the same as displayed in current configuration.)

gateway Gateway IP in your network. Check with your network administrator.
(Typically this will be the same as displayed in current configuration.)

nameserver 1 DNS server in your network. Check with your network administrator.
(Typically this will be the same as displayed in current configuration.)

nameserver 2 Second DNS server in your network. Check with your network 
administrator.(Typically this will be the same as displayed in current 
configuration.)
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4. Select static for Configuration Method to open more options on the Editing Interface page. See the 
screenshot on the next page.
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6. Click Save. 

7. Read the message on the page then click here (as shown in the next screenshot) to reboot the system.

8. After the system reboot, open Savant Configurator and verify the change by navigating to the Overview page, 
clicking Network Config from the System sidebar on the left, and then clicking eth0.
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5. Use the next table to enter or select values for the fields on the Editing Interface page.

Fields Value

inet addr IP address to be assigned to Savant PBX

netmask Netmask in your network. Check with your network administrator. 
(Typically this will be the same as displayed in current configuration.)

gateway Gateway IP in your network. Check with your network administrator.
(Typically this will be the same as displayed in current configuration.)

nameserver 1 DNS server in your network. Check with your network administrator.
(Typically this will be the same as displayed in current configuration.)

nameserver 2 Second DNS server in your network. Check with your network 
administrator.(Typically this will be the same as displayed in current 
configuration.)

6. Click Save. 

7. Read the message on the page then click here (as shown in the next screenshot) to reboot the system.

6. Click Save. 

7. Read the message on the page then click here (as shown in the next screenshot) to reboot the system.

8. After the system reboot, open Savant Configurator and verify the change by navigating to the Overview page, 
clicking Network Config from the System sidebar on the left, and then clicking eth0.
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8. After the system reboot, open Savant Configurator and verify the change by navigating to the Overview page, 
clicking Network Config from the System sidebar on the left, and then clicking eth0.

6. Click Save. 

7. Read the message on the page then click here (as shown in the next screenshot) to reboot the system.

8. After the system reboot, open Savant Configurator and verify the change by navigating to the Overview page, 
clicking Network Config from the System sidebar on the left, and then clicking eth0.
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Setting Local Time Zone on PBX and Wired Phones
To set the local time zone for the Savant PBX and TEL-HST01 and TEL-HST02 phones using Savant Configurator, 
do the following.

1. On the Overview page, click Set Timezone from System panel on the left.

The current time zone information is displayed, as shown in the next screenshot.

2. From the drop-down list select the city that is in your local time zone. For example, choose America/New_York 
for the US Eastern time zone, or America/Los_Angeles for US Pacific time zone.

Setting Local Time Zone on PBX and Wired Phones
To set the local time zone for the Savant PBX and TEL-HST01 and TEL-HST02 phones using Savant Configurator, 
do the following.

1. On the Overview page, click Set Timezone from System panel on the left.

The current time zone information is displayed, as shown in the next screenshot.

2. From the drop-down list select the city that is in your local time zone. For example, choose America/New_York 
for the US Eastern time zone, or America/Los_Angeles for US Pacific time zone.

3. Click Save. This will cause the system to restart.

4. If the time zone is changed after the wired phones—TEL-HST01 and TEL-HST02—are configured, restart the 
TEL-HST01 and TEL-HST02 phones to enable the time zone change on the phones.
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3. Click Save. This will cause the system to restart.

4. If the time zone is changed after the wired phones—TEL-HST01 and TEL-HST02—are configured, restart the 
TEL-HST01 and TEL-HST02 phones to enable the time zone change on the phones.
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Configuring Additional Gateways
Use the information in the next table as a reference when adding the Savant gateways as devices in the PBX system 
using Savant Configurator. Each gateway has the following lines and Shared Line name assignments. Note that the 
Gateway Index is the index associated with the gateway in RacePoint Blueprint™.

Gateway Index Assignment

Gateway Index Physical FXS Port SLA Name

1 1 Line1

1 2 Line2

1 3 Line3

1 4 Line4

2 1 Line5

2 2 Line6

2 3 Line7

2 4 Line8

3 1 Line9

3 2 Line10

3 3 Line11

3 4 Line12

4 1 Line13

4 2 Line14

4 3 Line15

4 4 Line16

5 1 Line17

5 2 Line18

5 3 Line19

5 4 Line20

6 1 Line21

6 2 Line22

6 3 Line23

6 4 Line24
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To add additional gateways to a Savant PBX system that already has a gateway configured, do the following.

1. Click the Devices tab.

2. Click Add Devices to open the Add Device page.

3. Use the next table to enter or select values for the fields on the Add Device page. See the previous screenshot 
with the example data.

Fields Value

Type Select Gateway

DeviceNumber Enter a unique name for this gateway. Savant recommends using the 
gateway index and the end of the name , for example Gateway2.

Friendly Name For Friendly Name  enter the same value you entered for the Device 
Name

Max Channels Enter 4.

Host Enter the IP address of the gateway

4. Click Add & Exit.

If a Shared Line Appearance Group (SLA) group must be assigned to multiple gateways, see Adding an SLA to 
Multiple Gateways.
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Adding an SLA to Multiple Gateways
Depending on the gateway index and lines you want to add , the corresponding Share Line Appearance (SLA) groups 
must be assigned. Using the table, Gateway Index Assignment  enter the associated SLA names when creating the 
SLA Group. 
To add an SLA to multiple gateways, do the following.
1. Click SLA tab.

2. Click Add SLA.

3. For Name use the table, Gateway Index Assignment. Ensure that the name is typed correctly.

4. For Device select the required gateway from the drop-down list.

5. Click Add Shared Line.

After adding at least one SLA group to the gateway the Overview page will show the gateway.

After all the SLA lines and associated gateways have been added, you can add endpoints to different SLA 
groups. See Adding an iOS Device or Phone to an SLA.
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Performing Advanced Configuration
This feature is intended to simplify configuring additional parameters on a global basis or per device using Savant 
Configurator. By using Advanced Configuration you avoid the need to manually change configuration files. This 
feature is not to be used without previously consulting with Savant Technical Support. An incorrect parameter could 
negatively affect the Savant PBX behavior.

Global
To change a global parameter in a Savant PBX configuration, do the following.

1. Click the Overview tab.
2. In the left pane, click Advanced.

3. After consulting with Savant Technical Support enter the appropriate parameters.

4. Click Submit.
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Device Configuration
To change a device parameter in a Savant PBX configuration, do the following.

1. Click the Devices tab.
2. Select the appropriate device.
3. Click Edit.

 

4. With the supervision of  the Savant Technical Assistance Center enter the appropriate parameter for the device 
being configured.

5. Click Save.
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Configuring Distinctive Ringing
Distinctive Ringing allows you to set different ringing tones on your devices (phones and iOS devices). The Savant 
phones—TELHST01 or TEL-HST02—are the only hardware phones that support this Distinctive Ringing feature. 

With Distinctive Ringing, for example, the ring could be used to differentiate external calls and calls that are originated 
at the gate (door entry) stations.

Savant Systems offers five stock ringtones including a silent one. The iOS devices also allow the creation of up to 
four custom mp3 files that can be used as ringtones. 

The Distinctive Ringing feature is configured in a Savant system using the following procedures:

• Configuring a Configuring a Custom *.mp3 File as a Ring Tone

• Creating a Ring Profile 

• Assigning a Ring Profile to a Phone or iOS Device 

• Configuring Priority Alerting for an SLA Group

• Configuring Priority Alerting for a Call Group 

• Distinctive Ring Configuration Examples
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Configuring a Custom mp3 File as a Ring Tone
To add custom rings for an iOS device, do the following.

1. Click the Ring Profiles tab.
2. In the left pane, click iOS Ring Tones.

The iOS Ring Tones page opens.

3. Click Add New.

4. Use the next table to enter or select values for the fields on the Upload Ringtone page.
 

Field Description

Name Name	
  of	
  Custom	
  RingTone.	
  This	
  name	
  will	
  be	
  displayed	
  to	
  the	
  user	
  on	
  the	
  iOS	
  Savant	
  app.	
  

File
Actual	
  audio	
  file.	
  Note	
  that	
  only	
  mp3	
  files	
  are	
  supported	
  any	
  other	
  audio	
  format	
  will	
  result	
  
in	
  no	
  audio	
  being	
  played.

5. Click Save.

Repeat this procedure for every custom ringtone you want to use.
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Creating a Ring Profile
This procedure assumes you have completed the procedure Configuring Distinctive Ringing. To create a ring profile, 
do the following.
1. Click Ring Profile Tab.

2. Click Add New.

3. Use the next table to enter or select values for the fields on the Add Ring Profile page.

Field Description
Profile	
  Name Name	
  of	
  group.	
  

Profile	
  Type Leave	
  as	
  is.

Ring	
  Tone Select	
  an	
  op;on	
  from	
  the	
  drop-­‐down	
  box.

Priority	
  Aler;ng	
  Allowed
Enter	
  the	
  length	
  of	
  ;me	
  that	
  you	
  want	
  the	
  devices	
  to	
  ring.	
  
Recommended:	
  30	
  seconds.

Priority	
  Aler;ng	
  Groups In	
  here	
  	
  for	
  the	
  group	
  you	
  intent	
  to	
  use	
  ,	
  select	
  the	
  proper	
  ring	
  behavior

4. Click Save.
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Assigning a Ring Profile to a Phone or iOS Device
This procedure assumes you have completed the procedure Creating a Ring Profile. After ring profiles have been 
created, you can assign them to a particular iOS device or phone. To assign a ring profile to an iOS device, do the 
following.

iOS Device
1. Click the Devices tab.

2. Select a device from the Devices page to open the Edit Device page.

3. For Ring Profile, select an option from the drop-down list.

4. Click Save.

Phone
To assign a ring profile to a phone, do the following.

1. Click the Phones tab.

2. Select a phone from the Phones page to open the Edit Phone page.

3. For Ring Profile, select an option from the drop-down list.

4. Click Save.
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Configuring Priority Alerting for an SLA Group
Priority alerting allows certain incoming calls to trigger distinctive ringing. This is done by associating a priority group 
(alerting group) to either a call group and/or an SLA group, so that member devices will use the applicable ring 
associated with that call group or SLA group.

To configure priority alerting on an SLA group, do the following.

1. Click SLA tab.

2. Select the proper SLA Line and click Edit Shared Line.

3. Select the Priority Group from the list and click Save Shared Line.
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Configuring Priority Alerting for a Call Group
Priority alerting allows certain incoming calls to trigger distinctive ringing. This is done by associating a priority group 
(alerting group) to either a call group and/or an SLA group, so that member devices will use the applicable ring 
associated with that call group or SLA group.

To configure priority alerting on a call group, do the following.

1. Click Call Groups tab.

2. Select the appropriate Call Group.

3. Select the Priority Group from the drop-down list.
4. Click Save Group.
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Distinctive Ring Configuration Examples
The following are some examples which demonstrate the use of the Distinctive Ring feature.

Differentiate Calls from the Gate Station with a Different Ring
To differentiate calls from the door entry (gate) station with a different ring, do the following in Savant Configurator.

1. Create a ring profile of Type: Phone.

2. Choose a priority alerting group—Internal: for example Bellcore-dr2.

3. Save the phone profile.

4. Assign this profile to every phone you want to ring differently when the call is coming from the gate station.

5. Open the page for the Call Group associated with the gate station. 

6. Edit the Call Group and select Internal for the Priority Group field.

7. Save.

Now when you receive a call  from the door station the phones use a different ringtone.

Differentiate between Two SLA Lines
To differentiate calls between two SLA lines with a different ring, do the following in Savant Configurator.

1. Create a ring profile of Type: Phone.

2. Choose a group for SLA 1 and another for SLA 2.

3. Select the applicable tone for each SLA group.

4. Save the ring profile.

5. Assign this profile to all the phones.

6. Open the edit page for SLA 1 and SLA 2 and assign the applicable Priority Group to each SLA.

Now when calls come in from SLA 1 and from SLA 2 the phones will ring differently.

No Ring for a Particular Phone when Calls are Coming from SLA 2 
To avoid a phone ringing when a call comes in from a specific SLA group, do the following in Savant Configurator.

1. Create a ring profile of Type: Phone

2. Choose a priority alerting group, for example, Internal and select the option Silent.

3. Save the ring profile.

4. Select the Phones tab.

5. Select the phone that should not ring when the call is coming from SLA 2 and assign this profile to that device.

6. Set the SLA tab and open the page to edit SLA 2.

7. For the Priority Group field, select Internal from the drop-down list.

8. Save the ring profile.

Now when calls are coming in on SLA 2 (which is associated with phone line 2) all the phones but one will ring.  
However, in any other scenario phones will ring normally.
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Shared Lines Label
The name of the Shared Line is separate from the actual Label (displayed name on the devices). Also the SLA Name 
is provided in a selection list to avoid potential errors on the name of the SLA.

For an SLA created prior to Release PBX 5.2.1 the Label field is defaulted to the SLA Name for backward 
compatibility. 

For Release PBX 5.2.1 and later the Label is a user defined field, see below:
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Downloading Log Files to an SDE
To download log files to a Savant Development Environment (SDE), do the following in Savant Configurator.

1. Click the Overview tab.

2. From the left sidebar, click Download Log Files.

3. Press the button Click to Download.

4. To open the files within the tar file, for example—savantSystemLog-savant-ipbx-1349733434.tar—use <specify 
application>.
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What To Do Next
Unless you require some optional devices as part of your Savant PBX system, your PBX system is now configured.

The optional devices that can be added to your Savant PBX system, are as follows:

• Savant Public Announcement System —click this link here.
• Door Entry System—click this link here.
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5. SAVANT DECT BASE STATIONS
Use this section to set up your wireless phone system and base station with your Savant PBX system. 

..........................................................................................................Installing Base Stations 130

.............................................................................OpenMobility Manager: Before You Begin 133

..................................................................Generating a License for Multiple Base Stations  134

........................................................................................................Booting the Base Station 138

............................................................................................................Adding a Base Station 148

....................................................................................Adding Handsets to the Base Station 151

.............................................................................Subscribing Handsets to the Base Station 154

If the newer base stations are being added to a PBX system that already has older base stations installed using a 
previous software release, you only need to perform this procedure: 

................................Integrating TEL-BST11/TEL-BST12  with TEL-BST01/TEL-BST02 157

Hardware Considerations
The following information will help you determine what procedures to use when installing hardware. 

• If installing only new base station models (TEL-BST11/TEL-BST12) use the procedures in this section (pages 
108-132).

• If integrating new base station models (TEL-BST11/TEL-BST12) with older models already in use, perform the 
procedure on page 133, Integrating TEL-BST11/TEL-BST12  with TEL-BST01/TEL-BST02. 

• If installing only old base station models (TEL-BST01/TEL-BST02) use the Release PBX 5.1.1 Savant 
Telephony Solution Deployment Guide (009-0406-06).

The model numbers referred to in this section include the following:

Model Number Description
TEL-HSTW01 Wireless DECT Handset

TEL-BST01 Indoor DECT Base Station for integrating with TEL-BST11

TEL-BST11 (new) Indoor DECT Base Station

TEL-BST01I Indoor International DECT Base Station

TEL-BST02 Outdoor DECT Base Station for integrating with TEL-BST12

TEL-BST12 (new) Outdoor DECT Base Station

TEL-BST02I Outdoor International DECT Base Station

TEL-BSTMMT Mast Mount for Outdoor Base Station

TEL-BSTWMT Wall Mount for Outdoor Base Station

Important!  The following procedures included in this section apply when adding newer base stations to your 
Savant PBX system—that is, base station models TEL-BST11 and/or TEL-BST12. If you are adding 
the older base station models,TEL-BST01 and/or TEL-BST02, as the only base stations to be used 
with your Savant PBX system, the procedures presented in this guide are not applicable. You must 
use the relevant procedures included in the Savant Telephony Solution Deployment Guide 
(009-0406-06), which refers to OpenMobility Manager SIP-SECT 2.1SP4.
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Installing Base Stations
Employing DECT wireless technology, the Savant SIP-DECT mobility solution offers superior levels of interference-
free performance and reliability in a cordless SIP telephone system.

The Savant DECT—Digital Enhanced Cordless Telecommunications— base stations comprises the following:
o Savant Base Stations (SIP-DECT Access Points) being distributed over an IP network and offering DECT 

wireless and IP interfaces
o Savant PBX platform 
o Savant DECT Handsets Savant TEL-HSTW01—also known as Portable Parts (PP)
o OpenMobility Manager (OMM) SIP-DECT 3.0: Management interface for the DECToverIP using SIP solution, 

which runs on one of the base stations (Radio Fixed Parts)
o OpenMobility Configurator—a Java tool used to do the initial boot up. Available on the OMM Activation CD

The Savant PBX server and the Savant Gateway, OpenMobility Manager (OMM) and the base stations communicate 
through the IP infrastructure. The base stations and the Portable Parts communicate over the air, where the DECT 
GAP protocol or DECT GAP with proprietary enhancements is used.

Savant Telephony DECT wireless handsets are available with indoor (TEL-BST11) and outdoor (TEL-BST12) DECT 
base stations.

Both DECT base stations are the Radio Fixed Parts for the Savant TEL-HSTW01 handset solution and are directly 
connected to the LAN. The indoor base station TEL-BST11 enables the complete integration of DECT radio networks 
into the IP infrastructure and provides eight simultaneous call connections. It is powered either via a separate power 
supply unit or using Power over Ethernet (PoE).

The outdoor base station TEL-BST12 performs the outdoor operating requirements and is powered using Power-
over- Ethernet.

On the base station locate the port marked LAN and 
plug in an Ethernet cable. Plug the other end of the 
Ethernet cable in to the managed ethernet switch.
Savant recommends using Power Over Ethernet. 
Standards-based (802.3af compliant) Power Over 
Ethernet affords a one-wire solution for connecting 
Ethernet devices, delivering power and data over a 
single CAT5/6 network cable. Using 802.3af compliant 
PoE injectors or PoE Ethernet Switches, there is no need 
to install a separate power supply at the device location. 
The PoE injector or PoE Ethernet Switch can simply be 
mounted at any convenient location up to 100 meters 
(328 feet) from the device.
Due to the inherent voltage drop over copper wire, a 
maximum of 12.9 W is guaranteed to be received by the 
PoE powered device over a cable run length of 328 feet 
(100 meters) per specification.

The figure above shows the Outdoor (right) and Indoor Base Station
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Mounting the Base Station 
An indoor base station can be mounted on a wall or ceiling, or placed on a flat surface. Outdoor base stations can be 
mounted on a wall or mast (2.55 in. or 65 mm or larger). The outdoor base stations can be used for indoor areas with 
difficult radio characteristics. For example, when equipped with beam antennas it can the ideal solution for long 
corridors or elevator shafts.

A base station installation is more reliable if a base station can receive the signal from more than only one base 
station, because the other signals are also used for synchronization.

The sync-over-air solution is very reliable, because all existing redundant paths are used for synchronization. Thus, 
hardware tolerances have only very little influence. No base station has a key position. Only unfavorable setups 
without redundant synchronization paths can cause problems.

Sometimes base stations do not need to be synchronized, for example, if they are in different buildings. These base 
stations can be put into different clusters. Base Stations in different clusters will not be synchronized with each other. 
Different clusters start-up at the same time independently. See the next diagrams.

For optimum range performance, wall mounting is recommended.
Location of the base station can have significant impact on performance.
It is recommended that the base station be located:

• Away from metal objects such as filing cabinets, metal blinds or other metal support structures
• Away from other electronic devices such as CRT’s, desktop computers and other cordless products
• As high as possible with the antennas pointing up in a vertical position.
• The antenna used for the base station transmitter must be installed to provide a separation distance of at 

least 20 cm from all persons.
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Signal Loss Guidelines
Signal loss related to the building materials which exist at an installation is determined in detail by a site survey, but 
the following table provides some guidelines.  For more details on these guidelines see the DECT site survey 
document: http://www.aastra.com/cps/rde/aareddownload?file_id=6023-13550-
_P06_XML&dsproject=aastra&mtype=pdf

LEDs for Indoor Base Station

Installing Base Stations

Employing DECT wireless technology, the Savant SIP-DECT mobility solution offers superior levels of interference-
free performance and reliability in a cordless SIP telephone system.
Savant Telephony DECT wireless handsets are available with indoor (TEL-BST11) and outdoor (TEL-BST12) DECT 
base stations.
Both DECT base stations are the Radio Fixed Parts for the Savant TEL-HSTW01 handset solution and are directly 
connected to the LAN. The indoor base station TEL-BST11 enables the complete integration of DECT radio networks 
into the IP infrastructure and provides eight simultaneous call connections. It is powered either via a separate power 
supply unit or using Power over Ethernet (PoE).
The outdoor base station TEL-BST12 performs the outdoor operating requirements and is powered using Power-
over- Ethernet.

On the base station locate the port marked LAN and plug 
in an Ethernet cable. Plug the other end of the Ethernet 
cable in to the managed ethernet switch.
Savant recommends using Power Over Ethernet. 
Standards-based (802.3af compliant) Power Over 
Ethernet affords a one-wire solution for connecting 
Ethernet devices, delivering power and data over a single 
CAT5/6 network cable. Using 802.3af compliant PoE 
injectors or PoE Ethernet Switches, there is no need to 
install a separate power supply at the device location. 
The PoE injector or PoE Ethernet Switch can simply be 
mounted at any convenient location up to 100 meters 
(328 feet) from the device.
Due to the inherent voltage drop over copper wire, a 
maximum of 12.9 W is guaranteed to be received by the 
PoE powered device over a cable run length of 328 feet 
(100 meters) per specification.

The figure above shows the Outdoor (right) and Indoor Base Station

2
1

3
4

The figure above shows the LEDs for the Indoor Base Station (TEL-BST11)
Mounting the Base Station 
An indoor base station can be mounted on a wall or ceiling, or placed on a flat surface. Outdoor base stations can be 
mounted on a wall or mast (2.55 in. or 65 mm or larger). The outdoor base stations can be used for indoor areas with 
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The figure above shows the LEDs for the Indoor Base Station (TEL-BST11)

The next table describes the callouts in the previous figure.

LED 1 LED 2 (DECT) LED 3 (OMM) LED 4

UNUSED

Orange: DECT not configured Orange on/off every second: 
connecting to OMM

Red: power on

UNUSED

Green with short off every two 
seconds: DECT inactive (not 
synchronized yet) 

Orange on with a quick off 
every two seconds: OMM 
connecting failure

Orange: booting

UNUSED
Green: DECT ready Green: OMM connected Green: ready

UNUSED

Green with quick flashing of 
orange every two seconds: call 
active on this Radio Fixed Part 

Green with quick flashing of 
orange every 2 seconds: OMM 
running with warning

Green with quick flashing of 
orange every two seconds: 
ready and the Radio Fixed Part 
houses OMM.
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OpenMobility Manager: Before You Begin
The application used to configure a wireless phone system and base station is the OpenMobility Manager (OMM). 
The login details for this application are described in Booting the Base Station. Before you start configuring your 
wireless phone system and base station associated with your Savant PBX system, ensure that you have the following 
files or information available, or procedures completed. Note that the OMM CD is included with the Savant PBX 
(SPX-1000).

• OM_Configurator.jar – Java tool to do the initial boot up, is available on the OMM Activation CD. Copy 
OM_Configurator.jar from the CD to your Savant Development Environment (SDE) machine. 

• PARK – Portable Access Rights key (PARK) is a unique key to configure the base station and add a 
handset, included the OMM Activation CD. Save this key for future reference. You must enter this key 
(without hyphens) during configuration.

• Reserve an IP address for each base station
• You must have already added wireless handsets in Savant Configurator, see the section on the Savant 

Configurator, Adding a Savant Wireless Phone. To summarize, this procedure assumes you have added a 
device, adds a phone, and exports the sip_dect.cfg file.

• TAD – Transaction Data used to generate license file, shown on the OMM Activation CD. Only needed if 
there will be three or more base stations in the system. 

OMM Display of Model Numbers

The OpenMobility Manager (OMM) displays model numbers that are different from the Savant model numbers of the 
base stations.

Savant Model Number OMM displays...

TEL-BST01 RFP L32

TEL-BST02 RFP L34

TEL-BST11 RFP L35

TEL-BST12 RFP L36
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Generating a License for Multiple Base Stations
Perform the following procedure only if there will be three or more (up to 20) base stations in the wireless system. 
Before starting this procedure, the OpenMobility Manager (OMM) Activation CD and MAC addresses of three base 
stations must be available.

1. Open a web browser, and go to http://license.aastra.de

2. Click Generation of License tab (circled in the next screenshot).

3. Click Generate License in the left sidebar. See the next screenshot as circled.
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4. For License Carrier Type, select SIP-DECT. Enter the MAC address for each base stations in the format of 
00-30-42-xx-xx-xx. Then click Check MAC(s). 
NOTE: Only three base stations need to be entered here to generate the license. If your system will contain 

various models—TEL-BST01, TEL-BST02, TEL-BST11, or TEL-BST12 base stations—use at least two 
TEL-BST11, and/or TEL-BST12 base stations here. Once the license file is uploaded, up to 20 base 
stations can be added to the system.

5. The Release field will show up if MAC(s) are verified. Select Release 4.0 for release.
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6. In the TAD-TAN field, enter the TAD that can be found on the OMM Activation CD. Then click Check TAD.

7. In the Park field, enter the Portable Access Rights key (PARK) that can be found on the OMM Activation CD. 
Then click Generate License button at the bottom of the page. These will be displayed in the OpenMobility 
Manager—see Booting the Base Station, step 16.
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8. Click the link: Download Importable File circled in the next screenshot. A file named ommsip.xml should be 
saved in the Downloads folder. Please keep this file with other important information about your installation, in 
case there is a need to reset to the factory default in the future.
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Booting the Base Station
The Savant PBX includes support for the access point base stations: Savant TEL-BST11, or TEL-BST12. The Savant 
documentation refers to these devices as SIP DECT. If a license file was generated in the previous procedure, 
Generating a License for Multiple Base Stations,start with the base stations used to generate the license, and run the 
primary and secondary OpenMobility Manager (OMM) on two of them.

To boot the SIP-DECT, do the following.

1. Run OM_Configurator.jar from your SDE.

2. Click Add parameter (tab), select Country then click Add. Repeat to add DNS addresses, NTP server name 
and 2nd OMM IP address (when there are at least two base stations in the system). The next screenshot shows 
example values. See the next table for help on entering values.
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3. The fields in the Radio Fixed Part (RFP) configuration page should be set as shown in the next table. Fields that 
are not shown in the table do not need to be set or modified.

Field Description
Login Insert check mark 

User Enter omm

Password Enter omm

MAC address Enter MAC address of the base station with format: 
12:34:56:78:ab:cd

Use Local Configuration Insert check mark beside yes

IP address IP address that you have reserved for this device (the base station).

Net mask Enter your network mask

TFTP server address Enter Savant PBX IP address

TFTP file name

Enter Trivial File Transfer Protocol (TFTP) file name:
/SIP-DECT_4_0/iprfp3G.dnld

If you are configuring base station models TEL-BST01 or TEL-
BST02, the following Trivial File Transfer Protocol (TFTP) file name 
name should be used (for more details see the Savant Telephony 
Solution Deployment Guide 009-0406-06):

/omm_ffsip.tftp

Ensure the file path and name is exactly as shown above.

Important! Do not cut and paste this file name. You must type the 
file name in the field.

OMM IP address

IP address of the first base station. If there is only one base station 
or this is the first base station, enter the IP address of the base 
station. This is where the primary OMM will be running. Make sure 
you use the same address in this field for each base station that you 
add later.

Router address Click plus button then enter the gateway IP address of local 
network.

Country Click question button to find out proper country code. United States 
is 100.

DNS addresses

Enter Domain Name Server (DNS) address.
You should be able to find your DNS server address from the router 
of your local network. Use your router’s web user interface which 
should display general router information, including DNS.
You can also choose to use Google Public DNS instead, for 
example:
 8.8.8.8

NTP server name
Enter Network Time Protocol (NTP) server name:
1.aastra.pool.ntp.org

2nd OMM IP address

If there is more than one base station, enter the IP address of a 
base station where the secondary OMM is to run. Ensure that you 
use the same address in this field for each base station that you add 
later.
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4. If you have not done so already and you have more than one network interface, verify your network interface on 
your SDE by using the Terminal utility and the command ifconfig. 

The base station and the Savant Development Environment (SDE) must be on the same network. Typically, the 
first three octets of the broadcast IP address will match those of the base station IP address. See the next two 
screenshots. 

Select the network interface from the drop-down list (circled in red in the next screenshot) that has a broadcast 
IP address with the same first three octets as the base station IP address. Use the next two screenshots to help 
determine the correct network interface.

Note that the IP Address circled in green in the previous screenshot is the base station IP address. Compare this 
to the broadcast IP address circled in the next screenshot taken from Terminal. 

5. Click Send Config, check if status “sending ok” shows on the bottom left.

All LEDs on the base station light up orange then off, wait until the bottom LED is up green and the second from 
bottom LED flashing orange.

6. If there will be more than one base station in the system, repeat steps 3 to 6 to boot up all base stations.

7. Open your web browser and type in the OMM IP address. Note that the OMM runs in active and standby mode 
(if a second OMM IP is configured), and the system will automatically switch to the active OMM. You can not 
open OMM on any other base stations in the system.
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8. With initial installation enter the default user name and password:

User Name: omm
Password:   omm

Leave System blank. The value for PARK is populated by default as 1F100CF0A6. This is a demo license. 
It must be replaced by uploading a license file for a system containing 3 - 20 base stations, or by entering 
the PARK on the OMM CD for a system containing only one or two base stations.

9. Read the end-user license agreement, and click Accept on the end-user license agreement page.
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10. Change the Full Access and root account password, and then for future reference write down the user names 
and passwords. The password must be at least five characters, contain both upper and lower case characters, 
and include a numerical digit. If no user action takes place, the OMM logs out the user after five minutes. See the 
next two screenshots.
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11. The system shows that it is running on a temporary license that is valid for 72 hours.This temporary status will 
change to a permanent license after you enter a Portable Access Rights key (PARK)—for a system that has one 
or two base stations—or upload a valid license file (for a system having 3-20 base stations). If a license is not 
needed, skip steps 14-17, and continue on System settings. 

12. Click Licenses in the left sidebar.
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13. Click the Choose File button to open Finder.

14. Select the license file ommsip.xml that was downloaded when you generated the license. Click Choose, as 
circled in the next screenshot.

15. Click Import, as circled in the next screenshot.
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The system will restart after the license file is uploaded. Note that on the login page, the PARK field now displays 
the PARK values you used to generate the license file in the procedure, Generating a License For Multiple Base 
Stations. 

16. Ensure that all three base stations used to generate the license are added to the system—these were entered in 
the License Carrier Type field, in the procedure Generating a License For Multiple Base Stations. Otherwise, a 
license violation will occur and lead to the system not working properly.
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17. Under System click System Settings in the left pane.

18. The fields on the System Settings page should be set as shown in the next table. Fields that are not shown in 
the table do not need to be set or modified.

Field Description

System name Enter a name for the DECT system. It will be displayed on the handsets after 
handsets have subscribed to the system successfully. 

Remote access Insert a check mark in the box.

PARK

Either of the following two scenarios will apply: 

 Enter the Portable Access Rights key (PARK) included with the OMM 
package (on the CD) if installing only one or two base stations. 

 If you uploaded a valid license for 3-20 base stations, the OMM user 
interface will display the PARK you used to generate the license.

Encryption Insert a check mark the box.

Regulatory Select the required value from the drop-down list.
Downloading new firmware
to portable parts (Active) Insert a check mark the box.

Voice mail number Enter the Voicemail Extension number. Refer to the procedure, Adding Voice mail to 
Savant PBX. Leave it blank if there is no voicemail in Savant PBX.

Active (under Syslog) Insert a check mark in the box.

IP address Enter Savant PBX IP address.

Port number Click the Default button, which adds 514.

Regulatory domain Select the required value from the drop-down list.
Time zone Select one. 

All available time zones are listed in alphabetical order. For users in the US, use 
Eastern, Central, Mountain, Pacific or Hawaii depending on the place of installation.

19. Click OK. The system may restart.
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20. Log in with the Full Access user name and password after system starts up. See step 11 in the Booting the 
Base Station procedure. 

21. Click System (circled in the next screenshot) in the left pane to expand the options.

22. Click SIP to open the SIP page.

23. The fields in the SIP settings page should be set as shown in the next table. Fields that are not shown in the 
table do not need to be set or modified.

Field Description
Proxy server Enter Savant PBX IP address

Proxy port 5060

Registrar server Enter Savant PBX IP address 

Registrar 5060

Dial terminator Clear this field and leave blank

24. Click OK. The system will restart.

25. Log in after system starts up. 

Next add a base station. See the next procedure, Adding a Base Station.
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Adding a Base Station
This procedure is used for adding a single base station or adding multiple base stations. Repeat this procedure for 
each base station. When adding multiple base stations, it is assumed the procedure, Generating a License for 
Multiple Base Stations, has been performed.

Whether a license is required (three to 20 base stations in the system) or not, this procedure is the same. All booted 
base stations are displayed here so they can be added to the system. However, if a license was uploaded to the 
system, all three base stations—based on their MAC addresses that were used to generate a license—will be 
displayed, even if they are not booted yet.

To add a base station, do the following in OpenMobility Manager.

1. Click Radio fixed parts in the left pane.

2. Click the Start button and wait for 10 seconds. All booted base stations should display on this page. If there is 
base station still missing, double check if that station is booted up with the correct OMM IP.

3. Select one base station. If a license file was uploaded, start with a base station that is used to generate the 
license file. Click the edit icon in front of the selected base station (shown by the red arrow in the previous 
screenshot), the Configure radio fixed part page opens. See the next screenshot.
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4. The fields in the Configure radio fixed part page should be set as shown in the next table. Fields that are not 
shown in the table do not need to be set or modified.

Field Description
MAC	
  address Enter	
  MAC	
  address	
  of	
  the	
  base	
  sta;on.

Name Enter	
  a	
  name,	
  for	
  example,	
  House	
  (Inside).

DECT	
  sebngs Insert	
  a	
  check	
  mark	
  in	
  the	
  box.

DECT	
  cluster Enter:	
  1

Preferred	
  synchroniza;on	
  source Insert	
  a	
  check	
  in	
  the	
  box	
  if	
  this	
  is	
  the	
  base	
  sta;on	
  you	
  want	
  to	
  use	
  as	
  the	
  
synchroniza;on	
  source.	
  For	
  a	
  system	
  that	
  has	
  mul;ple	
  base	
  sta;ons,	
  the	
  
synchroniza;on	
  source	
  should	
  be	
  the	
  one	
  in	
  the	
  middle.	
  

5. Click OK. After a few seconds, the base station should show as active with a green check mark.
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6. Repeat steps 3-5 to add all base stations to the system.

Now you can add handsets. See the next procedure, Adding Handsets to the Base Station.
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Adding Handsets to the Base Station
To add wireless handsets to the base station, do the following in OpenMobility Manager.

1. Click Portable parts.

2. Click Import.

3. Click Choose File, there should be a pop up directory to allow you choose file.

4. Find sip_dect.cfg, click Choose. The file name displays on the page. See the next screenshot.

NOTE: The file, sip_dect.cfg, is the one that you saved when adding a Savant wireless phone using the 
Savant Configurator.
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5. Click Import. Available handsets will be displayed. If the import fails, click the Log file button to get detailed 
information. You may need to go back to the procedure, Adding Savant Wireless Phone, and generate 
sip_dect.cfg file again.

6. Insert a check mark in each box beside the names of the required handsets. Insert a check mark beside Name to 
select all handsets.

7. Click Add.
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8. Confirm the handsets have been added (indicated by the green check marks).

9. Click Portable parts in left pane.

Handsets are shown as not subscribed to the base station. See the next screenshot.

Next, subscribe wireless handsets to a base station. See the next procedure.
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Subscribing Handsets to the Base Station 
To subscribe handsets to the base station, do the following in OpenMobility Manager. 

1. Ensure subscription is allowed and the handset is added to the system by checking the OMM Portable parts 
page. If subscription is allowed, you will see a green check mark for Subscription allowed. If added, you will 
see the handset’s IPEI displayed. If subscription is not allowed, click the Start button under Subscription with 
configured IPEI to enable subscription.”

2. From a handset, press right softkey to Menu screen.

3. Use ∇∆ to select System.

4. Press left softkey for ok to the System menu.

5. Use ∇∆ to select Subscriptions.

6. Press left softkey for ok to the Subscriptions menu.

7. Select New system. Press ok.

8. Leave Auth. Code blank.

9. Press left softkey for Next to the New system menu.

10.  Select Enter PARK, press left softkey for ok.

11. Enter the numeric PARK number shown on the Portable parts page, circled in the next screenshot.

12. Press left softkey for Next.

Screen displays please wait. After the subscription process is done, the screen will show handset’s extension 
number, the system name and time. It is now ready to make and receive calls. 

13. Confirm that the handset is subscribed by viewing the Status section in the Portable parts page. If subscribed, 
you will see a green check mark for Subscribed. Repeat to subscribe all handsets.
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Integrating TEL-BST11/TEL-BST12  with TEL-BST01/TEL-BST02
If the Savant PBX system includes more than one base station, when a handset detects that another base station has 
a better signal strength, the handset starts the handover process, so that it will have better voice quality and extended 
coverage area.

Before You Begin
This procedure is only applicable if you are adding a TEL-BST11 or TEL-BST12 to a Savant PBX system already 
running with a TEL-BST01 or TEL-BST02.

1. In the left pane of OpenMobility Manager, click Radio fixed parts.

2. Under HW type, check the base station that OMM is running on—information is displayed in Bold.

If the base station running OpenMobility Manager (OMM) in the current system is a TEL-BST11 or TEL-BST12 follow 
the steps in the procedure Booting the Base Station and Adding a Base Station. Note if the current system does not 
have a license and the number of base stations is three or more (up to twenty) after expansion, a license is needed. 
Refer to the procedure, Generating License for Multiple Base Stations, to download a license file before adding a new 
base station to the system.

If the base station type in the current Savant PBX system is a TEL-BST01 or TEL-BST02, follow this procedure to 
add the TEL-BST11 or TEL-BST12 base station(s) to the existing system. For example, an existing system has two 
TEL-BST01 or TEL-BST02 base stations— running redundant OMM—with IP addresses: 10.5.225.66 and 
10.5.225.68. Two TEL-BST11 or TEL-BST12 base stations will be added to the system, using IP addresses: 
10.5.225.86 and 10.5.225.88.

If the current system does not have a license and the number of base stations is three or more (up to twenty) after 
expansion, a license is needed. Refer to the section Generating License for Multiple Base Stations to download a 
license file. 

NOTE: For more details on the way the OMM displays the base station model numbers, click here. 

To add a TEL-BST11 or TEL-BST12 base station to a running system, do the following.

1. Open a web browser and log in to OMM.

2. To back up the current configuration, click System > DB management from the left pane. 

3. Under Manual export, for Protocol select FILE. Leave the other fields blank. 

The file name is pre-defined as date_system name_PARK_omm_conf.gz and not changeable. The next 
screenshot shows an example filename, 120914_Building45_1F1023199B_omm_conf.gz. 
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4. Click Save. This will download the system configuration to the Downloads folder under your user folder on your 
Savant Development Environment (SDE).

5. Perform the procedure, Booting the Base Station to boot up TEL-BST11 or TEL-BST12 base station(s). 

Important! In a system running both TEL-BST01 or TEL-BST02, and TEL-BST11 or TEL-BST12 base stations, OMM 
must run on a TEL-BST11 or TEL-BST12 base station. If the system has a secondary OMM, OMM also 
must run on a TEL-BST11 or TEL-BST12 base station. As an example, the OMM IP address is set to 
10.5.225.86 and 2nd OMM IP address is set to 10.5.225.88. 

6. After booting up the new base stations, log in to a new OMM (the next screenshot shows 10.5.225.86 as an 
example) using omm/omm as the user name/password. Accept the end user license agreement. When you are 
asked to change Full Access and root user name and password, use the same as in the old OMM. Upload the 
license file, if needed. Keep the OpenMobility Configurator open for later use.
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7. Load the configuration from the old OMM. Click System > DB management from the left.

8. Under Manual import, select FILE for Protocol field, leave other fields empty then click Choose File. This will 
open a Finder window.

9. Select the file downloaded in step 3, click Choose.
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10. The file name selected displays (as circled in the next screenshot) on the Database management page.

11. Ensure that the pop-up window is not blocked. If using the Safari web browser, go to Safari > Preference > 
Security. Uncheck the box for Block pop-up windows. 

12. Click Load. Click OK on the pop up window. This will restart OMM. After log in, you may be asked to accept end 
user license and change Full Access and root user name/password again. Use the same user name and 
password as in step 6.
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13. Click Radio fixed parts from the left. Click Start so that there is a green check mark for Capture allowed.

14. The TEL-BST01 or TEL-BST02 base stations in the original system should show up as not connected. The new 
TEL-BST11 or TEL-BST12 base stations booted in step 6 should show up as inactive.

15. Add new base stations to the system. Click the edit icon for each inactive TEL-BST11 or TEL-BST12 base 
station, configure following fields then click OK.

Field Description
MAC address Enter MAC address of the base station.

Name Enter a name, for example, House (Inside).

DECT settings Insert a check mark in the box.

DECT cluster Enter: 1

Preferred synchronization 
source

Insert a check in the box if this is the base station you want to use as the 
synchronization source. For a system that has multiple base stations, the 
synchronization source should be the one in the middle. 

16. Wait a moment so that all newly added TEL-BST11 or TEL-BST12 base stations become connected and active. 
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17. Confirm that all newly added TEL-BST11 or TEL-BST12 base stations are display as connected and active.

18. Move the base stations controlled by the old OMM to the new OMM. Go to the OpenMobility Configurator used in 
step 6. 

19. For the MAC address field, enter the MAC address of one TEL-BST01 or TEL-BST02 base station. 

20. In the User and Password fields, enter full access user name and password. Make sure the Login box is 
checked. Keep all other fields the same as in step 6 when you booted up TEL-BST11 or TEL-BST12 base 
stations, except the following:

Field Description
IP	
  address IP	
  address	
  assigned	
  to	
  base	
  sta;on

TFTP	
  file	
  name /SIP-­‐DECT_3_0/iprfp2G.ftp

21. Click Send config.
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22. Once the base station is booted up, it should show connected and active under the Radio fixed parts in OMM.

23. Repeat steps 17-21 to reconfigure all TEL-BST01 or TEL-BST02 base stations.
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24. If voice mail is configured in the Savant PBX system, click Systems > System settings.

Enter	
  the	
  voice	
  mail	
  extension	
  number	
  used	
  in	
  Savant	
  Phone	
  Configurator	
  in	
  the	
  Voice	
  mail	
  number	
  field.	
  

25. Click	
  OK.
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6. SAVANT PUBLIC ANNOUNCEMENT SYSTEM
This section describes the Savant Public Announcement (and paging) system (PAS-1000).

PAS-1000 Hardware
The Savant Public Announcement device requires the following cables for a proper installation: Power cable (sold 
separately), Ethernet cable and a 1/8 inch audio jack to RCA cable as is shown in the next image.

The audio control system PAS-1000 augments an existing SIP PBX as another communications component. An 
announcement, using the PAS-1000, is produced by initiating a call from a telephone or iOS Device. The PAS-1000 
unites the functions of a telephone with a high-performance digital amplifier for broadcasting announcements. The 
PAS-1000 is used to add Whole House Page All functionality to the Savant PBX system. When a call is connected, 
the PAS-1000 output can be redirected back to the master controller on an RCA Stereo Input, which can then output 
to all the zones in the house.
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PAS-1000 Ports and Connectors 

The callouts in the next image of one of the panels of the PAS-1000 relate to the descriptions provided in the next 
table.

1 32 4 5 6 7 8

The next table associates the callouts in the previous figure with the functionality of the PAS-1000. 

Number Function Description

1 IP/Reset
Key for announcement of IP address (press once)
Resets IP address (press and hold)

2 Power Red LED indicates power is on

3 Call Green LED indicates call is connected

4 5V DC Optional port for 5V DC power

5 Port 2 RJ-45 port; 10/100 Mbps Base-T, auto-negotiating port 

6 Port 1 POE IEEE 802.3af Power Over Ethernet (PoE)

7 EXT Not applicable

8 I/O 1 Not applicable

The callouts in the next image of one of the panels of the PAS-1000 relate to the descriptions provided in the next 
table.

1 32 4 5 6

The next table associates the callouts in the previous figure with the functionality of the PAS-1000. 

Number Function Description
1 VDD Not applicable

2 I/O 2 Not applicable

3 KBD Not applicable

4 Speaker Connects to a speaker—four-watt amplifier (8 ohm) is built-in

5 Mic-In Used to connect headphone

6 Line Out Used to connect to Savant controller using headphone to RCA adapter cable
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The next diagram shows an overview of the components supported with the Savant PBX system.

Configuration of the PAS-1000
To configure the PAS-1000, ensure the following procedures have been completed:

1. Configure the PAS-1000 in RacePoint Blueprint™. See Adding the Savant PA System.

2. Configure the PAS-1000 in the Savant Configurator as a device to the Savant PBX. For details, see Adding a 
Savant PA System.

3. Upload the configuration file to the PAS-1000. For details, see Uploading Configuration File to the Savant PA 
System.
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7. THIRD-PARTY DOOR ENTRY SYSTEMS INTEGRATION
This section describes the third-party door entry systems that can be integrated as endpoints into a Savant PBX 
system. The Savant PBX treats the door unit as an IP phone, thus if your door entry system is an analog one, a 
conversion is needed to successfully integrate it with the Savant PBX.

The Savant PBX supports the following door entry systems:
• Three Analog Door Entry Systems:

Holovision 404 with Viking Dialer
The Holovision 404 intercom system with Viking E-XX functions as a two way call speaker phone. 
Savant recommends using the Viking E-30 or Viking E-40.
Siedle 
This system is set up with an Integrated Access Device (TEL-IAD1 or TEL-IAD2), and includes a 
loud speaker, color camera, SIP interface, and PBX interface.
DoorKing 1812 Access Plus
The DoorKing 1812 requires an Integrated Access Device (TEL-IAD1 or TEL-IAD2) and can 
connect to your home network, program the system, and receive reports via the internet.

• Two VoIP Door Entry Systems: 
Holovision with Cyberdata
The Holovision with Cyberdata SIP Intercom is already an integrated IP phone. You must configure 
the unit to register to the Savant PBX and dial the number that is associated with the Ring Group. 
The following Holovision models are supported by the Savant PBX:

All	
  400	
  Series
Model	
  513
All	
  600	
  Series

All	
  700	
  Series
All	
  800	
  Series
All	
  900	
  Series

Mobotix T24
The Mobotix T24 is a fully operational SIP phone with an IP camera included.

Procedures For Each Door Entry System
Use the following procedures (in the sequence shown) to set up an analog door entry system:
Holovision 404 with Viking Dialer

• Setting Up an Analog Door Entry System
• Adding the Holovision/Viking Dialer in Savant Configurator

Siedle
• Configuring a Siedle Unit using RacePoint Blueprint
• Configuring a Siedle Unit using Savant Configurator
• Setting Up a User for a Siedle Door Entry System

DoorKing
• Configuring a DoorKing Unit using RacePoint Blueprint
• Integrating a DoorKing 1812 with a Savant PBX

Use the following procedures (in the sequence shown) to set up the VoIP door entry systems:
Holovision 404 with Cyberdata Module

• Configuring Holovision with Cyberdata SIP Intercom Using Savant Configurator
• Configuring Holovision Cyberdata VoIP Intercom

VIO by Holovision VoIP Intercom
• Configuring VIO by Holovision VoIP Intercom

Mobotix T24
• Adding the Mobotix T24 Using RacePoint Blueprint 
• Adding a Mobotix T24 Using Savant Configurator
• Configuring VoIP Settings for Mobotix T24 Intercom
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Setting up an Analog Door Entry System
To operate an analog door entry system—Holovision 404 and Viking intercom module—within a Savant PBX, other 
hardware components are required, as specified in the next table.
NOTE: It is assumed that a Savant PBX and at least one iPad® are already configured and working properly with the 

Savant PBX, before adding the door entry system. 

Hardware Recommended 
Model

Description

Door Intercom Unit Model 100 for 
Savant Systems

Order Model 100-VIK, plus the SIP adaptor and dialer

SIP Adapter Cisco SPA112
(TEL-IAD2)

This is an analog telephone adapter (also referred to as an 
integrated access device) that connects a Viking dialer, such 
as an E-10, E30, or E-40 to an IP network, enabling SIP-
supported VoIP communication. For more information on 
Cisco SPA112, see:
http://www.cisco.com/en/US/products/ps11977/index.html

Dialer Viking Programable 
Tone Dialer Model: 
K-1900-5

This generates a call to contact the Savant PBX server by 
dialing a preprogramed number. This number will trigger the 
PBX server to ring one or more iOS devices in the house or 
facility.

Analog phone Any available analog 
phone

Needed to set up the dialer and helps with debugging.

To set up the door entry system, the analog RJ-11 cable from the Holovision 404 unit must be plugged into the Viking 
dialer phone port. The cable from the dialer must be plugged to the Integrated Access Device (TEL-IAD1 or 
TEL-IAD2) Phone 1 Port (Phone 2 will be disabled). See the next figure showing the cable connections.

Connections to Analog Door Entry System Holovision 404
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Viking Programable Dialer
Perform the following steps to set the “hot” number that will be used when the user presses the intercom button in the 
Holovision unit.

Currently the Savant PBX has a preassigned number or extension of 7000 for this purpose. Therefore, assign 7000# 
—# signals end of digits to the Integrated Access Device (TEL-IAD1 or TEL-IAD2) to the Viking Dialer.
1. Call the phone connected to the Dialer

2. Answer phone. Enter *& and security code (Factory set to 845464) 

3. Write your security code for future references.

4. Enter 7000*##00

For additional programming see www.vikingelectronics.com/products/view_product.php?pid=160.

Using Bonjour to Add Integrated Access Device to Network 
The Integrated Access Device advertises itself via Bonjour®. 

1. Connect the power adapter and Ethernet cable to the TEL-IAD2.

2. Open Safari and click Bonjour. If Bonjour is not included on your Bookmarks Bar, see the procedure for adding it  
by clicking here (see page 56). 

3. Select SPA112 from the list of devices that Bonjour has detected. 

Reset Procedure for Integrated Access Device: TEL-IAD2 

It can be helpful to reset your integrated access device to its factory default settings.
If you are using a used device, then resetting your device to factory default settings is highly recommended. 

NOTE: The integrated access device is labelled as Cisco SPA112. In the Savant product line this device is referred to 
as an Integrated Access Device (TEL-IAD2). The Savant Configurator configures this device as an ATA 
Adapter. The user web interface refers to the Cisco SPA112.

To reset your TEL-IAD2, do the following. 

1. Using a telephone cable, connect a telephone to the PHONE 1 port of the device.

2. Power up your device unit using its power adapter.

3. Unplug the Ethernet cable from the device.

4. Dial ****, and wait for the Interactive Voice Menu (IVM) to get activated. 

5. After hearing IVM message, type in the following number with the # symbol: 73738#

This number spells RESET.

6. Confirm the reset by pressing 1.
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Registering Integrated Access Device to Savant PBX: TEL-IAD2 
If you believe the settings of your TEL-IAD2 will interfere with the setup of your door entry system, reset the device to 
the factory defaults before continuing.

To reset your TEL-IAD2 back to its factory default settings, see the Reset Procedure for Integrated Access Device: 
TEL-IAD2.

To register to the Savant PBX the TEL-IAD2 will be assigned the extension number 2031 and the Savant PBX will be 
assigned the IP Address as the Registrar Server.

To set the device so that it can be properly registered to the Savant PBX, do the following.

1. Determine the IP address of your device. To do this, use your phone handset attached to the Line 1 jack and 
dial:**** (four asterisks)
then dial:  110 #

The interactive voice system will state the IP address of your device (for example, 192.168.0.100).

2. Write down the IP address.

3. Open your web browser and enter the IP address of your device: 

http://<IP ADDRESS>/
(where <IP ADDRESS> is replaced by the address of your device.

The web user interface to your device opens.

4. Log in using the following:

Username:  admin

Password:  admin 
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5. Click Quick Setup to configure Line 1.

6. Use the next table to enter or select values for the specified fields on the Quick Setup for Line 1 shown in the 
previous screenshot.

Field Description
Proxy The IP address of the Savant PBX in the example screenshot is 10.5.214.3

Display Name Enter a meaningful name. This will be displayed on the iPads when a call is sent from the door 
entry system.

User ID Enter the Device Number used when the ATA device (Integrated Access Device—TEL-IAD2) was 
added in Savant Configurator.

Password Leave this blank.

Dial Plan Replace *xx with 7000S0 | *xx 
7000 is the extension associated with a RingAll call group defined in Savant Configurator.
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7. Click Submit. You will see the following screen. Wait until the device is back.

8. Check that the device is registered with the PBX.
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9. Click the Voice tab.
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10. Click SIP.

11. Scroll down to SDP Payload Types and delete the value—default is 100—for the NSE Dynamic Payload field. 
See the next screenshot (partial view).

12. Click Submit.
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13. Wait for the device to reset.

If you require another port to be configured for a second door entry station, click the Quick Setup tab and 
proceed to configure Line 2 to access the options of that line. Repeat Step 6. Ensure that the UserID is unique.

Inhibit Reorder/BusyTones: TEL-IAD2
If you need to inhibit Reorder/Busy tones (usually needed when using Holovision along with Viking Intercom units), do 
the following.

1. Click the Voice tab in the web user interface used in the previous procedure.

2. Click Regional.

3. In the Call Progress Tones section, find the Reorder Tone (as shown circled in the next screenshot).
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4. Modify the Reorder Tone string as follows:
480@-19,620@-19;0(.25/.25/1+2)

5. In the Call Progress Tone section, modify the Off Hook Warning tone string as follows:

480@-10,620@0;0(.125/.125/1+2)

6. Scroll down to the Control Timer Values section:

7. Change the Reorder Delay value to 0.

8. Click Submit. The line will detect “silence” this is enough for some device to go on-hook.

9. It may be necessary to add a device which will send a Calling Party Control (CPC) disconnect signal over an 
analog phone line. If this is the case, Savant Systems recommends installing a Viking CPC unit. This unit will 
disconnect the analog line upon detection of reorder tone and or silence. After setting up the proper wiring 
connections between the door entry unit, the Viking dialer and the integrated access device (TEL-IAD2), pressing 
the intercom button will start a call and the iPads will ring. The first person to answer the call will be connected to 
the door entry unit allowing a full duplex conversation. The other iPads will be disconnected.
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Reset Procedure Integrated Access Device: TEL-IAD1 

It can be helpful to reset your Integrated Access Device (TEL-IAD1) to factory default settings. If you are using a used 
TEL-IAD1, then resetting your adapter to factory default settings is highly recommended. 

NOTE: This integrated access device is labelled as Linksys PAP2T. In the Savant product line this device is referred 
to as an Integrated Access Device (TEL-IAD1). The Savant Configurator configures this device as an ATA 
Adapter. The user web interface refers to the Linksys PAP2T.

To reset your TEL-IAD1, do the following.

1. Using a telephone cable, connect a telephone to the PHONE 1 port of the TEL-IAD1.

2. Power up your TEL-IAD1 unit using its power adapter.

3. Unplug the Ethernet cable from the TEL-IAD1.

4. Dial ****, and wait for the Interactive Voice Menu (IVM) to get activated. 

5. After hearing IVM message, type in the following number with the # symbol: 73738#

This number spells RESET.

6. Confirm the reset by pressing 1.
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Registering Integrated Access Device to Savant PBX: TEL-IAD1 
If you believe the settings of your TEL-IAD1 will interfere with the setup of your door entry system, please reset the 
device to the factory defaults before continuing.

To reset your TEL-IAD1 unit back to its factory default settings, see the Reset Procedure Integrated Access Device: 
TEL-IAD1

To register to the Savant PBX the TEL-IAD1 will be assigned the extension number 2031 and the Savant PBX will be 
assigned the IP Address as the Registrar Server.

To set theTEL-IAD1 (also referred to as Linksys PAP2T) so that it can be properly registered to the Savant PBX, do 
the following.

1. Determine the IP address of your TEL-IAD1. To do this, use your phone handset attached to the Line 1 jack and 
dial:**** (four asterisks)
then dial:  110 #

The interactive voice system will state the IP address of your device (for example, 192.168.0.100).

2. Write down the IP address.

3. Open your web browser and enter the IP address: 

http://<IP ADDRESS>/
(where <IP ADDRESS> is replaced by the address that was provided in Step 1.

The user interface to your TEL-IAD1 opens. See the next screenshot.
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4. Click System (circled in the previous screenshot). 

5. Ensure that DHCP is set to yes. See the next screenshot.

6. Save the settings. Repeat step 1-3 with the new IP address.

7. Click Admin Login (circled in the previous screenshot).

8. After you click Admin Login a view of the available lines displays. See circled area of next screenshot
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9. Click Line 1 to access the options of that line. See the next screenshot.

10. Use the next table to enter or select values for the specified fields on the Basic View page shown in the previous 
screenshot.

Field Description
Line Enable Set to yes.

SIP Port Use 5060.

Proxy The IP address of the Savant PBX in the example screenshot is 10.5.200.169

Display Name Enter a meaningful name. This will be displayed on the iPads when a call is sent from the door 
entry system.

User ID Enter the Device Number used when the TEL-IAD1 device was added in Savant Configurator.

Password Leave this blank.

Auth ID Enter the device number used when the TEL-IAD1 device was added in Savant Configurator.

Use Auth ID Set to no.

11. Click Save Settings.

12. Click switch to advance view, as circled below.
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13. Click SIP tab.

14. Scroll down to SDP Payload Types and delete the value—default is 100—for the NSE Dynamic Payload field. 
See the next screenshot (partial view).

15. Click Save Settings.

16. If you require another port to be configured for a second door entry station, click Line 2 to access the options of 
that line. See the next screenshot. If you do not require a second port, skip this step and Step 17-18, and 
continue with Step 19.
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17. Use the next table to enter or select values for the specified fields on the Basic View page for Line 2.

Field Description

Line Enable Set to yes.

SIP Port Use 5061.

Proxy Use the same IP address of the Savant PBX that you entered for Line 1.

Display Name Enter a meaningful name. This will be displayed on the iPads when a call is sent from the 
door entry system.

User ID Enter the Device Number used when the TEL-IAD1 was added in Savant Configurator.

Password Leave this blank.

Auth ID Enter the device number used when the TEL-IAD1 was added in Savant Configurator.

Use Auth ID Set to no.

18. Click Save Settings.

Inhibit Reorder/BusyTones: TEL-IAD1

If you are integrating Siedle door units with your Savant PBX system, please skip this section.

The TEL-IAD1 does not go “on hook” immediately after the SIP side has been torn down. Instead, the device sends a 
reorder tone and an “Off Hook Warning” tone on the analog line after the SIP side has disconnected.

If you need to inhibit Reorder/Busy tones (usually needed when using Holovision along with Viking Intercom units), do 
the following.

1. To inhibit the tones, in the Advanced View click the Regional tab.
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2. In the Call Progress Tones section, find the Reorder Tone (as shown circled in the next screenshot).

3. Modify the Reorder Tone string as follows:
480@-19,620@-19;0(.25/.25/1+2)

4. In the Call Progress Tone section, modify the Off Hook Warning tone string as follows:

480@-10,620@0;0(.125/.125/1+2)

5. Scroll down to the Control Timer Values section:

6. Change the Reorder Delay value to 0.

7. Save the settings. The line will detect “silence” this is enough for some device to go on-hook.

It may be necessary to add a device which will send a Calling Party Control (CPC) disconnect signal over an 
analog phone line. If this is the case, Savant Systems recommends installing a Viking CPC unit. This unit will 
disconnect the analog line upon detection of reorder tone and or silence. After setting up the proper wiring 
connections between the door entry unit, the Viking dialer and the TEL-IAD2, pressing the intercom button will 
start a call and the iPads will ring. The first person to answer the call will be connected to the door entry unit 
allowing a full duplex conversation. The other iPads will be disconnected.
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Adding Holovision 404 in Savant Configurator
To add the Holovision 404 (with a Viking intercom module) as an endpoint to the Savant PBX using Savant 
Configurator, do the following.

1. Select the Devices tab and click Add Device to open the Add Device page.

2. Use the next table to enter or select values for the fields on the Add Device page.
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Field Description

Server Leave as is. 

Type Select this option: ATA Device.

Device Number Enter a four-digit number (in the range 2000-2500) for this device. 
The previous screenshot uses 2031 as an example. 

Assign to Provides a drop-down list of all users that the device can be assigned to. It can also be 
unassigned. Savant Systems recommends this field be Unassigned. 

Friendly Name Name that displays when a call is made from this device. 
The previous screenshot uses Holovision E10 as an example. 

UID The Savant user identifier is automatically populated by the Device Number. 

Context Default is Phone (all_calls). Use the default value.

Usable as Trunk Do not insert a check mark.

Use TCP Do not insert a check mark.

Secret Leave it blank.

Call Limit Enter 2.

Host Use the default: dynamic.

Port Use the default value: 5060.

NAT Network Address Translation (NAT) helps determine whether this device is on the internal 
network or outside the firewall. You must insert a check mark in the check box.

Register? Do not insert a check mark.

Qualify Insert a check mark.

3. Confirm that the device has been added correctly.

4. Click Call Groups and then click Add Group to open the Add Call Group page.

5. Use the next table to enter or select values for the fields on the Add Call Group page.

Field Description

Z*5/ Z*5/.8M.:<8;>\.

]*6L."[-/,=68, #/*+/.*=.6=\

!1>/ )/L/O-.H6,:$3LL\

H6,:$3LL.!65/ ",-/<.-?/.L/,:-?.8M.N5/.-?*-.18;.0*,-.-?/.4/+6O/=.-8.<6,:\.
H/O855/,4/4.R'.=/O8,4=\

  Confidential and Proprietary                                                                         158 of  246Savant Telephony Solution Deployment Guide
PBX Release 5.1.1
009-0406-07

4. Click Call Groups and then click Add Group to open the Add Call Group page.

4. Click Call Groups and then click Add Group to open the Add Call Group page.

5. Use the next table to enter or select values for the fields on the Add Call Group page.

Field Description

Z*5/ Z*5/.8M.:<8;>\.

]*6L."[-/,=68, #/*+/.*=.6=\

!1>/ )/L/O-.H6,:$3LL\

H6,:$3LL.!65/ ",-/<.-?/.L/,:-?.8M.N5/.-?*-.18;.0*,-.-?/.4/+6O/=.-8.<6,:\.
H/O855/,4/4.R'.=/O8,4=\
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5. Use the next table to enter or select values for the fields on the Add Call Group page.

Field Description

Name Name	
  of	
  group.	
  

Fail	
  Extension Leave	
  as	
  is.

Type Select	
  Ring-­‐All.

Ring-­‐All	
  Time Enter	
  the	
  length	
  of	
  ;me	
  that	
  you	
  want	
  the	
  devices	
  to	
  ring.	
  
Recommended	
  30	
  seconds.

6. Click Save.

7. Click View Groups from the side bar on the left.

8. Select the group you just created. 

6. Click Save.

7. Click View Groups from the side bar on the left.

8. Select the group you just created. 

9. Click Edit Members.

10. Select all the endpoints from the Available Devices—that you want to include in the Ring-All group—and use 
the arrow button to move the device to the Group Members area.

11. Click Save.
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9. Click Edit Members.

6. Click Save.

7. Click View Groups from the side bar on the left.

8. Select the group you just created. 

9. Click Edit Members.

10. Select all the endpoints from the Available Devices—that you want to include in the Ring-All group—and use 
the arrow button to move the device to the Group Members area.

11. Click Save.
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10. Select all the endpoints from the Available Devices—that you want to include in the Ring-All group—and use 
the arrow button to move the device to the Group Members area.

11. Click Save.
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Configuring a Siedle Unit using RacePoint Blueprint
To add the Siedle door entry system to the Savant PBX configuration using RacePoint Blueprint, do the following.

1. From the Library window, type door and select Generic Door Entry System. See the next screenshot.

2. Drag the component to main window and select the zone. Savant Systems recommends the global zone.

3. Click Choose.

4. From the Show drop-down list select Telephony. See the next screenshot.
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5. Select Registration Enabled.
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6. Enter the following:
• PBX IP address
• Username—this must match the Device Number you enter in the Savant Configurator.
• Password—leave this field empty.

7. For Video Support, select Enabled.

If there is no Video Support present in the unit, ensure that Enabled is unchecked.
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8. If the door entry station has an IP camera, enter the URL. For Siedle units the URL is the following (as shown 
circled in the next screenshot):

http://root:root@10.5.203.47/mjpg/video.mjpg
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9. Next generate services, save and upload the configuration.
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Configuring a Siedle Unit using Savant Configurator
Because the Siedle door entry system is analog and the Savant system is IP, the signaling must be converted from 
analog to IP and vice-versa by using an Integrated Access Device, also referred to as Analog Telephone Adapter 
(ATA). Before you begin configuring the Siedle unit in Savant Configurator, you must configure the ATA—see the 
procedure, Registering Integrated Access Device to Savant PBX: TEL-IAD2. Ensure that the registration credentials 
of the ATA match the ones you use when you add the ATA in Savant Configurator.
After the ATA is successfully registered and the Siedle door entry system is programed to dial the proper extension, 
the door entry system is ready.
The hardware parts included with the Siedle door system are as follows:

 BTLM650-04 LoudSpeaker  DCA650-02 DoorCom PBX Interface

 BTM650-01 Call Button Module  DCA-SIP IP Interface

 CMC612-1 Color Camera Module  IM7001 Video Encoder

 BNG650-1 Power supply  VNG602-1 Power Supply

To add the Siedle unit as an endpoint within a Savant PBX system using Savant Configurator, do the following.

1. Select the Devices tab and click Add Device to open the Add Device page. 
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2. Use the next table to enter or select values for the fields on the Add Device page.

Field Description
Server Leave as is. 

Type Select this option: ATA Device.

Device Number Enter a four-digit number (in the range 2000-2500) for this device.

Assign to Provides a drop-down list of all users that the device can be assigned to. It can 
also be unassigned. Savant Systems recommends this field be unassigned. 

Friendly Name Name that displays when a call is made from this device. 

UID The Savant user identifier is automatically populated by the Device Number.

Context Default is Phone (all_calls). Use the default value.

Usable as Trunk Do not insert a check mark.

Use TCP Do not insert a check mark.

Secret Leave it blank.

Call Limit Enter 2.

Host Use the default: dynamic.

Port Use the default value: 5060.

NAT Network Address Translation (NAT) helps determine whether this device is on the 
internal network or outside the firewall. You must insert a check mark in the 
check box.

Register? Do not insert a check mark.

Qualify Insert a check mark.

3. Click Add & Exit.

4. Click the Devices tab to ensure the new device appears in the list.

5. Click the Call Groups tab.

6. Click Add Group to open the Add Call Group page.

Field Description

)/<+/< #/*+/.*=.6=\.

!1>/ )/L/O-.-?6=.8>N8,_.HIH)/$0#1$\

X/+6O/.Z;5K/< ",-/<.*.M8;<$46:6-.,;5K/<.C6,.-?/.<*,:/.@'''$@a''E.M8<.-?6=.4/+6O/\

3==6:,.-8 A<8+64/=.*.4<8>$480,.L6=-.8M.*LL.;=/<=.-?*-.-?/.4/+6O/.O*,.K/.*==6:,/4.-8\.W-.O*,.
*L=8.K/.;,*==6:,/4\.)*+*,-.)1=-/5=.</O855/,4=.-?6=.9/L4.K/.;,*==6:,/4\.

]<6/,4L1.Z*5/ Z*5/.-?*-.46=>L*1=.0?/,.*.O*LL.6=.5*4/.M<85.-?6=.4/+6O/\.
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3. Click Add & Exit.

4. Click the Devices tab to ensure the new device appears in the list.

5. Click the Call Groups and then click Add Group to open the Add Call Group page.

6. Use the next table to enter or select values for the fields on the Add Call Group page.

Field Description

Z*5/ Z*5/.8M.:<8;>\.

]*6L."[-/,=68, #/*+/.*=.6=\

!1>/ )/L/O-.H6,:$3LL\

H6,:$3LL.!65/ ",-/<.-?/.L/,:-?.8M.N5/.-?*-.18;.0*,-.-?/.4/+6O/=.-8.<6,:\.
H/O855/,4/4_.R'.=/O8,4=\

7. Click Save.
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7. Use the next table to enter or select values for the fields on the Add Call Group page.

Field Description

Name Name	
  of	
  group.	
  

Fail	
  Extension Leave	
  as	
  is.

Type Select	
  Ring-­‐All.

Ring-­‐All	
  Time Enter	
  the	
  length	
  of	
  ;me	
  that	
  you	
  want	
  the	
  devices	
  to	
  ring.	
  
Recommended:	
  30	
  seconds.

8. Click Save.
9. Click View Groups from the side bar on the left.
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10. Select the group you just created. 

8. Click View Groups from the side bar on the left.

9. Select the group you just created. 

10. Click Edit Members.

11. Select all the endpoints from the Available Devices—that you want to include in the Ring-All group—and use 
the arrow button to move the device to the Group Members area.

12. Click Save.
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11. Click Edit Members.

8. Click View Groups from the side bar on the left.

9. Select the group you just created. 

10. Click Edit Members.

11. Select all the endpoints from the Available Devices—that you want to include in the Ring-All group—and use 
the arrow button to move the device to the Group Members area.

12. Click Save.
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12. Select all the endpoints from the Available Devices—that you want to include in the Ring-All group—and use 
the arrow button to move the device to the Group Members area.

13. Click Save.

Next assign an extension to the call group just created. Note that the extension number is the number the Siedle unit 
will be dialing out.
14. Click the Extensions tab to open the Extensions page.
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15. Click Add Extension.

16. Enter or select values as shown in the next table.

Field Description

Number Number	
  of	
  extension	
  (do	
  not	
  enter	
  the	
  door	
  sta;on	
  extension)

Extension	
  Type Select	
  Call	
  Group	
  from	
  the	
  drop-­‐down	
  list.

Des;na;on Select	
  the	
  call	
  group	
  your	
  created	
  in	
  steps	
  6-­‐8.

17. Click Add New Ext.
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Setting Up a User for a Siedle Door Entry System
To complete configuration of the Siedle door entry system as part of the Savant PBX, a user must be set up on the 
DCA 650-02 component.

The DCA 650-02 is a universal a/b interface which connects the Siedle door station (shown below on the left) 
and in-house telephony with the public network.  For a view of the DCA 650-02, see the figure to the right.

Light bulb 
button

DCA 650-02

BNG-650-1

To set up a user on the Siedle door entry system, do the following.

1. Open the cover on the DCA 650-02.

2. On the DCA 650-02 main menu, press the OK button.

3. Press ▼ (down) arrow until you see "Register new user with <ok>".

4. Press OK button.

5. Wait until "Register user Please wait!" message stops flashing.

6. Use the down/up arrows to change the number of users to be registered, for example 1.

7. Press OK button.

8. Wait until "Register. running 01 new users" stops flashing.  This can take up to one minute.

9. When you see "Switch on prog. mode at BNG/BVNG" message flashing, using a pin press the "Prog. Mode" 
button on the BNG 650-1 power supply unit ( as shown on the previous figure).

10. Next, you should see a "Door loudspeaker enable" message flashing on the DCA 650-02.

11. Go to the door station and press the top right button (lightbulb icon as shown in the door station figure on above 
left) until you hear a long tone.
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12. "Door loudspeaker activated" should now be displayed.  You will hear a quick tone every five seconds.

13. Press OK button.

14. You should now see "Assign call btw. for user (user number)"

15. Press and hold the second button from the top-right which shows a bell.  You will hear a long tone then three 
quick tones.

16. You should now see "Direct call (user number)".

17. Using the arrows on the DCA  50-02, enter an extension number to be dialed when the Siedle button is pressed 
and then press OK button (# may be required at the end of the extension).

18. Press OK button.

19. Perform a quick press of the "Prog. Mode" button on the BNG 650-1 unit.

20. Press ESC on the unit to exit back to the top menu.

21. To communicate with the person who rang the doorbell at the door station, select the following from the DCA 
650-02:

service function > door call acceptance > No DTMF 

If you do not do this step, then you will only hear beeping when you answer the phone after someone rings the 
doorbell.
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Configuring DoorKing 1812 using RacePoint Blueprint
To add the DoorKing 1812 door entry system to the Savant PBX configuration using RacePoint Blueprint, do the 
following.

1. From the Library window, type door and select Generic Door Entry System. See the next screenshot.

2. Drag the component to main window and select the zone. Savant Systems recommends the global zone.

3. Click Choose.
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4. From the Show drop-down list select Telephony. See the next screenshot.

5. Select Registration Enabled.
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6. Enter the following:
• PBX IP address
• Username—this must match the Device Number you enter in the Savant Configurator.
• Password—leave this field empty.

7. Generate services, save, and upload the configuration.

8. Next, follow the procedure, Integrating a DoorKing 1812 with a Savant PBX.
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Integrating a DoorKing 1812 with a Savant PBX
This section provides an overview of the integration of a DoorKing 1812 with a Savant PBX. 

To complete the configuration of the DoorKing 1812 refer to the product installation manual, which is available from 
the Web site:  http://www.doorking.com/pages/dks-tel-1812.php 

The next figure shows the gateway port (line) sending the gate calls into the Savant PBX system.

DoorKing 1812 uses Savant Gateway (TEL-GW04) with Savant Telephony Solution 

The DoorKing 1812 allows two modes of operation:
• Phone Mode
• Intercom Mode

Each mode has a different wiring scheme from the DoorKing 1812 to the Savant PBX system.

All devices that are to communicate with the DoorKing 1812 must be added to a Shared Line Appearance (SLA) 
group. By doing so, when the call button is pressed from the DoorKing 1812, all of these devices will ring. Also, since 
the devices are added to the relevant SLA, the devices can call the DoorKing 1812 using an attention number. If the 
device is a Savant phone (TEL-HST02), you can program a speed dial button to the DoorKing 1812.  
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Phone Mode
This mode assumes you will be using an existing phone line or you will have a dedicated phone line. After the wiring 
is done, refer to the DoorKing 1812 installation manual to complete the configuration.

Single DK1812 Wiring

Multiple DK1812 Wiring
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Testing the DoorKing 1812 in Phone Mode
After you have completed your DoorKing 1812 installation and configuration, you must test the system. 

To test making a call to your DoorKing 1812 system, do the following.
1. Connect an analog phone to the Home (7  8) line.

2. Lift the phone’s handset to confirm there is dial tone.

3. Enter * and the attention number. For example, if you used 7 as the attention number, you would press *7. Now 
you should be connected and the audio should be two-way.

If you have programmed relay, now is the time to test the programming. See the DoorKing 1812 manual.

To test making a call from your DoorKing 1812 system, do the following.
1. Push the call button from the DoorKing 1812.

2. The analog phone should ring.

3. Answer the call. Now you should have two-way voice.

Test the relay codes, if you have them configured. See the DoorKing 1812 manual.

After you have successfully tested the DoorKing 1812, add the gateway to your DoorKing 1812 set up.

Adding Savant Gateway to DoorKing 1812 Configuration
To configure communication between the DoorKing 1812 and the Savant Gateway, do the following. This procedure 
applies whether you use Phone Mode or Intercom Mode.
1. Open a web browser.

2. Enter the Savant gateway IP address and log in to the gateway’s web interface.

3. Select the Configuration tab. and Full.

4. Go to VoIP > GW and IP to IP > Analog Gateway > Automatic Dialing. 

Testing the DoorKing 1812 in Phone Mode
After you have completed your DoorKing 1812 installation and configuration, you must test the system. 

To test making a call to your DoorKing 1812 system, do the following.
1. Connect an analog phone to the Home (7  8) line.

2. Lift the phone’s handset to confirm there is dial tone.

3. Enter * and the attention number. For example, if you used 7 as the attention number, you would press *7. Now 
you should be connected and the audio should be two-way.

If you have programmed relay, now is the time to test the programming. See the DoorKing 1812 manual.

To test making a call from your DoorKing 1812 system, do the following.
1. Push the call button from the DoorKing 1812.

2. The analog phone should ring.

3. Answer the call. Now you should have two-way voice.

Test the relay codes, if you have them configured. See the DoorKing 1812 manual.

After you have successfully tested the DoorKing 1812, add the gateway to your DoorKing 1812 set up.

Adding Savant Gateway to DoorKing 1812 Configuration
To configure communication between the DoorKing 1812 and the Savant Gateway, do the following. This procedure 
applies whether you use Phone Mode or Intercom Mode.
1. Open a web browser.

2. Enter the Savant gateway IP address and log in to the gateway’s web interface.

3. Select the Configuration tab. and Full.

4. Select Automatic Dialing from the left sidebar as shown in the next screenshot. 

5. For the Destination Phone Number field, enter 3333, and then select Submit. 

6. From the left sidebar navigate to Voip > GW an IP to IP > Analog Gateway > Caller Display Information.

7. For Port 2 FXO enter a meaningful name under Caller ID/Name, for example, Main Gate.
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5. For the Destination Phone Number field, enter 3333, and then select Submit. 

6. From the left sidebar navigate to VoIP > GW an IP to IP > Analog Gateway > Caller Display Information.

7. For Port 2 FXO enter a meaningful name under Caller ID/Name, for example, Main Gate.
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8. Click Submit.

9. Change the automatic dialed number for Channel 2 to 3333.

10. Go to Voip > GW and IP to IP > Hunt Group > Endpoint Phone Number.

11. Click Submit.

12. Save and burn the changes to flash memory.

Setting up the DoorKing 1812 Extension in the SLA
Next set up the DoorKing 1812 extension in the Shared Line Appearance (SLA) group.

1. Open Savant Configurator and log in.

2. Click the Extension tab.
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3. Select the extension associated with Line 2, that is, 6297. 

4. Click Edit Extension.
5. For the Number field, enter 3333.

 
4. Now the extension should show 3333

5.  Add all the devices that are to be rung when somebody calls from the gate as 
members of the SLA Group 2. 

6. Save configuration

Now if the DK unit button is pushed the all the devices that are members of SLA2 
should be ringing.

Now if you select SLA Line2 from a phone or iOS device and dial *7#  the call should 
connect to the DK unit.

Dialing of the Attention number *7
In order to make this easier for the user  so that the user does not have to dial *7# this 
number can be programmed as an speed dial button on the TEL-HST02.

TEL-HST02
Login into the phone via web browser.
Click Soft-keys and XML
Select any unassigned soft-key after number 11, in the picture we selected 12

6. Click Save.

Next add all the devices to SLA Group 2 that are to ring when a call is sent from the DoorKing 1812. For details on 
adding devices to an SLA group, see Adding an iOS Device or Phone to an SLA. 

Set up Speed Dial for Savant Phone to Connect to DoorKing 1812
Instead of using the “Attention” number to dial the DoorKing 1812 from a Savant phone (TEL-HST02), you can set up 
a speed dial button from the TEL-HST02. 

To program Speed Dial from the TEL-HST02, do the following.
1. Open a web browser.

2. Enter the IP address of the phone and log in.

3. Click Soft-keys and XML.

4. Select any unassigned soft-key after the number 11. In the next screenshot 12 is used as an example.

5. Use the next table to enter or select values.

Field Description

Type Enter SpeedDial

Label Enter Gate

Value Enter:  *7#

Line Select 1

6. Click Save.

To call the DoorKing 1812 from a Savant Phone (TEL-HST02) using a speed dial button, do the following.
1. Tap the Line 2 button on the screen of the TEL-HST02.

2. After you hear the dial tone tap the Gate button on the screen.

Now you should be connected to the DoorKing 1812.
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Intercom Mode
To complete the configuration of your DoorKing 1812—single unit or multiple units—in Intercom Mode, refer to the 
product installation manual, which is available from the Web site:  http://www.doorking.com/pages/dks-tel-1812.php 

Wiring for DoorKing 1812 Intercom Mode

Testing the DoorKing 1812 in Intercom Mode
After you have completed your DoorKing 1812 installation and configuration, you must test the system. 

To test making a call to your DoorKing 1812 system, do the following.
1. Lift the phone’s handset to confirm there is dial tone.

2. Enter * and the attention number. For example, if you used 7 as the attention number, you would press *7. Now 
you should be connected and the audio should be two-way.

If you have programmed relay, now is the time to test the programming. See the DoorKing 1812 manual.

To test making a call from your DoorKing 1812 system, do the following.
1. Push the call button from the DoorKing 1812.

2. The analog phone should ring.

3. Answer the call. Now you should have two-way voice.

Test the relay codes, if you have them configured. See the DoorKing 1812 manual.

After you have successfully tested the DoorKing 1812, add the gateway to your DoorKing 1812 set up. See the 
procedure, Adding Savant Gateway to DoorKing 1812 Configuration.
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Configuring Holovision with Cyberdata SIP intercom Using Savant Configurator 

The Holovision with Cyberdata unit operates as a fully-operational SIP IP phone—no ATA is required. The following 
Holovision models are supported by the Savant PBX:

All	
  400	
  Series
Model	
  513
All	
  600	
  Series

All	
  700	
  Series
All	
  800	
  Series
All	
  900	
  Series

To add a Holovision with Cyberdata unit as an endpoint within the Savant PBX system, open Savant Configurator and 
do the following.

1. Click the Devices (tab) to open the Devices page.

2.  Click Add Device (button).

Configuring Holovision with Cyberdata SIP intercom 
Using Savant Configurator 

The Holovision with Cyberdata unit operates as a fully-operational SIP IP phone—no ATA is required. The following 
Holovision models are supported by the Savant PBX:

3LL.(''.)/<6/=
I84/L.aBR
3LL.^''.)/<6/=

3LL.`''.)/<6/=
3LL.i''.)/<6/=
3LL.j''.)/<6/=

To add a Holovision with Cyberdata unit as an endpoint within the Savant PBX system, open Savant Configurator and 
do the following.
1. Click the Devices (tab) to open the Devices page.

2.  Click Add Device (button).
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3. Use the next table to enter or select values for the fields on the Add Device page.

Field Description

Server Leave as is. 

Type Select this option: IP Phone.

Device Number Enter a four-digit number (in the range 2000-2500) for this device.
The previous screenshot uses 2041 as an example. 

Assign to Provides a drop-down list of all users that the device can be assigned to. It can also be 
unassigned. Savant Systems recommends this field be unassigned. 

Friendly Name Name that displays when a call is made from this device. 

UID The Savant user identifier is automatically populated by the Device Number.
Context Default is Phone (all_calls). Use the default value.

Usable as Trunk Do not insert a check mark.

Use TCP Do not insert a check mark.

Secret Leave it blank.

Call Limit Enter 2.

Host Use the default: dynamic.

Port Use the default value: 5060.

NAT
Network Address Translation (NAT) helps determine whether this device is on the internal 
network or outside the firewall. Since you are adding an iOS device, you must insert a check 
mark in the check box.

Register? Do not insert a check mark.

Qualify Insert a check mark.

4. Click Add & Exit.

5. Click the Devices tab to ensure the new device appears in the list.

3. Use the next table to enter or select values for the fields on the Add Device page.

Field Description

)/<+/< #/*+/.*=.6=\.

!1>/ )/L/O-.-?6=.8>N8,_.<2)234%$\

X/+6O/.Z;5K/< ",-/<.*.M8;<$46:6-.,;5K/<.C6,.-?/.<*,:/.@'''$@a''E.M8<.-?6=.4/+6O/\
!?/.></+68;=.=O<//,=?8-.;=/=.@'(B.*=.*,./[*5>L/\.

3==6:,.-8 A<8+64/=.*.4<8>$480,.L6=-.8M.*LL.;=/<=.-?*-.-?/.4/+6O/.O*,.K/.*==6:,/4.-8\.W-.O*,.
*L=8.K/.;,*==6:,/4\.)*+*,-.)1=-/5=.</O855/,4=.-?6=.9/L4.K/.;,*==6:,/4\.

]<6/,4L1.Z*5/ Z*5/.-?*-.46=>L*1=.0?/,.*.O*LL.6=.5*4/.M<85.-?6=.4/+6O/\.

TWX !?/.)*+*,-.;=/<.64/,N9/<.6=.*;-85*NO*LL1.>8>;L*-/4.K1.-?/./$0#1$)*B,C$"D

78,-/[- X/M*;L-.6=.234%$.5+''61+''78\.T=/.-?/.4/M*;L-.+*L;/\

T=*KL/.*=.!<;,U X8.,8-.6,=/<-.*.O?/OU.5*<U\

T=/.!7A X8.,8-.6,=/<-.*.O?/OU.5*<U\

)/O</- #/*+/.6-.KL*,U\

7*LL.#656- ",-/<.9\

Y8=- T=/.-?/.4/M*;L-_.&(%+,#1\

A8<- T=/.-?/.4/M*;L-.+*L;/_.a'^'\

Z3! Z/-08<U.344</==.!<*,=L*N8,.CZ3!E.?/L>=.4/-/<56,/.0?/-?/<.-?6=.4/+6O/.6=.8,.
-?/.6,-/<,*L.,/-08<U.8<.8;-=64/.-?/.9</0*LL\.)6,O/.18;.*</.*446,:.*,.6J).4/+6O/b.
18;.5;=-.6,=/<-.*.O?/OU.5*<U.6,.-?/.O?/OU.K8[\

H/:6=-/<c X8.,8-.6,=/<-.*.O?/OU.5*<U\

d;*L6M1 W,=/<-.*.O?/OU.5*<U\

4. Click Add & Exit.

5. Click the Devices tab to ensure the new device appears in the list.

6. Click Call Groups (tab) and then click Add Group.

  Confidential and Proprietary                                                                         179 of  246Savant Telephony Solution Deployment Guide
PBX Release 5.1.1
009-0406-07

6. Click Call Groups (tab) and then click Add Group.

7. Use the next table to enter or select values for the fields on the Add Call Group page.

 Field Description

Z*5/ Z*5/.8M.:<8;>\.

]*6L."[-/,=68, #/*+/.*=.6=\

!1>/ )/L/O-.H6,:$3LL\

H6,:$3LL.!65/ ",-/<.-?/.,;5K/<.18;.0*,-.-?/.4/+6O/=.-8.<6,:\.H/O855/,4/4_.R'.=/O8,4=

8. Click Save.

9. Select View Groups from the side bar.

10. Select the group you just created. 
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7. Use the next table to enter or select values for the fields on the Add Call Group page.

Field Description

Name Name of group. 

Fail Extension Leave as is.

Type Select Ring-All.

Ring-All Time Enter the number you want the devices to ring. Recommended: 30 seconds

8. Click Save.

9. Select View Groups from the side bar.

10. Select the group you just created. 

7. Use the next table to enter or select values for the fields on the Add Call Group page.

 Field Description

Z*5/ Z*5/.8M.:<8;>\.

]*6L."[-/,=68, #/*+/.*=.6=\

!1>/ )/L/O-.H6,:$3LL\

H6,:$3LL.!65/ ",-/<.-?/.,;5K/<.18;.0*,-.-?/.4/+6O/=.-8.<6,:\.H/O855/,4/4_.R'.=/O8,4=

8. Click Save.

9. Select View Groups from the side bar.

10. Select the group you just created. 
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11. Click Edit Members.

11. Click Edit Members.

12. Select all the endpoints from the Available Devices—that you want to include in the Ring-All group—and use 
the arrow button to move the device to the Group Members area.

13. Click Save.

14. Click the Extension (tab) and then click Add Extension to open the Add Extension page.

15. Use the next table to enter or select values for the fields on the Add Extension page.

Field Description

Z;5K/< Z;5K/<.06LL.K/.-?/.,;5K/<.-?*-.-?/.488<./,-<1.06LL.46*L\.W,.-?/.
></+68;=.=O<//,=?8-.QRRR.6=.=?80,.*=.*,./[*5>L/\

"[-/,=68,.!1>/ )/L/O-.L+'')M"4B=\

X/=N,*N8, )/L/O-.-?/.7*LL.%<8;>.O</*-/4.6,.=-/>.^\.W,.-?/.></+68;=.=O<//,=?8-.
M+@$.6=.=?80,.*=.*,./[*5>L/\

16. Click Add New Ext.
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12. Select all the endpoints from the Available Devices—that you want to include in the Ring-All group—and use 
the arrow button to move the device to the Group Members area.

13. Click Save.
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14. Click the Extension (tab) and then click Add Extension to open the Add Extension page.

11. Click Edit Members.

12. Select all the endpoints from the Available Devices—that you want to include in the Ring-All group—and use 
the arrow button to move the device to the Group Members area.

13. Click Save.

14. Click the Extension (tab) and then click Add Extension to open the Add Extension page.

15. Use the next table to enter or select values for the fields on the Add Extension page.

Field Description

Z;5K/< Z;5K/<.06LL.K/.-?/.,;5K/<.-?*-.-?/.488<./,-<1.06LL.46*L\.W,.-?/.
></+68;=.=O<//,=?8-.QRRR.6=.=?80,.*=.*,./[*5>L/\

"[-/,=68,.!1>/ )/L/O-.L+'')M"4B=\

X/=N,*N8, )/L/O-.-?/.7*LL.%<8;>.O</*-/4.6,.=-/>.^\.W,.-?/.></+68;=.=O<//,=?8-.
M+@$.6=.=?80,.*=.*,./[*5>L/\

16. Click Add New Ext.
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15. Use the next table to enter or select values for the fields on the Add Extension page.

Field Description

Number Number will be the number that the door entry will dial. In the previous 
screenshot 3000 is shown as an example.

Extension Type Select Call Group.

Destination Select the Call Group created in step 6. In the previous screenshot 
Gate is shown as an example.

16. Click Add New Ext.
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Configuring Holovision Cyberdata VoIP Intercom
This door entry system is configured as DHCP from the factory. Ensure that you reserve the DHCP-assigned IP 
address on your DHCP server. This procedure assumes you are installing the Cyberdata VoIP Intercom based on 
firmware version: 6.3.0.
To configure the Cyberdata VoIP Intercom, do the following.

1. Open your web browser and enter the door entry system’s IP address.

2. Log in using the following:

User Name: admin
Password: admin

3. Click Log In. The Cyberdata Intercom page opens. See the next screenshot.

4. Click SIP Config.
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The SIP Configuration page opens.

5. Use the next table to enter or select values for the relevant fields on the SIP Configuration page.

Field Description

SIP Server Enter the Savant PBX address

Remote SIP Port Leave as is (5060)

Local SIP Port Leave as is (5060)

Outbound Proxy Leave blank.

Oubound Proxy Port Leave blank.

SIP User ID Enter the Device Number used when you added the device in Savant Configurator.

Authenticate ID Enter the Device Number used when you added the device in Savant Configurator
Authenticate 
Password Enter the Device Number used when you added the device in Savant Configurator.

Call disconnection Change	
  the	
  value	
  to	
  0	
  (zero)	
  seconds.

Dial Out Extension Enter the extension associated with the Ring group you added in Savant Configurator.

Extension ID: Enter the user Friendly Name used when you added the device in Savant Configurator

6. Click Save.
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7. Click Reboot. The next status message is displayed.

Next, the Enable SIP operation field is confirmed as Registered with SIP Server.

Now you are ready to make a call.
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Configuring VIO by Holovision VoIP Intercom
This door entry system is configured as DHCP from the factory. Ensure that you reserve the DHCP-assigned IP 
address on your DHCP server.

To configure the ViO by Holovision VoIP Intercom, do the following.

1. Open your web browser and enter the door entry system’s IP address in the browser’s address bar .

2. Click the CONFIGURATION tab. See the next screenshot.

3. Use the next table to enter or select values for the fields on the SIP Client page (Basic Settings).
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Field Description

Peer to Peer Use the default: No.

SIP Server (PBX) Enter the IP address of the Savant PBX.

SIP ID (username) Enter the device number used when you added the device in Savant 
Configurator

SIP Password (secret) Enter the device number used when you added the device in Savant 
Configurator

SIP Display Name Enter the user-friendly name used when you added the device in Savant 
Configurator.

Input 0 Call ID Enter the extension associated with the ring group you added in Savant 
Configurator.

Input 0 Call ID Leave blank

Input 1 Call ID Leave blank

Input 2 Call ID Leave blank

Phone pickup mode Leave as is (autoanswer)

Pick/hang up time Leave as is (20 seconds)

4. Click Apply.  The unit will reset in 4 seconds, see next screenshot.

17. Click Home tab. 

The Time till next Registration field is confirmed in green text. See the next 
screenshot.

Now the unit is ready to make and receive calls.
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If required, a door code may be set using the Advanced Settings. The following example screenshot, shows the 
number 11 used to connect the gate to the relay. Pressing 11 will open the gate.

Enter the Door Open Code you wish to use to connect the gate to the relay.  Click Apply.

5. Click the Home tab. 

The Time till next Registration field is confirmed in green text. See the next screenshot.

Now the unit is ready to make and receive calls.
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Adding the Mobotix T24 Using RacePoint Blueprint™
The Mobotix T24 door entry unit is a fully operational SIP phone with an IP camera included.

To add the door entry unit as part of the Savant PBX configuration in RacePoint Blueprint, do the following.

1. From the Library, select Generic Door Entry System.

2. Drag the component to the Layout window. 

3. Enter a unique name for the component.

4. Inspect the component.

5. Select Telephony from the Show popup menu.

6. Select Registration, on the Detail window, enter the following.

o Savant PBX IP address
o User name (same as the one used in Savant Configurator, for example, 2050)
o Leave password blank.

See the next screenshot.
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Important! The user name entered for this step match the one used when the device is added in Savant 
Configurator.

You must enter the Savant 
PBX IP address and a User 
name (same as the device 
number used in Savant 
Configurator, for example, 
2050.

7. Select Video on the Detail window.
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8. Enter the URL for the camera feed as follows:

http://username:password@camera_ip/control/faststream.jpg?stream=full&amp;fps=30

Where:
Username: the user name of the camera
Password: password of the camera
camera_ip: IP Address of the camera.

9. Generate services, save, and upload the configuration.

Next add the Mobotix T24 as a device in Savant Configurator. See the next procedure, Adding a Mobotix T24 Using 
Savant Configurator.
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http://username:password@camera
http://username:password@camera


Adding a Mobotix T24 Using Savant Configurator
To add the Mobotix T24 unit as an endpoint within the Savant PBX using Savant Configurator, do the following.
1. Click the Devices tab.

2. Click Add Device to open the Add Device page.

3. Use the next table to enter or select values for the fields on the Add Device page.

Field Description

Server Leave as is. 

Type Select this option: IP Phone.

Device Number Enter a four-digit number (in the range 2000-2500) for this device. 

Assign to Provides a drop-down list of all users that the device can be assigned to. It can also 
be unassigned. Savant Systems recommends this field be unassigned. 

Friendly Name Name that displays when a call is made from this device. 

UID The Savant user identifier is automatically populated by the Device Number. 
Context Default is Phone (all_calls). Use the default value.

Usable as Trunk Do not insert a check mark.

Use TCP Do not insert a check mark.

Secret Leave it blank.

Call Limit Enter 2.

Host Use the default: dynamic.

Port Use the default value: 5060.

NAT
Network Address Translation (NAT) helps determine whether this device is on the 
internal network or outside the firewall. You must insert a check mark in the check 
box.

Register? Do not insert a check mark.
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Qualify Insert a check mark.

4. Click Add & Exit.
5. Click View Devices from the left side bar and confirm the new device appears in the list. See the next 

screenshot with the Mobotix device circled.

A8<- T=/.-?/.4/M*;L-.+*L;/_.a'^'\

Z3! Z/-08<U.344</==.!<*,=L*N8,.CZ3!E.?/L>=.4/-/<56,/.0?/-?/<.-?6=.4/+6O/.6=.8,.-?/.
6,-/<,*L.,/-08<U.8<.8;-=64/.-?/.9</0*LL\.t8;.5;=-.6,=/<-.*.O?/OU.5*<U.6,.-?/.O?/OU.
K8[\

H/:6=-/<c X8.,8-.6,=/<-.*.O?/OU.5*<U\

d;*L6M1 W,=/<-.*.O?/OU.5*<U\

4. Click Add & Exit.

5. Click View Devices from the left side bar and confirm the new device appears in the list. See the next 
screenshot with the Mobotix device circled.

6. Click Call Groups and then click Add Group to open the Add Call Group page.

7. Use the next table to enter or select values for the fields on the Add Call Group page.

Field Description

Z*5/ Z*5/.8M.:<8;>\.

]*6L."[-/,=68, #/*+/.*=.6=\

!1>/ )/L/O-.H6,:$3LL\

X6=-<6K;-/4.3;468.k8,/= W,=/<-.*.O?/OU.5*<U.6,.-?/.K8[b.6M.</f;6</4\

8. Click Save.

9. Click View Groups from the left side bar, and then from the list select the group you just created. 
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6. Click Call Groups and then click Add Group to open the Add Call Group page.

A8<- T=/.-?/.4/M*;L-.+*L;/_.a'^'\

Z3! Z/-08<U.344</==.!<*,=L*N8,.CZ3!E.?/L>=.4/-/<56,/.0?/-?/<.-?6=.4/+6O/.6=.8,.-?/.
6,-/<,*L.,/-08<U.8<.8;-=64/.-?/.9</0*LL\.t8;.5;=-.6,=/<-.*.O?/OU.5*<U.6,.-?/.O?/OU.
K8[\

H/:6=-/<c X8.,8-.6,=/<-.*.O?/OU.5*<U\

d;*L6M1 W,=/<-.*.O?/OU.5*<U\

4. Click Add & Exit.

5. Click View Devices from the left side bar and confirm the new device appears in the list. See the next 
screenshot with the Mobotix device circled.

6. Click Call Groups and then click Add Group to open the Add Call Group page.

7. Use the next table to enter or select values for the fields on the Add Call Group page.

Field Description

Z*5/ Z*5/.8M.:<8;>\.

]*6L."[-/,=68, #/*+/.*=.6=\

!1>/ )/L/O-.H6,:$3LL\

X6=-<6K;-/4.3;468.k8,/= W,=/<-.*.O?/OU.5*<U.6,.-?/.K8[b.6M.</f;6</4\

8. Click Save.

9. Click View Groups from the left side bar, and then from the list select the group you just created. 
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7. Use the next table to enter or select values for the fields on the Add Call Group page.

Field Description

Name Name of group. 

Fail Extension Leave as is.

Type Select Ring-All.

Distributed Audio Zones Insert a check mark in the box, if required.

8. Click Save.

9. Click View Groups from the left side bar, and then from the list select the group you just created. 
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10. Click Edit Members.

 

11. Select all the endpoints from the Available Devices—that you want to include in the Ring-All group—and use 
the arrow button to move the device to the Group Members area.

12. Click Save.
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10. Click Edit Members to open the edit group members page. See the screenshot on the next page.

10. Click Edit Members.

 

11. Select all the endpoints from the Available Devices—that you want to include in the Ring-All group—and use 
the arrow button to move the device to the Group Members area.

12. Click Save.
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11. Select all the endpoints from the Available Devices—that you want to include in the Ring-All group—and use 
the arrow button to move the device to the Group Members area.

12. Click Save.

13. Click the Extension tab and click the Add Extension button to open the Add Extension page.

13. Click the Extension tab and click the Add Extension button to open the Add Extension page.

14. Use the next table to enter or select values for the fields on the Add Extension page.

Field Description

Z;5K/< Z;5K/<.06LL.K/.-?/.,;5K/<.-?*-.-?/.488<./,-<1.06LL.46*L\.

"[-/,=68,.!1>/ )/L/O-.L+'')M"4B=\

X/=N,*N8, )/L/O-.H6,:$3LL\
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14. Use the next table to enter or select values for the fields on the Add Extension page.

Field Description

Number Number will be the number that the door entry will dial. 

Extension Type Select Call Group.

Destination Select Ring-All.
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Configuring the VoIP Settings for Mobotix T24 Intercom
The Mobotix T 24 intercom can be configured using the Mobotix web interface. When using this interface you may be 
prompted to store your configuration. If so, click OK to avoid losing data.

The Mobotix T24 advertises itself via Bonjour®.

NOTE: This procedure is based on the Mobotix web interface version: 4.1.1.21. If the Mobotix website is 
using a different version, please contact Mobotix customer support.

To configure the VoIP Settings for the Mobotix T24 Intercom, do the following.

1. Open Safari and click Bonjour. If Bonjour is not included on your Bookmarks Bar, see the procedure for adding it  
by clicking here (see page 56). 

2. Enter the user name and password as follows:

User: admin
Password: meinsm

3. Click Log in to open the main page of the Mobotix web interface. See the next screenshot.
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Main Page in Mobotix Web Interface

4. Click Admin Menu to open the Mobotix Administration Overview page in the web interface. See the next 
screenshot.
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Administration Overview Page
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#$%&!'()!*+,-./01213+0!45206/78!
!
93/:;/!9<71/.=!>(#(#!*+,-./01213+0!9121/7!1521!15/!?3:/+!@AB!C271/:!301+!%;-/CD301!
75+-;:!E/8!511C8FFD++18D++1G")('(H)#(>IF.JC6FK3:/+(JC6!
 
'()=!L5/D/!75+-;:!E/!20!.!E/M+D/!15/!/0:306!(JC6(!!!@AB!75+-;:!E/8!
511C8FFD++18D++1G")('(H)#(>IF.JC6FK3:/+(.JC6!
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5. In the Audio and VoIP Telephony group, click SIP Client Settings to open the page for these settings. See the 
next screenshot.

6. In the Setup Mode group, select Expert	
  Setup.	
  	
  This	
  enables	
  more	
  op;ons	
  for	
  the	
  General	
  Phone	
  Se?ngs	
  and	
  
shows	
  the	
  Add	
  new SIP account button.

7. Click Add new SIP account once to add a blank row for entering a SIP account.
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8. Use the next table to complete the fields shown in the previous screenshot.

Field Description

SIP Client Select Enabled

Hangup On Outgoing Calls Select Disabled

Parallel Dialing Select Disabled

SIP Address: User Name Assigned Device Number of Mobotix system in Savant Configurator.   

SIP Address: Domain IP Address of the Savant PBX

Authentication: User Name Assigned Device number of Mobotix system in Savant Configurator. 
This user name should match the SIP Address: User Name. 

Authentication: Password Leave field blank.

Server: Hostname/address Make sure the Use as Registrar boxes are checked.

Server: Port Leave field blank.

Available As Proxy Leave field blank.

Use As Registrar Add check mark.

Registrar Expiration Use 5 minutes

9. Scroll down to the Audio Codec Settings section and insert a check mark for Use PCMA Codec and Use 
PCMU Codec.

10. Scroll down and click Set. 

At this point the Mobotix unit should be registered with the Savant PBX.

11. Go back to the Admin Menu by clicking the left arrow at the top of the page. See Administration Overview Page.

12. From the Audio and VoIP Telephony group select Outgoing Calls Settings.

13. Click the Add button to open the Mobotix Outgoing Calls Settings page.

14. Enter a Profile name in the field as circled in red in the next screenshot.

  Confidential and Proprietary                                                                         226 of  272Savant Telephony Solution Deployment Guide
Release PBX 6.0
009-0406-14



! '!

!!
4;3,W!15/!Z::!E-11+0!20:!2!E;20W!E+O!Q3;;!E/!75+Q0(!!
$5+0/!_-.E/D!+D!9\$!Z::D/77=!^O1/073+0!_-.E/D!M+D!15/!N+E+13O!,2;;!6D+-C!MD+.!
92K201!4+0M36-D21+D!R.30/!37!#))"TG\$!+M!$%&!
!
ZM1/D!./7726/!527!E//0!7/018!\01/D,+.(!!
P206-C!2M1/D8!"!N30-1/(!
!
4;3,W!15/!9/1!E-11+0!21!15/!E+11+.(!!
`+!E2,W!1+!15/!./0-!E<!,;3,W306!15/!;/M1!2DD+Q!21!15/!1+C!;/M1!+M!15/!7,D//0(!
!
$9!,20!<+-!,3D,;/!15/![,2;;b"]!30!15/!1+C!;/M1!E+OS!730,/!Q/!Q3;;!E/!7//306!1537!;21/Dc!
!
!

15. Use the next table to complete the fields shown in the previous screenshot.

Field Description

Phone Number or SIP Address Enter the extension you selected for the ring group followed by @ 
and the Savant PBX IP address.

Message Name Leave as is.

Connection Type Select SIP Audio.

Confirm call with PIN code Leave blank.

After the message has been sent Select Intercom.

Camera Remote Control Select On.

Hangup after: Select 1 minute.

16. Click Set.

17. Go back to the Administration Overview page and click the Incoming Calls Settings option in the Audio and 
VoIP Telephony group. See the next screenshot.
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18. Use the next table to complete the fields shown in the previous screenshot.

Field Description
Phone	
  Call-­‐In	
   Select	
  VoIP.

Accepted	
  Phone	
  Numbers	
  or	
  SIP	
  addresses Leave	
  blank.

Accepted	
  SIP	
  proxies Leave	
  blank.

PIN	
  Code Leave	
  blank.

Audio	
  Mode Select	
  Speak

Intercom	
  Sebngs Threshold:	
  Disabled	
  	
  |	
  	
  Dura;on:	
  Medium

Hangup	
  call	
  aMer	
   Select	
  1	
  minute.
E-­‐mail	
  Profile Select	
  disabled.

19. Click Set.

20. Go back to the Administration Overview page and click the LoudSpeaker and Microphone option in the Audio 
and VoIP Telephony group. See the next screenshot.
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21. Use the next table to complete the fields shown in the previous screenshot.

Field Description

Audio	
  Input Select	
  Microphone	
  and	
  select	
  Medium	
  sensiCvity.

Audio	
  Output Select	
  Speaker.

Echo	
  Cancella;on Select	
  Enabled.

22. Click Set.

23. Go to the Mobotix T24 main web page by clicking 
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 and then click Setup Menu (on the left).

24. From the Event Control group, click Event Overview.
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25. Use the next table to complete the fields shown in the Signal Events group in the previous screenshot.

Field Description

Signal Input Select SI and add a check mark to Inactive

UC Soft Button Select UC. Leave Inactive and leave Delete unchecked.

Signal Input Select CameraBellButton.
Leave Inactive and Delete unchecked.

Signal Input Select CameraLightButton.
Add a check mark to Inactive and leave Delete unchecked.

26. Click Set.

27. Go back to the Mobotix Setup Overview page.

28. From the Event Control group select the Action Group Overview to open the configuration settings for the 
Action Group Overview page.

! "H!

!
!
!
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!
!
!
!

29. Click Add new group to open the configuration settings for an action group.
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30. Enter a name for the action group and then click Edit to open the action group details.
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31. Use the next table to complete the fields shown in the Action Group Details page in the previous screenshot.

Field Description

Action Group: Name Select the action group created in step 28. The previous 
screenshot shows for example, Doorbell.

Arming Select Enable.

Event Selection Select SignalCameraBellButton.

Action Details Enter 0
Use Simultaneously

32. Click Add new action to open the ...Action Group Details page. See the next screenshot
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33. Use the next table to complete the fields shown in the ...Action Group Details page in the previous screenshot.

Field Description

Action 1: Action Type and Profile Select Phone Call:call_1

Action 1: Action Timeout Select 0

34. Click Set.

35. Go to the Mobotix T24 main web page by clicking 
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 and then click Admin Menu (on the left).

36. From the Configuration group click Store to open the Mobotix Permanently Store Configuration page. See 
the next screenshot.
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Now a call can be sent to the door entry unit. When you receive a call from the endpoint associated with the Mobotix 
T24, you will see the message, Incoming Call. See the next screenshot.
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If answered, you will see the Connected message. See the next screenshot.
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8. APPENDIX 1
Use this appendix to update the Savant IP Phone Firmware, and to install the Savant phones: TEL-HSTW01, TEL-
HST01, TEL-HSTW02.
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Updating Savant Phone Firmware using PBX 6.0
If you are using pre-Release PBX 5.2 software, see - Savant Phone Firmware using Pre PBX 5.2.

The table below represents the PBX Releases and coordinating Firmware that should be used for them.

PBX Release Use This Firmware

Pre 5.2.1.13:1 3.2.2.56 or higher

Post 5.2.1.13:1 3.2.2.2112 or higher

If you are using Release PBX 5.2.1 or later to update the firmware on the wired Savant IP phones—TEL-HST01 and 
TEL-HST02—do the following.

1. Open Savant Configurator and click the Phone tab.

2. Click the IP address of the phone for which the firmware is to be updated. This opens the web user interface of 
that phone. 

3. Under Advanced Settings, click Firmware Update.

4. Use the next table to modify the fields on the Manual Firmware Update page.

Field Description
File Name Enter TEL-HST01.st if the phone is TEL-HST01 model, or TEL-HST02.st if 

the phone is the TEL-HST02 model. Double check the file name and phone 
model is correct.

Download Protocol TFTP

Server Enter the IP address of PBX

Path Leave it empty

Port Use the default: zero (0)

Username This is not required

Password This is not required

See the next screenshot.
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5. Click Download Firmware. Wait for a couple of minutes.

6. Confirm that the web interface displays: “Firmware upgrade successful. The phone is restarting.” See the next 
screenshot.

7. After the phone restarts, under Status click System information. Confirm the Firmware Version under 
Firmware information.
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Updating Savant Phone Firmware using Pre-PBX 5.2
If you are using pre-Release PBX 5.2. software to update the firmware on the wired Savant IP phones—TEL-HST01 
and TEL-HST02—see the Release PBX5.2 Savant Telephony Solution Deployment Guide (009-0406-08).

If you are using Release PBX 5.2.1 to update the firmware on the wired Savant IP phones—TEL-HST01 and TEL-
HST02—see the procedure Updating Savant Phone Firmware using PBX 5.2.1.
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Installing the Savant Wireless Phone: TEL-HSTW01
Inserting the Standard Battery
Push the battery cover downwards until it disengages from the locking mechanism and lift off. Insert the battery with 
the contacts downwards. Replace the battery cover and push upwards until it snaps into place.

Installing the Mounting Bracket
Place the supplied fixing bracket on both openings at the upper end of the handset and snap in place by 
pressing downwards. To remove the fixing bracket, press into the small cutouts at the edge of the bracket and 
pull the two sides slightly apart. 

Attaching the Carrying Strap
There are two openings in the upper part of the fixing bracket. Feed the lower end of the carrying strap through these 
openings (please install with the fixing bracket removed). 

Headset Connection: Bluetooth®
All handsets have a 2.5 mm jack plug at the bottom left for connecting a headset. Only use the recommended 
headsets 
The TEL-HSTW01 mobile handset has a Bluetooth interface (2.0) for corresponding headsets. With a headset only 
audio data can be transferred via the Bluetooth interface.

Headset Safety Information
Headsets (earphones and headphones) can produce very loud and high-pitched feedback. Exposure to such 
feedback can damage hearing. Before using a headset, set the volume as low as possible. For wired headsets, you 
can adjust the settings in the menu ›❯›❯›❯ Audio > Volume > Headset (wire). In the case of Bluetooth headsets, adjust 
the setting on the device (please consult the User’s Guide for the device). If you are making a call with the headset, 
adjust the volume slowly if necessary. 

USB and External Charging Connection
A mini USB connection (2.0) is located at the bottom right. This has two functions: 

• as an interface for connecting to a PC to load data from or to the device, for example. If the handset is 
connected to a PC, the battery is charged at the same time. The charging process is, however, slower 
than if the handset is charged in the charging unit. 

• as a connection socket for a USB charging device to charge the handset even when it is in a leather 
pouch. The charging process is also slower here than charging in the charger cradle. 

Only use a shielded USB cable of the type “USB 2.0 A on USB Mini B”.
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Connecting the Charging Unit
This handset can be used without any changes to the charger cradle. 

The plastic guides can also be removed, by pushing a suitable screwdriver into the slits on the bottom of the charger. 

Connect the plugin power supply to the charger cradle and place the connection cable through the cable guide. Place 
the charger cradle on a nonslip surface. Change the plug of the power supply unit if necessary. 

Power Supply
The power supply unit is designed for 100V to 240V AC (50-60 Hz). It is supplied with four change adapters enabling 
virtually worldwide use. Where necessary, connect the plug normally used in your country to the power supply 
unit. There are two versions of the plug-in power supply unit that are connected slightly differently:

Version 1: Set the switch on the power supply unit to OPEN and push out the existing plug upwards. 
Then insert the new plug required into the power supply unit and lock it with the switch (LOCK).

Version 2: Remove any existing plug by pressing OPEN. Then insert the required new plug into the 
power supply unit at a slight angle with the label TOP upwards. Press downwards until it snaps into 
place.

Micro SD Card
There is a slot for a micro SD card under the battery in the Savant TEL-HSTW01 handset. This is not
used in the current delivery condition and is available for future applications. Please make sure that the card 
slot is not damaged when inserting the battery.

Important Information about the Battery
The devices are powered by a Li-ion battery (both standard and power battery). It is vital that you read the 
safety regulations before using the battery for the first time. Keep these safety regulations and all instructions 
for use at hand for future reference.

• Dispose of used batteries in accordance with local regulations.
• Failure to heed any of the following precautions when using the battery can lead to overheating, fire and 

danger of explosion.
• CAUTION: Risk of explosion if the battery is replaced by an incorrect type.
• Never try to use the battery for the power supply of any device other than these handsets.
• Never use or leave the battery close to a naked flame.
• Never put the battery into a microwave oven, do not throw it into a fire and do not expose it to high 

temperatures by any other means.
• Never carry or store the battery together with electrically conducting objects (neck chains, pencil leads, etc.)
• Never attempt to open the battery, never modify it in any way or subject it to severe blows.
• Never immerse the battery in fresh or salt water.
• Never use or leave the battery in direct sunlight, in a vehicle parked in blazing sunlight or in any other 

location with high temperatures.
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• If you ever notice liquid leaking out, unusual odor, build-up of heat, discoloration, deformation or any other 
abnormal condition when you use, charge or store the battery, remove the battery immediately from the 
handset and keep it away from naked flames.

• The battery fluid can damage your sight. If at any time battery fluid accidentally gets into your eyes, rinse 
your eyes immediately with clean tap water and contact a doctor.

• If the battery is to be used by children, make sure a responsible adult instructs the children in the 
precautions and proper handling, and make sure the children handle the battery correctly.

• If battery fluid accidentally gets onto your clothing or skin, rinse the affected place immediately with pure tap 
water. Prolonged contact with battery fluid can lead to skin inflammation.

Precautions During Use:
• The battery is designed for use with these handsets only. 
• Only use the charger cradle supplied for charging. 
• A new battery is not charged so you need to charge it before using for the first time. 
• Using the battery in a cold environment can shorten the expected operating life of a full charge. 

Charge the battery at a location with a temperature between 10° C and 35° C. Charging outside this 
temperature range can lead to a longer-than-usual charging time or even to failure of the charging 
process. 

• An extremely short operating time after a full charge indicates that the lifetime of the battery has 
expired. Replace the battery. 

• Never wipe the battery with thinners, benzene, alcohol, or other volatile substances, or chemically 
treated cloths. These can cause deformation of the battery and malfunction. 

• If you need to send your handset with an installed LI-ion battery or LI-ion batteries separately, make 
sure you comply with the applicable laws and regulations with regard to the shipment of hazardous 
goods. 
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Installing the Savant Phone: TEL-HST02
The Savant TEL-HST02 communicates over an IP network allowing you to place and receive calls in the same 
manner as a regular business telephone. The Savant TEL-HST02 is capable of supporting the SIP IP protocol.

Requirements
The Savant TEL-HST02 requires the following environment:

• SIP-based IP PBX system or network installed and running with a SIP account created for the TEL-HST02 
phone.

• Access to a Trivial File Transfer Protocol (TFTP) server, File Transfer Protocol (FTP) server, Hypertext 
Transfer Protocol (HTTP) server or access to Hyper Text Transfer Protocol over Secure Sockets Layer (SSL) 
(HTTPS) server.

• Ethernet/Fast Ethernet LAN (10/100 Base-T), Gigabit Ethernet LAN (1000 Base-T) recommended
• Category 5/5e straight through cabling
• Power source

For Ethernet networks that supply in-line power to the phone (IEEE 802.3af):

For power, use the Ethernet cable (supplied) to connect from the phone directly to the network for power. (No 
48v AC power adapter required.)

Standards-based (802.3af compliant) Power over Ethernet affords a one-wire solution for connecting Ethernet 
devices, delivering power and data over a single CAT5/6 network cable. Using 802.3af compliant PoE injectors 
or PoE Ethernet Switches, there is no need to install a separate power supply at the device location. The PoE 
injector or PoE Ethernet Switch can simply be mounted at any convenient location up to 100 meters (328 feet) 
from the device. 

NOTE:  Due to the inherent voltage drop over copper wire, a maximum of 12.9 W is guaranteed to be 
received by the PoE powered device over a cable run length of 328 feet (100 meters) per 
specification.

For Ethernet networks that DO NOT supply power to the phone (optional):

For power, use the 48V AC Power Adapter (optional accessory) to connect from the DC power port on the phone 
to a power source.

Phone Parts (TEL-HST02)
When you unpack your phone, you should ensure that you have all of the following items. If any part is missing, 
contact the supplier of your phone.

Savant Phone (TEL-HST02)
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Optional Accessories (Not Included)

A PoE (Power over Ethernet) inline power injector supplies 48v power to the HST-02 through the Ethernet Cable on 
pins 4 & 5 and 7 & 8.

Warning: Do not use this PoE inline power injector to power other devices.
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Installation and Setup

The HST02 can be setup to share a network connection with another network device. Power can be provided by an 
AC adapter (optional accessory), an 802.3af compliant network power source, or with a PoE inline power injector 
(optional accessory). It can also be installed on a desk or mounted on the wall.

Direct or Shared Network Connection

The phone can be set up as a direct network connection to the Ethernet wall jack or as a shared network connection 
as a pass-through if connecting a computer or another network device to the phone.

Direct Network Connection

Located at the top of the phone are two fully switched 10/100/1000 Mbps Ethernet cable ports. The port marked with 
LAN is used to connect the phone to the network, as well as provide power to your phone (if required).

Shared Network Connection

To connect a network device (such as a computer) to the phone, connect an Ethernet cable into the network port on 
the top of the phone marked PC. Plug the other end of the Ethernet cable into the network port on the network device 
with which you are sharing the network connection.

Note: The PC jack on the HST02 does not supply inline power onto other network devices. All Ethernet cables used 
must be category 5/5e straight-through cables, such as the cable provided with your phone
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Connecting to the Network and to Power

Inline Power Provided

If your network provides 802.3af compliant in-line power, the phone is powered through the network.

1. On the top of your phone, connect the Ethernet cable (provided with your phone) into the network port marked with 
LAN.

2. Plug the other end of the Ethernet cable directly into the network jack on the wall.

Inline Power Not Provided

If your network does not provide 802.3af compliant in-line power, you need to install the supplied AC adapter or the 
PoE inline power injector (optional accessory).

1. On the top of your phone, connect the Ethernet cable (provided with your phone) into the network port marked with 
LAN.

2. On the PoE power injector, plug the other end of the Ethernet cable into the network jack marked as indicated in 
the following illustration.

3. On the PoE power injector, connect an additional Ethernet cable into the network port as indicated in the following 
illustration.

4. Plug the other end of the Ethernet cable into the network jack on the wall. 
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5. Plug the PoE power injector into a power outlet.

Note: You should connect the power supply to a surge protector or power bar. All Ethernet cables used must be 
category 5/5e straight-through cables, such as the cable provided with your phone.
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Connecting a Handset, Headset, or DHSG Headset

Handset

To connect the handset to the phone:

1. On the back of the phone base, locate the handset port marked .
Insert one end of handset cord into the port until it clicks into place.

2. Route the handset cord through the channel as shown in the illustration on the next page.

3. Attach the handset to the other end of the handset cord.

Headset (Optional)

To connect a headset to the phone:

1. On the back of the phone base, locate the headset port marked .
Insert the headset cord into the port until it clicks into place.

2. Route the headset cord through the channel as shown in the above illustration on on the next page.

DHSG Headset (Optional)

You can attach an optional DHSG headset to the HST02 Phone if required.

To connect a DHSG headset to the phone:

1. On the back of the phone base, locate the DHSG port marked AUX.

2. Attach your 3rd party DHSG headset cable to Savant’s DHSG jack.

Note: DHSG headsets may require further configuration before use. Refer to your headset documentation or contact 
your headset vendor for more information.
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Attaching Cords and Cables
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Desk or Wall Installation

Install on the Desk

The desk installation for the HST01 consists of two legs that attach to the back of the phone near the top corners. A 
total of four different viewing angles allows users to personalize their phone viewing preference.

1. Attach each leg by inserting the tabs on the leg into the slots on the bottom of the phone. There are three pair of 
leg slots on each corner of the phone; each leg uses two pairs (1&2, or 2&3) giving two leg positions designating 
different viewing angles. Furthermore, the legs can be reversed which offer two additional viewing angles.

2. For a higher viewing angle, use the second and third slots from the top.

3. For a lower viewing angle, use the first and second slots from the top.

4. Push the stand towards the phone until it snaps into place.
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Install on the Wall

The HST02 phone has two pre-drilled wall mounting holes on the back of the phone.

1. Using the provided wall mount drilling template, locate and mark the position for the mounting screws on the wall. 
Depending on the wall type, you may need to use wall anchors. Both the screws and wall anchors are included with 
your phone.

2. Place the wall mount holes on the phone over the screw heads on the wall and pull down to lock the phone in.

Note: You may wish to purchase a short Ethernet cable from a local supplier for a wall installation. Also, if 802.3af 
compliant in-line power is not provided on your network, and you are installing the 6739i on a wall using a PoE in-line 
power injector, you may also wish to use an equivalent flat Ethernet cable rather than the one provided.

3. In the handset cradle, there is a small clip that sits flush with the cradle surface. Using a small flathead screwdriver, 
pull the clip up and remove it from the phone.

4. With the arms on the clip facing you and the flat side of the clip towards the phone, turn the clip 180 degrees and 
reinsert it back into the clip cavity in the phone’s cradle.
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5. Push the clip in until it snaps into the slot flush with the surface and only the legs on the clip are sticking up.

6. Place the handset into the phone’s cradle, inserting the legs on the clip into the square hole on the handset. This 
allows the handset to rest in the cradle in a vertical position without slipping off when the phone is installed on the 
wall.
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Installing the Savant Phone: TEL-HST01 
The Savant TEL-HST01 phone communicates over an IP Network, allowing you to receive and place calls in the 
same manner as a regular business telephone.

Requirements
The following are required to operate a TEL-HST01

• SIP-based IP PBX system or network installed and running with a SIP account created for the TEL-HST01 
phone.

• Access to a Trivial File Transfer Protocol (TFTP), File Transfer Protocol (FTP), Hypertext Transfer Protocol 
(HTTP) server, or Hyper Text Transfer Protocol over Secure Sockets Layer (SSL) (HTTPS).

• Ethernet/Fast Ethernet LAN (10/100 Base-T)
• Category 5/5e straight through cabling
• Power source 

Phone Parts (TEL-HST01)
When you unpack your phone, you should ensure that you have all of the following items. If any part is missing, 
contact the supplier of your phone.
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Network Connection

The port marked with LAN is used to connect the phone to the network.

Power Adapter

Use the power adapter (provided) with your phone and plug your phone into a power source.
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Connecting a Handset

Turn the phone over and locate the handset jack marked . Insert one end of handset cord into the jack until it 
clicks into place. Then route the handset cord through the groove as shown in the illustration below. Attach the 
handset to the other end of the handset cord.

Desk or Wall Installation

Install on the Desk

The desk installation for the HST01 Phone IP phone consists of two legs that attach to the back of the phone near the 
top corners. A total of four different viewing angles allows users to personalize their phone viewing preference.

1. Attach each leg by inserting the tabs on the leg into the slots on the bottom of the phone. There are three pair of 
leg slots on each corner of the phone; each leg uses two pairs (1&2, or 2&3) giving two leg positions designating 
different viewing angles. Furthermore, the legs can be reversed which offer two additional viewing angles.

2. For a higher viewing angle, use the second and third slots from the top.

3. For a lower viewing angle, use the first and second slots from the top.
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4. Push the stand towards the phone until it snaps into place.

Install on the Wall

The HST01 IP phone has two pre-drilled wall mounting holes on the back of the phone.

1. Using the provided wall mount drilling template, locate and mark the position for the mounting screws on the wall. 
Depending on the wall type, you may need to use wall anchors. Both the screws and wall anchors are included with 
your phone.

2. Place the wall mount holes on the phone over the screw heads on the wall and pull down to lock the phone in.
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3. In the handset cradle, there is a small clip that sits flush with the cradle surface. Using a small flathead screwdriver, 
pull the clip up and remove it from the phone.

4. With the arms on the clip facing you and the flat side of the clip towards the phone, turn the clip 180 degrees and 
reinsert it back into the clip cavity in the phone’s cradle.

5. Push the clip in until it snaps into the slot flush with the surface and only the legs on the clip are sticking up.
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6. Place the handset into the phone’s cradle, inserting the legs on the clip into the square hole on the handset. This 
allows the handset to rest in the cradle in a vertical position without slipping off when the phone is installed on the 
wall.
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Inserting the Key Card

This card contains the label identification spaces for 8 programmable keys.

1. Remove the logo plate from the top front panel of the telephone by gently pressing down and sliding upward.

2. Slide the card into the programmable key card slot on the top front panel of the telephone using the display slots 
for alignment. Ensure the tabs are sticking out for future removal of the card.

3. Gently slide the logo plate back in place, covering the paper tabs.
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Key Cards for TEL-HST01
The next page includes printer-ready labels (key cards) for the Savant phone (TEL-HST01).
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Labels for Savant TEL-HST01 (Letter) 
Note:  Do not scale - print labels 1:1  (page adjustment for printing: none)

  









17

kathy.hall
Typewritten Text

kathy.hall
Typewritten Text

kathy.hall
Typewritten Text

kathy.hall
Typewritten Text
260 of 274
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9. APPENDIX 2: SAVANT PBX INSTALLATION 

Print this section to track the progress of your Savant PBX configuration.
 

  Confidential and Proprietary                                                                         261 of  272Savant Telephony Solution Deployment Guide
Release PBX 6.0
009-0406-14



Checklist
Print this checklist and check off each task as it is completed.You can also use the hyperlinks to open the procedure 
associated with a task in the PDF version of this document. 

Task ✓
Complete	
  the	
  Savant	
  PBX	
  On-­‐Line	
  Training.	
  

Enter	
  informa;on	
  in	
  the	
  Savant	
  PBX	
  Worksheets	
  that	
  follow	
  this	
  checklist.

Router	
  ConfiguraCon

Reserve	
  IP	
  Address	
  for	
  Savant	
  PBX.	
  See	
  page	
  7.

Reserve	
  IP	
  Address	
  for	
  Gateway.	
  See	
  page	
  7.

Reserve	
  IP	
  Address	
  for	
  each	
  Base	
  Sta;on.	
  See	
  page	
  7.

Physical	
  ConfiguraCon

Install	
  Savant	
  PBX.	
  See	
  Page	
  7.	
  

Install	
  Gateway.	
  See	
  Page	
  13.	
  

Install	
  the	
  Wired	
  Phones:	
  TEL-­‐HST01,	
  See	
  page	
  252	
  or	
  TEL-­‐HST02	
  See	
  page	
  242.

Install	
  the	
  Wireless	
  Phones:	
  TEL-­‐HSTW01	
  See	
  Page	
  239.

Install	
  the	
  Base	
  Sta;ons	
  See	
  page	
  130.

Savant	
  PBX	
  ConfiguraCon	
  in	
  RacePoint	
  Blueprint	
  (BP)

Add	
  the	
  Savant	
  PBX	
  in	
  your	
  BP	
  Configura;on.	
  	
  See	
  page	
  18.

Add	
  the	
  Gateway	
  Component	
  (TGW-­‐004)	
  to	
  BP	
  configura;on.	
  See	
  page	
  20.

Add	
  the	
  Public	
  Announcement	
  System	
  (PAS-­‐1000)	
  See	
  page	
  29.

Configure	
  Triggers	
  for	
  Savant	
  PA.	
  See	
  page	
  33.

Export	
  the	
  Savant	
  Gateway.ini	
  file.	
  See	
  page	
  23.

Export	
  the	
  Telephony.plist.	
  See	
  page	
  28.

Upload	
  the	
  BP	
  Configura;on	
  and	
  Test.

Savant	
  Gateway

Uploading	
  the	
  *.ini	
  file	
  to	
  the	
  Savant	
  Gateway.	
  See	
  page	
  24.

Con;nued	
  on	
  next	
  pageCon;nued	
  on	
  next	
  page
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Savant	
  Configurator

Upload	
  the	
  plist.	
  See	
  page	
  60.

Add	
  all	
  the	
  iOS	
  devices	
  to	
  the	
  PBX.	
  See	
  page	
  63.

Add	
  the	
  Wired	
  and	
  Wireless	
  Savant	
  Phones	
  as	
  devices.	
  See	
  page	
  65.

Add	
  a	
  Savant	
  PA	
  System	
  (PAS-­‐1000).	
  See	
  page	
  73.

Add	
  all	
  iOS	
  devices	
  and	
  Phones	
  to	
  the	
  SLA.	
  	
  See	
  page	
  82.

Configure	
  the	
  Voice	
  Mail.	
  See	
  page	
  86.	
  

Add	
  Voice	
  Mail	
  to	
  Shared	
  Line.	
  See	
  Page	
  94.

Add	
  a	
  Savant	
  Wired	
  Phone	
  as	
  a	
  Phone.	
  See	
  page	
  67.

Add	
  the	
  Wireless	
  Savant	
  Phones	
  as	
  phones.	
  See	
  page	
  71.

Uploading	
  the	
  Configura;on	
  to	
  the	
  Wired	
  Phone.	
  See	
  page	
  69.

Update	
  Firmware	
  of	
  Wired	
  Savant	
  Phones.	
  See	
  page	
  236.

SIP-­‐Dect	
  Base	
  StaCon	
  ConfiguraCon

Genera;ng	
  a	
  License	
  for	
  Mul;ple	
  Base	
  Sta;ons.	
  See	
  page	
  134.

Boot	
  the	
  Base	
  Sta;on.	
  	
  See	
  page	
  138.

Add	
  each	
  Base	
  Sta;on.	
  See	
  page	
  148.

Add	
  the	
  Wireless	
  Handsets	
  to	
  the	
  Base	
  Sta;on.	
  See	
  page	
  151.

Subscribe	
  the	
  Wireless	
  Handsets	
  to	
  the	
  Base	
  Sta;on.	
  See	
  page	
  154.

PAS-­‐1000	
  Configura;on

Upload	
  Configura;on	
  File	
  to	
  the	
  Savant	
  PA	
  System.	
  See	
  page	
  77.

Emergency	
  Call	
  Tes;ng

Savant	
  Systems	
  recommends	
  performing	
  a	
  test	
  of	
  emergency	
  calls.	
  See	
  page	
  271.
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MAC Addresses and IP Addresses
All the MAC Addresses can be found on stickers that are on the box or the equipment. The IP addresses depend on 
how you would like to configure the network at this particular location.

Item Model Name Mac Address IP Address

1 SPX-1000 ____-____-____-____-____-____ _____._____._____._____

2 TGW-0004 ____-____-____-____-____-____ _____._____._____._____

3 TEL-HST0_ ____-____-____-____-____-____

4 TEL-HST0_ ____-____-____-____-____-____

5 TEL-HST0_ ____-____-____-____-____-____

6 TEL-HST0_ ____-____-____-____-____-____

7 TEL-HST0_ ____-____-____-____-____-____

8 TEL-HST0_ ____-____-____-____-____-____

9 TEL-HST0_ ____-____-____-____-____-____

10 TEL-HST0_ ____-____-____-____-____-____

11 TEL-HSTW_ ____-____-____-____-____-____

12 TEL-HSTW_ ____-____-____-____-____-____

13 TEL-BST0_ ____-____-____-____-____-____ _____._____._____._____

14 TEL-BST0_ ____-____-____-____-____-____ _____._____._____._____

15 TEL-BST0_ ____-____-____-____-____-____ _____._____._____._____

16 TEL-BST0_ ____-____-____-____-____-____ _____._____._____._____

17 TEL-BST0_ ____-____-____-____-____-____ _____._____._____._____

18 TEL-BST0_ ____-____-____-____-____-____ _____._____._____._____

19 TEL-BST0_ ____-____-____-____-____-____ _____._____._____._____

20 TEL-BST0_ ____-____-____-____-____-____ _____._____._____._____

21 TEL-BST0_ ____-____-____-____-____-____ _____._____._____._____

22 TEL-BST0_ ____-____-____-____-____-____ _____._____._____._____

23 PAS-1000 ____-____-____-____-____-____ _____._____._____._____

24

24

26

27

28

29

30
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Wireless Handset Information
Enter the 13-digit IPEI characters (they can include *) that can be displayed from the handset:
 Menu->System->Show IPEI 

Item Model Name IPEI

1 TEL-HSTW01

2 TEL-HSTW01

3 TEL-HSTW01

4 TEL-HSTW01

5 TEL-HSTW01

6 TEL-HSTW01

7 TEL-HSTW01

8 TEL-HSTW01

9 TEL-HSTW01

10 TEL-HSTW01

iOS Device Information
On the iOS device, the device UID is a 16-digit number accessed as follows:
Settings -> Systems -> Settings -> Device Info-> Device UID.

Item Model Name UID

1 WIA-
2 WIA-
3 WIA-
4 WIA-
5 WIA-
6 WIA-
7 WIA-
8 WIA-
9 WIA-
10 WIA-
11 WIA-
12 WIA-
13 WIA-
14 WIA-
15 WIA-
16 WIA-
17 WIA-
18 WIA-
19 WIA-
20 WIA-
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Other SIP Base Station General Information 
These are general network guidelines based on how the network is setup at the particular installation.

Item Name Description Value

1 Net Mask This will determine your IP 
Subnet, default is 255.255.255.0

2 Router Address This is the IP Address of the 
Router

3 DNS
Address

Using Google DNS Address is 
fine “8.8.8.8” and “8.8.4.4”

4 NTP Server 
Name

You can use 
“1.aastra.pool.ntp.org”

5 Primary OMM The IP Address of the Primary 
Base Station _____._____._____._____

6 Secondary 
OMM

The IP Address of the Secondary  
Base Station _____._____._____._____

7 Park

This is a unique key to configure 
the base station and add a 
handset. The key is shown on 
the OMM package (on the CD).
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Add a Wired Phone to an Existing Configuration Checklist
Open Savant Configurator to perform the following tasks. Print this checklist and check off each task as it is 
completed.You can also use the hyperlinks to open the procedure associated with a task in the PDF version of this 
document.

Tasks ✓
Add	
  a	
  Wired	
  Phone	
  as	
  a	
  Device	
  See	
  page	
  65.

Add	
  the	
  Wired	
  Phone	
  Device	
  to	
  the	
  SLA.	
  See	
  page	
  82.

Add	
  the	
  Wired	
  Phones	
  as	
  a	
  Phone.	
  	
  See	
  page	
  67.

Op;onally,	
  add	
  the	
  Wired	
  Phone	
  to	
  the	
  Page	
  Group.	
  See	
  page	
  97.

Update	
  to	
  the	
  latest	
  firmware	
  version.	
  See	
  page	
  236.

Reset	
  the	
  Phone.

  Confidential and Proprietary                                                                         267 of  272Savant Telephony Solution Deployment Guide
Release PBX 6.0
009-0406-14



Add a Wireless Phone to an Existing Configuration Checklist
Open Savant Configurator to perform the following tasks. Print this checklist and check off each task as it is 
completed.You can also use the hyperlinks to open the procedure associated with a task in the PDF version of this 
document.

Tasks ✓
Add	
  a	
  Wireless	
  Phone	
  as	
  a	
  Device.	
  See	
  Page	
  65.

Add	
  the	
  Wireless	
  Phone	
  Device	
  into	
  the	
  SLA.	
  See	
  Page	
  82.

Add	
  the	
  Wireless	
  Phones	
  as	
  a	
  Phone.	
  See	
  page	
  71.

Op;onally,	
  add	
  the	
  Wireless	
  Phone	
  to	
  the	
  Page	
  Group.	
  See	
  page	
  97.

Export	
  the	
  sip_DECT.cfg	
  file.	
  See	
  Page	
  71.

Add	
  the	
  wireless	
  handsets	
  to	
  the	
  Base	
  Sta;on.	
  See	
  Page	
  151.

Subscribe	
  the	
  wireless	
  handsets.	
  See	
  Page	
  154.
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Add an iOS device to an Existing Configuration Checklist
Open Savant Configurator to perform the following tasks. Print this checklist and check off each task as it is 
completed.You can also use the hyperlinks to open the procedure associated with a task in the PDF version of this 
document.

Tasks ✓
Add	
  an	
  iOS	
  device	
  as	
  a	
  device.	
  See	
  Page	
  63.

Add	
  the	
  iOS	
  device	
  into	
  the	
  SLA.	
  See	
  Page	
  82.

Op;onally,	
  add	
  the	
  iOS	
  device	
  to	
  the	
  page	
  group.	
  See	
  page	
  97.

Update	
  to	
  the	
  latest	
  Savant	
  app	
  version.	
  Refer	
  to	
  the	
  da	
  Vinci	
  6.0-­‐Release	
  ReadMe	
  
notes	
  to	
  verify	
  the	
  correct	
  soMware	
  version.	
  

Relaunch	
  the	
  Savant	
  app	
  on	
  the	
  iOS	
  device.
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Add a new Base Station to an Existing Configuration 
Checklist
Open Savant Configurator to perform the following tasks. Print this checklist and check off each task as it is 
completed.You can also use the hyperlinks to open the procedure associated with a task in the PDF version of this 
document.

Tasks ✓
Configure	
  each	
  Base	
  Sta;on.	
  See	
  page	
  155.
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10. TESTING EMERGENCY CALLS

Savant Systems recommends that after installing any Savant PBX system the emergency call functionality be tested. 
Savant also recommends testing this functionality regularly as a preventative measure. The test procedure for 
verifying emergency call services is different from one country to another. The next procedure applies to the United 
States. Outside of the United States, Savant dealers can contact local agencies to determine how emergency calls 
should be tested.

In the United States to test that calls to 911 are working properly using the Savant PBX system, do the following. 

1. Find your local public safety answering point (PSAP): http://www.fcc.gov/pshs/services/911-services/
enhanced911/psapreg...

2. Call the PSAP administrator (non emergency) and ask how to perform a 911 test in your area.

3. Schedule a 911 test.

4. Call 911 at the scheduled time.

5. During the call confirm the following:

• the Automatic number identification (ANI) and Automatic Location Identification (ALI) that is shown on the 
screen of  the call taker

• the PSAP to which the call was routed
• that answer supervision was received by looking at the call duration timer on the IP phone—an active call timer 

is an indication that answer supervision is working properly.
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11. DOCUMENT CHANGE HISTORY
The next table outlines the changes that have been included in this document for Release 6.0.

Page Number Description

202 Added new step 4: Go to VoIP > GW and IP to IP > Analog Gateway > Automatic Dialing.

213 Added procedure Configuring VIO by Holovision VoIP Intercom.

The next table outlines the changes that have been included in this document for Release 6.0.

Page Number Description

Removed obsolete procedure, Configuring a DoorKing 1812 using Savant Configurator

12 Added PBX Support of Call Features table

59 Updated screenshot for Main Page in Savant Configurator

183
Added statement: If you are integrating Siedle door units in your Savant PBX system, please  
skip this section.

The next table outlines the changes that have been included in this document for Release 5.2.1 ER2.

Page Number Description

65
In Step 3 added the following information to the table:
MWI enabled—Insert checkmark to enable Message Waiting Indicator.
Advanced— See the section Performing Advanced Configuration.

88 Added note to Step 3 description of Email.

90
Added more detail to Step 4:
Step 4. When prompted to enter password, enter the PIN number assigned to the user.(PINs 

must be assigned and you can customize PINs.)

The next table outlines the changes that have been included in this document for Release 6.0.

Page Number Description

12
Added “Important!  You should avoid using iOS devices and full duplex (two-way) PBX 
functions with in-wall docks. Otherwise, the iOS devices will experience acoustic issues.  
Instead, half duplex (one-way) Push-To-Talk intercom functions must be used with in-wall 
docks.”

184 Updated Table to reflect image options more precisely.

225 Updated image to show one SIP account as only one is necessary.

236 Added Firmware data details.
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